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Introduction 
EFI Technique software offers an end-to-end software solution from the point of sales through production to the 
shipment of goods. It has the comprehensive capabilities of a world-class ERP software system, while fitting the 
unique business processes of publication and commercial print companies. The solution’s comprehensive 
capabilities are able to address the needs of print companies with complex operating environments such as 
multi-site, multi-currency, multi-language and multi-product production processes. 

Contact Information 
EFI Support 

Web Site: https://customer.efi.com/support 

UK Phone: + 44 (0) 1246-298085 

US Phone: 1-855-EFI-4HLP 

E-mail: technique.support@efi.com  
Regular USA Service Desk hours are 8:30 AM to 5:00 PM Eastern Time, Monday – Friday. 

Regular European Service Desk hours are 8:30 AM to 5:00 PM Greenwich Mean Time (British Summer Time 
during summer), Monday – Friday. 

Note For problems involving infrastructure (i.e., computers, networks, operating systems, backup software, 
printers, third-party software, etc.), contact the appropriate vendor. EFI cannot support these types of 
issues. 

EFI Professional Services 

UK Phone: + 44 (0) 113 3836000 

EFI Professional Services can help you perform EFI software installations, upgrades, and updates. This group 
can also help you implement, customize, and optimize your EFI software plus offer a range of training option. 
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About This Guide 
The EFI Technique Estimating system has the ability to provide quotations for Web Offset, Coldset, Sheetfed, 
Gravure and Digital print, virtually any piece of finishing equipment as well as Print and Finishing outwork.  The 
complexity of the enquiry can range from a simple single style single quantity component to a multi-site, multi-
style, multi-quantity, multi-product version quotation. All of this is encased in a truly unique and revolutionary 
Route Based Estimating system that, after some initial configuration, makes the production of quotations fast and 
accurate. 

The configuration of the data within the Estimating Maintenance application supports Sales Enquiries, 
Estimating, Order Management, Inventory and Production Scheduling applications.  

This user guide is provided to assist the IT and Project Team and Super Users when configuring Sales 
Enquiries, Estimating and Quick Pricer. 

This System User Guide will provide details on: 

• Configuration of Estimating Maintenance to support the Estimating application 
 

• Configuration of Sales Enquiry templates 
 

• Configuration of Quick Pricer (commercial and contract) 
 

• Configuration of the User Profile Options and Application Settings 

This user guide does not provide details on how to use Sales Enquiries, Estimating or Quick Pricer. 
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Process Flow 
We recommend that you adopt the following process flow when setting up the system. 



 User Profiles | System Admin for Sales Enquiries, Estimating and Quick Pricer 5.4 User Guide l 11  

 
 

 

User Profiles 
There are multiple profile options, which need to be considered when deciding the roles of users who will access 
the application.  

Estimating 
Profile Option Description Chapter reference 

Members can perform 
Administration 

Access to Estimating Maintenance. Estimating 
Maintenance 

Members can maintain 
Contract data 

Access to Contract Management from Tools > Options. Quick Pricer from 
Contract 

Members can view 
attachments 

Access to attachments within an estimate. Attachments 

Members can manage 
attachments 

Ability to add and delete attachments. Attachments 

Members can de-
select standard terms 

Ability to select and clear selections of Terms and 
Conditions. 

Estimate Workings 
and Quotations 

Members can access 
Site estimates 

Ability to access estimates created by a user whose user 
detail is at a different site to yours. 

Component 
Calculation and 
Route Selection 

Members can access 
Sector estimates 

Ability to access estimates created by a user whose user 
detail is at a different sector to yours. 

Opening an 
Enquiry in 
Estimating 

Members can view 
Quick Pricer page 

Access to Quick Pricer in MIS Console. Quick Pricers 

Members can reprice Ability to amend the pricing of an estimate within the reprice 
window. 

Re-Pricing the 
Estimate 

Members can access 
Group estimates 

Ability to access estimates created by a user whose user 
detail is at a different group to yours. 

Open an Enquiry in 
Estimating 

Members can delete 
enquiries 

Ability to remove enquiries within Estimating. Deleting and 
Enquiry in 
Estimating 

Members can assign 
estimators 

Ability to assign an estimator to an enquiry/estimate. Assigning an 
Estimator 

Members can unlock 
estimates 

Access to the Unlock window so that the estimate can be 
made available to a different user if another user has already 
accessed it. 

Locked 

 

Note Estimators need to be entered as an estimator within the User Details. 

Sales Enquiries 
Profile Option Description Chapter reference 

Members can prioritise 
new Enquiries 

Ability to enter a priority sequence for enquiries. Enquiry List Views 

Members can edit 
Sales Values 

A user entered as a salesperson is able to change Sales 
Values online. This permission must be granted if a reprice 
profile is associated to the profile group to which the user 
belongs. 

Re-pricing a 
quotation letter 
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Profile Option Description Chapter reference 
Members can view 

Sales Values 
A user entered as a salesperson can view the pricing for a 
quotation. 

Re-pricing a 
quotation letter 

Sales members can 
view all Customers 

A user entered as a salesperson can open all company 
records even when they’re not assigned as a salesperson to 
the contact. 

Creating a Sales 
Enquiry 

Members can print 
Enquiries 

Ability to print the sales enquiry. Creating a Sales 
Enquiry 

Members can delete 
Enquiries 

Ability to remove enquiries. Deleting an Enquiry 
in MIS Console 

Members can add 
Enquiries 

Ability to create enquiries. Creating a Sales 
Enquiry 

Members can edit 
Enquiries 

Ability to edit enquiries (using the standard form) when 
available. 

Creating a Sales 
Enquiry 

Members can produce 
Estimates 

Ability to submit enquiries to the Estimating application. Creating a Sales 
Enquiry 

Members can Assign 
Estimators 

Ability to assign an estimator to an enquiry in Sales Enquiry. Assigning an 
Estimator 

Members can view 
attachments 

Ability to view attachments linked to an enquiry. Attachments 

Members can manage 
attachments 

Ability to add or delete attachments linked to an enquiry. Attachments 

Sales Members can 
search all customers 

A user entered as a salesperson can search all company 
records even when they’re not assigned as a salesperson to 
the contact. 

Creating a Sales 
Enquiry 

Members can export 
enquiries 

Ability to export a list of enquiries. Exporting an 
Enquiry in MIS 
Console 

Members can view all 
templates 

Ability to open all enquiry templates. Viewing and 
Changing the 
Quotation Letter in 
MIS Console 

Members can change 
Enquiry Required By 

Date 

Ability to change the Enquiry Required By Date from the 
default date entered. 

Changing the date 
of an enquiry in 
MIS Console 

Members can edit 
Enquiry Status 

Ability to change the status of an enquiry. Changing the 
status of an enquiry 

 

MIS Console 
Below are the settings that are applicable for use with Sales Enquiries, Estimating and Quick Pricer only. 

Profile Option Description Chapter reference 

Members can view 
incomplete quotes 

Ability to open a quotation letter for an estimate, that has 
been generated, but where the estimate has not been 
entered as Complete. 

Enquiry List Views 

Members can edit 
multi version quotes 

Ability to change the versions included in an estimate that 
has been generated in Estimating as a multi-version quote. 
For example, a multi-version quote may include 3 versions of 
different paginations, however with this permission, users 
can adjust this to only include two of the versions within MIS 

Multi-Version 
Quotes 
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Profile Option Description Chapter reference 
Console > Estimating > Quotes. 

 

Reference to specific profile options will be included throughout the Estimating 5.4 User Guide when explaining 
the different scenarios available to you. 

Application Settings 
Estimating, Estimating Maintenance and Sales Enquiries have a number of Application Settings that control 
various aspects of the module’s operation.  The system administrator can maintain application Settings within 
either Information Console or MIS Console.  

Estimating 

Setting id Name Example 
value Description Chapter 

Reference 

1 Default Packing Type  Adds a default packing type to new 
enquiries - use PType value from 
Packing table. 

Setting is no 
longer used 

2 In House Outwork 
Pricing 

FALSE Set to '-1' if default Outworker pricing 
should override In-house calculated 
pricing. 

Choosing 
the Finishing 
Routes 

3 Default Currency 
Symbol 

£ Sets the application currency symbol. Entering the 
Enquiry 
Details 

4 Single Load Limit 20000 Sets the tonnage on a single truck. Packing and 
Delivery 

5 Swap Depth/Width 0 Swaps the Depth and Width fields 
around within the estimate entry 
screens. 

Entering the 
Enquiry 
Details 

6 Quote Date Align Right TRUE Align the Date on Quote to the right Setting is no 
longer used 

7 Quote Ref Align Right TRUE Align the Quote Reference to the right Setting is no 
longer used 

8 Paper Banding TRUE Implements Paper Weight banding Setting is no 
longer used 

9 No Delivery Run On 0 Determines if delivery runon cost is 
calculated 

Reviewing 
the estimate 
calculations 

10 QP Display Run On TRUE  MIS Quickpricer display run on Setting is no 
longer used 

11 QP Display  PFD price TRUE  MIS Quickpricer display print finish 
delivery price 

Setting is no 
longer used 

12 QP Confirm enquiry TRUE  MIS Quickpricer email confirm 
enquiry price 

Setting is no 
longer used 

13 QP From Email 
Address 

user@domai
n.com 

Email Address the confirmation email 
comes from 

Setting is no 
longer used 

14 QP To Email Address  Email Address the confirmation email 
goes to. 

Setting is no 
longer used 
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Setting id Name Example 
value Description Chapter 

Reference 

15 OPT_IMPERIAL_CALC FALSE Switch to set Metric (false) or US 
Imperial (true) calculation 

Various 

16 Stock Web Width 0 Use stock web widths Paper 

17 Show QP Warnings TRUE 1 = displays QP warnings anything 
else will not display them 

Setting is no 
longer used 

18 Round Pound 1 1 = rounds QP figures to the nearset 
pound, else = 2dp 

Setting is no 
longer used 

19 Run On Caption Price per M Overrides the caption for Run On's on 
the Quote 

Setting is no 
longer used 

20 Show Process FALSE 1= displays the process anything else 
does not display them 

Setting is no 
longer used 

22 Minimum QP Quantity 1000 Set the minimum quantity allowed in a 
quickpricer quote 

Quick Pricer 

23 Maximum QP Quantity 50000 Set the maximum quantity allowed in 
a quickpricer quote 

Quick Pricer 

24 Include Customer 
Telephone & E-Mail on 
Quote 

TRUE Include Customer Telephone & E-Mail 
on Quote 

Setting is no 
longer used 

25 OPT_INPUT_QTY_IN_
000S 

0 Defines whether the system 
automatically multiplies any quantity 
by 1000 on input 

Quantities 

26 QP Show Extra 
Finishing Styles 

TRUE Show the additional finishing section 
in Quickpricer 

Setting is no 
longer used 

27 Show Contribution 1 Shows Contribution or AV or neither 
in the reprice screen (0 = show 
neither, 1 = show contribution, 2 = 
show added value) 

Re-pricing 
the Estimate 

30 Default Route summary 
view 

1 Defines which view is shown by 
default (cost=1/budget=2/target=3) 

Component 
Calculation 

31 Hide routes with zero 
paper costs 

1 Hide print routes with invalid or 
uncalculated paper costs 
(0=false/show, 1=true/hide). 

Component 
Calculation 

32 QUOTEEXTENSION doc Specify the quote file extension type 
(doc or pdf) 

Setting is no 
longer used 

33 APPSETTING_USE_C
ALIPER 

0 Switch between Paper Weight (gsm) 
and Caliper (1 = On, 0 = Off) 

Paper 

35 Advanced guillotine 
setup 

0 Enables advanced configuration and 
calculation of Guillotining (0=false/off, 
1=true/on). 

Advanced 
Guillotine 

36 APPSETTING_SHEET
PRESELECT 

0 Enables Sheet & Number Up pre 
selection (1 = on / 0 = off) 

Setting is no 
longer used 

37 APPSETTING_SMALL
MACHINES 

1 Enables finishing small machines 
calculation (1 = on / 0 = off) 

Small 
Machines 

38 APPSETTING_BUTTO
NIMAGES 

1 Display images on main screen 
command buttons (1 = on / 0 = off) 

Component 
Calculation 

39 APPSETTING_RUNW
ASTE_NLT 

0 Apply NLT to run waste calculation (1 
= on / 0 = off) 

Route 
Calculation 
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Setting id Name Example 
value Description Chapter 

Reference 

40 PDF Location C:\_Custome
rs\Technique
\51\PDF 

Location to store pdf documents. Setting is no 
longer used 

41 Automatically update 
paper pricing 

1 Controls whether to automatically 
update the paper pricing (1= Yes/ 0 = 
No). If entered as 1, if you change the 
cost and sell price of the paper in 
Estimating Maintenance > 
Miscellaneous > Materials > Paper > 
Type > Item, this will automatically 
update the cost and price for the 
paper in any estimate for which it has 
been added. 

Paper 

42 APPSETTING_BOR 1 Enables Bill Of Routing functionality Using BOR 
Format 

43 APPSETTING_HIDE_S
WDEPWID 

1 Hides Section Web Depth, Width & 
Pages fields (1 = Hide, 0 = Show) 

Web 
Definition 

44 Quotation Email 
Subject Line 

Your 
document 
[#QUOTEN
O#] is 
attached for 
[#TITLE#] 

Default subject line used when 
emailing a pdf quote. 

Quotation 
Letter 

45 APPSETTING_SENDQ
UOTEEMAIL 

0 Send a notification email to the 
salesperson when a quote is 
completed 

Marking an 
Estimate as 
Complete 

46 APPSETTING_WSCO
VERHASNOFOLD 

0 Saddle Stitched Sheeted Sections of 
4 pages do not create Folding 
operations 

Adding 
Cutting and 
Folding 

47 APPSETTING_CLOSE
QUOTEGEN 

1 Closes Quote dialogue automatically Estimate 
Workings 
and 
Quotations 

48 APPSETTING_BINDS
PEEDCOMP 

0 Calculate bindery speed reduction 
based upon individual component 
paginations 0=Off, 1=On 

Reviewing 
the estimate 
calculations 

50 APPSETTING_REPRI
CEPLATEMATERIALS 

1 Re-Price Pre Press and Plate 
Materials, 0=OFF, 1=ON 

Re-pricing 
the Estimate 

51 APPSETTING_OWLC
R 

0 Inc Outwork Finishing in Least Cost 
Routing 

Choosing 
the Finishing 
Routes 

52 SHEETCOSTREQUIR
ED 

1 Return valid paper cost sheetfed 
routes only 0=False/1=True 

Component 
Calculation 
and Route 
Selection 

53 KEEPROUTESONREV
ISE 

1 Preserve routing in revised estimates 
(0 = False/1 = True) 

Revising an 
Enquiry in 
Estimating 
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Setting id Name Example 
value Description Chapter 

Reference 

54 SHOWQUOTEVERSIO
NSELECTION 

0 Allows exported files to have a single 
FinStyle and Qty 

Estimate 
Workings 
and 
Quotations 

55 OM_OPEN_IN_COLLA
PSED_VIEW 

0 Upon opening OM the list is dispayed 
in collapsed view if a sequence is 
defined. 0 = False, 1 = True. Default = 
false 

Customizing 
the Display 

56 APPSETTING_PRODU
CTTYPE_CODE 

0 Defines if Product Type and Code are 
required fields. O = Off, 1 = On 

Entering the 
Enquiry 
Details 

57 APPSETTING_SHOW
PRESSVENDORS 

1 Shows the Press Vendor Combo box 
in maintenance 0 = Off, 1 = On 

Press 

58 APPSETTING_PAPER
HANDBYTIME 

0 Control how paper handing is charged 
(0 = By Weight) (1 = By Time/Hourly 
Rate)  

Components 

59 APPSETTING_PAPER
HANDLINGHOUSE 

0 Control whether paper handling 
charges are applied to house or 
customer supplied stock (0 = 
customer supplied stock only) (1 = 
house and customer supplied stock) 

Components 

60 APPSETTING_PRECU
TEXTRACUTS 

0 Control how many additional cuts 
should be added when precutting 
sheets to ensure the edges are 
square. 

Pre-cutting 

61 VAL_PRESS_METHO
D_DESC 

#[ConfigDes
c]# 
#[WorkStyle]
# 
#[SheetDept
h]#x#[Sheet
Width]# 

Control how the press method 
description is shown. Possible values 
include #[ConfigDesc]#, 
#[WorkStyle]#, #[SheetDepth]#, 
#[SheetWidth]# 

Component 
Calculation 

62 CALC_ALL_FIN_NOU
P 

0 Calculate all NoUp options for 
finishing routes (0=Off, 1=On) 

Choosing 
the Finishing 
Routes 

63 APPSETTING_SHOW
DIRECTCOST 

0 Default to showing Direct Cost on 
reprice screen, 1 = Show Direct 
Costs, 0 = Show Standard Costs 

Re-pricing 
the Estimate 

64 VAL_PRECUT_MAXW
ASTEPC 

40 Defines the maximum percent of 
white space allowed on a precut 
press sheet. Helps reduce the 
number of precut options returned. 

Pre-cutting 

65 VAL_THIS_SITE_PAP
ER_PRICES 

0 Specifies whether the 'This site only' 
check box should be checked and the 
site id to default to for paper pricing. 
(0=off/use press site prices) 

Components 

66 OPT_QUOTE_PDF_U
SE_SERVER 

0 Whether or not the quotation letter 
should be emailed from the users 
client PC or from the server (0 = 
client/off, 1=server/on) 

Quotation 
Letter 



 Application Settings | System Admin for Sales Enquiries, Estimating and Quick Pricer 5.4 User Guide l 17  

 
 

 

Setting id Name Example 
value Description Chapter 

Reference 

67 VAL_QUOTE_PDF_CC
_TO 

 Specifies who should be CC’d when 
emailing the quotation letter. Possible 
values include #[SALES]# 
(salesperson), #[EST]# (estimator) or 
any valid email address separated 
with ; 

Quotation 
Letter 

68 APPSETTING_PROD
WEIGHTUPLIFT 

0 Determines if Product Weight Uplift is 
included in Bindery delivery weights. 
O = Off, 1 = On 

Reviewing 
the estimate 
calculations 

69 INCLUDECUTFOLD 0 Determine whether the press routes 
should calculate cut and fold 

Component 
Calculation 

70 AUTO_INSERT_GUFL 1 BOR GU and FL operations auto 
insert operations dependant upon 
section routing. 0 = Off, 1 = On. 
Default = Off 

Using BOR 
Format 

71 APPLY_QP_FILTERS 1 Defines if advanced Quick Pricer 
press and config filters are to be used 

Quick Pricer 

72 DEFAULT_UOP 0 Default paper UOP when using 
custom paper (0 is off so first in list) 

Components 

73 APPSETTING_USEEN
QUIRYSIZE 

0 Finishing will use the Enquiry 
Dimentions to calculate, ignoring 
sections.. O = Off, 1 = On 

Estimate 
Version 
Calculation 

74 ONLY_USE_QP_FILT
ER_ROUTES 

0 Defines if Quick Pricer filtered routes 
are to be used only 

Quick Pricer 

75 INCLUDE_WIP_DELIV
ERY_IN_FINISHING 

0 Finishing to include WIP Delivery Reviewing 
the estimate 
calculations 

76 COPY_WEB_WIDTH_
OVERRIDE 

0 Copy the web width override when 
copying a component 

Components 

77 ADD_COMMISSION_T
O_QUOTE 

0 Sales Commission is added to the 
quote total 

Sales 
Commission 

78 REPRICE_PRICEINCR
EASE_ENABLED 

0 Enable price increase reprice 
calculations 

Re-pricing 
the Estimate 

79 ENABLE_ADVANCED
_PACKING 

1 Enable Advance Packing 0 - off, 1 - 
on 

Packing - 
Advanced 

80 PALLET_WEIGHT_TO
LERANCE 

0 Maximum pallet weight is allowed to 
move by x% 

Packing – 
Advanced 

81 PALLET_HEIGHT_TOL
ERANCE 

0 Maximum pallet height is allowed to 
move by x% 

Packing – 
Advanced 

82 MAX_BUNDLE_WEIG
HT 

12 Maximum bundle weight Packing – 
Advanced 

83 MAX_BUNDLE_HEIGH
T 

300 Maximum bundle height Packing – 
Advanced 

84 BUNDLE_WEIGHT_TO
LERANCE 

0 Maximum bundle weight is allowed to 
move by x% 

Packing – 
Advanced 

85 BUNDLE_HEIGHT_TO
LERANCE 

0 Maximum bundle height is allowed to 
move by x% 

Packing - 
Advanced 

86 BPOP_ROUNDING_F
ACTOR 

0 BPOP pallet quantity is rounded to 
nearest factor 

Packing - 
Advanced 
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Setting id Name Example 
value Description Chapter 

Reference 

87 BUNDLE_ROUNDING
_FACTOR 

5 Bundle quantity is rounded to nearest 
factor 

Packing - 
Advanced 

88 PACK_ROUNDING_FA
CTOR 

0 Pack quantity is rounded to nearest 
factor 

Packing - 
Advanced 

89 DEFAULT_PACKING_
OPTION 

3 1=BPOP, 2=Bundle, 3=Material Setting is no 
longer used 

90 MATERIAL_PACK_DE
PTH_TAB 

10 Depth Tab used to calculate initial 
cost/price 

Setting is no 
longer used 

91 MATERIAL_PACK_WI
DTH_TAB 

10 Depth Tab used to calculate initial 
cost/price 

Setting is no 
longer used 

92 REEL_TO_SHEET_PR
ICING 

1 Use separate reel-to-sheet pricing 
(1=on/0=off) 

Paper 

93 AUTO_CALCULATE_P
ACKING 

1 Default packing is automatically 
calculated if set to 1 

Setting is no 
longer used 

94 START_WITH_SUMM
ARY_FORM 

1 Indicates when choosing the 
advanced packing function which 
view the user starts in 

Setting is no 
longer used 

95 START_WITH_CUSTO
M_CARTON 

1 Indicates when starting the advanced 
packing function that custom carton 
details are calculated 

Setting is no 
longer used 

96 DEFAULT_CUSTOM_
CARTON_MATERIAL 

0 Initial material used within the custom 
carton calculation 

Packing - 
Advanced 

97 BASE_CARTON_SIZE
_DEPTH 

310 Base carton dimention used for 
custom carton calculation 

Packing - 
Advanced 

98 BASE_CARTON_SIZE
_WIDTH 

230 Base carton dimention used for 
custom carton calculation 

Packing - 
Advanced 

99 BASE_CARTON_SIZE
_HEIGHT 

300 Base carton dimention used for 
custom carton calculation 

Packing - 
Advanced 

100 CUSTOM_PACK_MAR
GIN 

5 The allowed margin around the 
product when calculating the custom 
pack dimention 

Packing - 
Advanced 

101 CUSTOM_PACK_TAB
_SIZE 

25 Pack Size Packing - 
Advanced 

102 MAX_CUSTOM_PACK
_WEIGHT 

12 Maximum custom pack weight Packing - 
Advanced 

103 CUSTOM_PACK_MAT
ERIAL_WEIGHT 

0.5 Custom pack material weight Packing – 
Advanced 

104 ADVANCE_PACKING_
PRICE 

1 Show packing price details Packing – 
Advanced 

105 MISCONSOLE_URL http://localho
st/MISConso
le500 

The url for the MIS Console. Various 

106 APPSETTING_SAVEL
ASTCHANGEDBY 

0 Controls if the last modified by 
functionallity is used (1=On, 0=Off) 

Customizing 
the display in 
Estimating 

107 CALCULATE_AND_SH
OW_CONTAINER_CO
STS 

1 Indicates whether to calculate and 
show container freight costs/prices. 

Setting is no 
longer used 
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Setting id Name Example 
value Description Chapter 

Reference 

109 USE_ADVANCED_FO
LDING 

0 1=ON, 0=OFF - Uses the advanced 
folder calculation if ON 

Folding - 
Advanced 

110 USE_COMMISSION 0 1=ON, 0=OFF - Use the commission 
functionality if ON 

Sales 
Commission 

111 FAIL_FIN_ADDOPS 1 1=ON, 0=OFF Fail Finishing Roiutes 
if no pricing for Additional Ops/Inserts 

Estimate 
Version 
Calculation 

112 SHOW_COMPONENT
_CALIPER 

1 1=ON, 0=OFF Shows component 
caliper,can override,spine width 
visible in finishing route selection,Not 
compatable with Caliper mode  

Paper 

113 STITCHES 2 Default number of stitches for stitched 
finishing styles 

Using 
Standard 
Format 

114 GRAVURE_TRIM 1 Use Site Trims for Gravure = 1, Use 
Gravure Press Trims = 0 (standard 
func.) 

Gravure 

115 REPRICE%_EXCLUD
E_OW 

0 Whether or not outwork print and 
finish routes are excluded from the 
Reprice by % function (0 = included, 1 
= excluded) 

Re-pricing 
the Estimate 

117 USE_STANDARD_CU
TOFFS 

1 Whether to use standard cutoffs (1 = 
on, 0 = off) 

Press 
Configuratio
ns 

118 APPSETTING_USE_IN
COTERMS 

1 Show Inco-Term and Transport Type 
against Deliveries 

Freight 
Rates 

119 USE_FREIGHT_RATE
S 

0 Use Freight Drops and Rates 1=on / 0 
= off 

Freight 
Rates 

120 DEFAULT_TRANSID 0 Default Transport type ID (Use Valid 
TransTypeID from 
LookUpTransportType) 

Freight 
Rates 

121 SHOW_HEIGHT 0 Show height dimension 0=off, 1=on. 
This application setting is also used in 
Contract and Order Management. It is 
for information purposes only. 

Entering the 
Enquiry 
Details 

122 GET_OVERS_UPON_
COMPONENT_CHAN
GE 

0 Reset operation binders overs when 
altering the operation component 
information (1=on, anything else=off) 

Estimate 
Finishing 

123 ENABLE_ADVANCED
_BINDERY_ASSISTAN
T_CALC 

0 Switches on the advanced bindery 
assistant calculation method (1=on, 
anything else=off) 

Advanced 
Bindery 
Assistants 

124 MAX_LOGS_PER_AS
SISTANT 

0 Maximum number of hoppers with 
logs/piles 1 assistant can handle 

Advanced 
Bindery 
Assistants 

125 MAX_BIND-
INS_PER_ASSISTANT 

0 Maximum number of bind-ins 1 
assistant can handle 

Advanced 
Bindery 
Assistants 

126 SIGNATURE_ROUNDI
NG_FACTOR 

0.2 Signature rounding factor used when 
calculationg the average number of 
log/piles in the job 

Advanced 
Bindery 
Assistants 
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value Description Chapter 

Reference 

127 BIND-
INS_ROUNDING_FAC
TOR 

0.33 Bind-ins rounding factor used when 
calculationg the average number of 
bind-ins in the job 

Advanced 
Bindery 
Assistants 

128 LOGS_PER_HOUR 0 Number of logs/piles that can be 
processed in 1 hour by 1 assitant 

Advanced 
Bindery 
Assistants 

129 LOG_LENGTH 1200 Site logs/piles length in mm or inches Advanced 
Bindery 
Assistants 

130 APPSETTING_UPDAT
E_FINISHING_WASTE
_FACTOR 

0 Update finishing waste factors when 
using set for all quantities. 0=off/1=on. 

Set 
Quantities 

131 IGNORE_SAME_SITE
_DELIVERIES 

0 Do not calculate deliveries when both 
the start and end locations are the 
same (1 = On, 0 = Off) 

Reviewing 
the estimate 
calculations 

132 VAL_PRECUT_ADDITI
ONAL_TRIM 

0 Additional paper to be trimmed away 
(applied each edge) when precutting 
(mm or decimal inches) 

Pre-cutting 

133 UPDATE_OPEN_SIZE 1 Update open size dimensions when 
component dimensions are changed, 
1 = Yes / 0 = No 

Components 

134 COPY_BIND_QTY_BA
NDS_WARNING 

0 Suppress the warning about press 
routing when copying binding routes 
across quantity bands 

Set 
Quantities 

135 DOUBLE_FACETRIM_
FOR_2PP 

1 Double up the face trim for 2pp webs 
(on by default) 

Press 
Calculation 
Process 

 

Note Setting ids 21, 28, 29, 31, 34, 49 and 108 are not included. 

Estimating Finishing 
Setting 

id Name Example 
value Description Chapter 

Reference 

1 OWINHOUSE 1 Allows users to produce Outwork 
Routes with Inhouse. 

Choosing the 
Finishing Routes 

2 Allow Custom 
Outworkers 

1 Allow Custom Outworkers to be 
used in Estimating Finishing (On = 
1, Off = 0). 

Reviewing the 
Outwork Pricing 
Details 

Sales Enquiries 
Setting 

id Name Example 
value Description Chapter 

Reference 

1 VAL_DEF_PROCE
SS_ID 

A Default print process. Set to ID 
contained in Processes table. 

Setting is no 
longer used 

2 VAL_DEF_PRINTS
ITE_ID 

6 Default print site. Set to ID 
contained in Sites table. 

Setting is no 
longer used 
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id Name Example 

value Description Chapter 
Reference 

3 VAL_DEF_ORIGIN
ATION_ID 

1 Default origination type. Set to ID 
contained in Origination table. 

Setting is no 
longer used 

4 VAL_DEF_RUN_O
N_QTY 

1000 Default enquiry run on quantity. Quantities 

5 VAL_DEF_ENQUIR
Y_QTY 

50000 Default enquiry order quantity. Quantities 

6 VAL_DEF_BINDST
YLE_ID 

WS Default enquiry finishing style. Set 
to CODE contained in 
FinishingStyles table. 

Finishing 

7 VAL_DEF_SIZE_D
EPTH 

297 Default enquiry product depth. Entering the 
Enquiry Details 

8 VAL_DEF_SIZE_W
IDTH 

210 Default enquiry product width. Entering the 
Enquiry Details 

9 VAL_DEF_INK_CO
VERAGE 

30 Default ink coverage (%). Ink 

10 OPT_DELDATE_R
EQD 

1 Does the enquiry require a delivery 
date (TRUE/FALSE). 

Setting is no 
longer used 

11 VAL_DEF_CURRE
NCY_SYMBOL 

GBP Sets the application currency 
symbol. 

Entering the 
Enquiry Details 

12 VAL_DEF_COLOR
S 

1,2,3,4 Sets default color configuration. Set 
to ID contained in Colors table. 

Ink 

13 VAL_DEF_PACKIN
G 

551,60 Sets default packing type. Set to ID 
contained in Packing table. 

Packing 

14 VAL_DEF_DELIVE
RY_LOCATION 

Leeds Sets default delivery location. Must 
be set to a matching entry in the 
Locations table. 

Delivery 

15 VAL_DEF_FREQU
ENCY_ID 

12 Default frequency for new enquiries. 
Set to ID contained in 
LookupFrequency table 

Entering the 
Enquiry Details 

16 VAL_DEF_NO_ISS
UES 

1 Default number of issues for new 
enquiries 

Entering the 
Enquiry Details 

17 VAL_SYS_FINSTY
_ONLY 

FALSE Hides all non system finishing styles 
from the finishing drop down lists 

Creating a Sales 
Enquiry 

18 VAL_DEF_INK_CO
VER 

50 Default ink coverage (cover) NB: 
supercedes setting 9 

Ink 

19 VAL_DEF_INK_TE
XT 

40 Default ink coverage (text) NB: 
supercedes setting 9 

Ink 

20 VAL_DEF_INK_OR
DERFORM 

25 Default ink coverage (orderform) 
NB: supercedes setting 9 

Ink 

21 Show CSR and 
CSR Filter 

TRUE TRUE shows the CSR FALSE hides 
it 

Enquiry List 
Views 

22 Show Designation 
Filter 

1 TRUE shows the Designation list 
FALSE hides it 

Enquiry List 
Views 

23 VAL_DAYS_TO_S
UBMIT 

3 The lead time for 'required by' date 
in days 

Entering the 
Enquiry Details 

24 VAL_TIME_OF_SU
BMIT 

16:00 The default time of day for 'required 
by' 

Entering the 
Enquiry Details 
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Setting 
id Name Example 

value Description Chapter 
Reference 

25 OPT_COUNTY_RE
QUIRED 

1 0=false 1=true  Standard 
Enquiry Form 

26 Default Pre Press 6,11 Comma separated default pre press 
options 

Entering the 
Enquiry Details 

27 VAL_DEF_PAPER
_ITEM 

 Defines the default paper grade, 
brand & weight for new components 
added to the enquiry. Enter the 
ItemID from Material Maintenance. 

Entering the 
Enquiry Details 

28 VAL_DEF_DELIVE
RY_DAYS 

7 Defines the default number of days 
to add to the date the enquiry is 
submitted for the DELIVERY date. 

Entering the 
Enquiry Details 

29 VAL_DEF_ARTWO
RK_DAYS 

1 Defines the default number of days 
to add to the date the enquiry is 
submitted for the ARTWORK date. 

Entering the 
Enquiry Details 

30 VAL_DAYS_TO_F
OLLOWUP 

7 The lead time for 'follow up' date in 
days 

Entering the 
Enquiry Details 

31 VAL_TIME_OF_FO
LLOWUP 

10:00 The default time of day for 'follow 
up' 

Entering the 
Enquiry Details 

32 QP_CUSTOM_PAP
ER_TEXT 

 Displays as QP paper text (if no 
entry then standard text is used) 

No longer used 

33 ENQ_DETAIL_INF
O 

 Default further information text (enq 
detail) 

Entering the 
Enquiry Details 

34 ENQ_COMPONEN
T_INFO 

 Default further information text (enq 
component) 

Entering the 
Enquiry Details 

35 ENQ_FINISHING_I
NFO 

 Default further information text (enq 
finishing) 

Entering the 
Enquiry Details 

36 ENQ_CUSTOMER
_INFO 

 Default further information text (enq 
customer) 

Entering the 
Enquiry Details 

37 SENTHOW_REQUI
RED 

True Enquiry form requires Sent How 
selection 

Entering the 
Enquiry Details 

38 New Enquiry Email 
Notification 

techniquecrm
@efi.com 

Email Address that is notified when 
a new enquiry is submitted 

Submit to 
Estimating 

39 ENQ_DECLINED_
STATES 

7 Comma separated list of ESCodes 
from EnquiryStatusCode table.  
Default is 7 only. 

Changing the 
Status of an 
Enquiry 

40 COMPLETIONORQ
UOTEDATE 

0 Date displayed in the 
enquiry/estimating grids in MIS C 
(0=QuoteDate, 1=CompletionDate) 

Enquiry List 
Views 

41 VAL_DEFAULT_PA
GE_UNITS 

14 Specifies the default meausurement 
units for page dimensions. Enter a 
valid ID from the 
MaterialUnitOfMeasure table. (0 = 
Not used / Base Measurement 
Units) 

Entering the 
Enquiry Details 

42 OPT_DEFAULT_B
LEED 

1 Set Default Bleed (1 = On, 0 = Off) Entering the 
Enquiry Details 

Setting the Run Back percentage default value 
Currently there is no application setting for this. To set the default values you will need to open the 
Estimating.dbo.QuoteStyle table in the SQL database and change the default values for the following: 
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QSPrintingRB  

QSPaperRB 

QSBindingRB 

QSPackingRB 

QSDeliveryRB 

QSExtrasRB 

MIS Console 
Below are the settings that are applicable for use with Sales Enquiries, Estimating and Quick Pricer only. 

Setting 
id Name Example 

value Description Chapter 
Reference 

2 APPSETTING_PRODUC
TTYPE_CODE 
 

0 Defines if Product Type and Code 
are required fields. O = Off, 1 = On 
 

Creating a Sales 
Enquiry 

3 
 

RFE_DEPTHWIDTHDEF
_FROMSEC 
 

1 Defines if the RFE Header 
Depth/Width fields are taken from 
the First Component in the BOR 
template 
 

Creating a Sales 
Enquiry 

7 
 

WIDTH_DEPTH_DECIM
ALPLACES 
 

0 Number of decimal places used in 
RFE Forms (not us mode) 
 

Creating a Sales 
Enquiry 

8 
 

EXACT_MATCH_ENQUI
RY_SEARCH 
 

0 Defines if the Enquiry Searches by 
like or equal 
 

Searching for an 
Enquiry 

16 
 

USE_REPRICED_BASE 
 

0 MIS Console repricing uses an 
estimating reprice instead of the 
true base values (1 = On, 0 = Off) 
 

Repricing a 
quotation in MIS 
Console 

19 
 

QP_ESTIMATE_SITE_O
NLY 
 

 If on then only use resources at the 
estimate site in quickpricer (1 = On, 
0 = Off) 
 

Quick Pricer 

 

Reference to specific application settings will be included throughout the Estimating 5.4 User Guide when 
explaining the different scenarios available to you. 

Estimating Maintenance 
This application provides the means to configure Estimating in its environment to work with the Estimating, Order 
Management and Planning, and Job Costing.  

Note The values and specific configurations set in the application should follow careful consideration of the 
business process and workflows used in the company implementing the system.  The decisions taken in 
this part of the set-up process are key to the successful use of the associated applications and the 
availability of meaningful information. 
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The Estimating Maintenance application is opened from the Tools menu in Estimating. You need to have the 
Estimating Maintenance application as an allowed application for your profile group and the option Members can 
perform Administration for the Estimating application. 

 

This application provides the source for the Estimating configuration data and associated costs.  The data is 
input via various tabs within the application. 

Some data entered is site specific, such as where equipment is located, whether prices are marked-up 
universally or by department etc.  It is worthwhile getting to know what data is stored where within the Estimating 
Maintenance application, and subsequently what affect that data has on the estimating process. 

The basic areas requiring data input are: 
• Printing sites (mark-ups set at site level) 

 
• Press list (press data including product configurations, waste rates, speeds) 

 
• Finishing details (includes binding parameters, insert prices) 

 
• Outwork details 

 
• Location (used to input mileages) & Currency information (where relevant) 

 
• Terms to be used on quotations 

 
• Miscellaneous detail (include material, press extra, ancillary, etc., detail) 

Entry of Time 
The entry of time factors is required on a number of the windows, for example, Make Ready Hours for a press.  
All time entry is in decimal hours and not hours and minutes, for example 1 hour 30 minutes needs to be entered 
as 1.5 hours. 

Maintaining Data  
A number of the windows presented to you use the following to control the addition, editing and deletion of data. 

 

To add a new entry click Data from the tool bar and select New Row or press CTRL+N. 

To delete an entry highlight the required row and click Data on the tool bar and select Delete Row or press DEL. 

To edit a line entry, on the majority of occasions you will need to simply type over it.  To save data entered, 
simply move off the line entry. 
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Process Flow 
The following process flow, provides you with the optimum sequence to enter the data into Estimating 
Maintenance.  

 

Site Tab 
The concept of the Site within the EFI Technique system is fundamental, whether your organization is a single or 
multi site installation. A site needs to be entered prior to entering resources or materials, as these entries need to 
be associated to a site.  

The Site tab is separated out to allow you to enter specific data.  
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Field Name Description 

Location The actual site location for which you are entering details. The location 
needs to entered on the Location / Currency tab prior to selection on the 
Site tab. The location entered also links to the User’s location that provides 
or limits access throughout the applications. 

Default outworker If multiple outwork binders are used instead of in-house binding, you have 
the ability to select a preferred outworker for the site. If a default outworker 
is selected, when calculating binding routes and the outworker is capable of 
producing the specification of the product, this will be the outworker 
presented to the user in the Estimating application by default (rather than 
the cheapest route). 

Graduation in press running 
speed 

The press speed tables use quantity breaks, however if this check box is 
selected, the application will calculate the average speed across a print run 
to create a smooth speed increase rather than stepped. If it is not selected, 
the speed is calculated based on the maximum speed for the specification 
of the product.  An example is provided below. 

Maximum Plate Impressions The quantity at which a full set of plates, follow on make-ready and follow 
on make-ready sheets are included in to the estimate to account for plate 
wear. 

Platemaking cost rate Cost rate per hour for platemaking. 

Pre Press cost rate Cost rate per hour for pre press activities. 

Imposition time 1 page Imposition time for 1 page.  This is irrespective of the number of colors on 
the page,  in other words, the same amount of time will be calculated for a 
4/4/ and 1/1. 

Planning time 1 color page Planning time for 1 piece of film per page. Not required if using CTP. 

Pre-press AV % limit Sets the maximum percentage of pre-press costs to be included within the 
estimated price. This functionality is more orientated to the Gravure 
process. 

Pre Press Mark Up (%) The percentage mark up to apply to the pre press cost. 

Matt/Silk ink uplift % Where matt or silk coated papers are included, a percentage mark up on 
the ink can be used if required. 

Product weight uplift (%) Uplift % applied to the calculated book weight to account for ink and non-
paper materials. 

Apply Site Mark Up %; Apply to 
Delivery 

The percentage mark up to apply to the delivery costs entered within the 
Location / Currency tab. 
Apply to Print, Binding and Packing is not used. 

Paper handling charge/tonne 
({local currency}): 

Ability to specify a handling charge for customer supplied paper. Please 
note that by default, the paper handling charge is only applied to customer 
supplied papers. However, an application setting is available that can 
change the functionality so that the paper handling charge is applied to 
both customer supplied and printer supplied papers. 

Bindery assistant rate ({local 
currency}): 

The cost rate per hour for bindery assistants. 

Bindery assistant mark up %: Mark up applicable to bindery assistants. 

Gravure Site Select the checkbox to denote that the site contains gravure presses. 

Repro Cost Per Page Ability to enter a different cost rate per page for repro for gravure 
resources. 
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Graduated Running Speeds 
Below is an example of how graduated running speeds are calculated. 

Example Speed Table: 

Speed Breaks Speed (copies per 
hour) 

Less than 10,000 copies 5,000 

Less than 20,000 copies 8,000 

Greater than 20,000 copies 10,000 
 

When the Graduation in Press Running Speeds check box is selected, estimating will calculate the running time 
and speed for a press that uses the above speed table as follows: This example is based on an enquiry quantity 
of 75,000 copies. 

Impressions Speed (copies per 
hour) Hours 

10,000 5,000 2.00 

10,000 8,000 1.25 

55,000 10,000 5.50 
 

For a press run of 75,000, the total time on press would be 8.75 hours therefore this would give an average run 
speed of about 8,571 impressions per hour. 

When Graduated Running Speeds is not selected, the estimating calculation will simply determine which speed 
range the estimate quantity falls into. In the example above, the quantity of 75,000 would fall into the range 
defined by row 3 (>20,000), so a speed of 10,000 impressions per hour would be selected, giving a running time 
of 7.5 hours. 

Press Site Link and Finishing Site Link 
To enable press and finishing resources to be available in Estimating and Order Management, the press and 
finishing resources must be linked to the site producing the estimates and routes in Order Management.  

Note You will need to ensure that the resources have been added to the Press and Finishing tab before you 
can link to the site, however adding a resource and linking to a site on the Press or Finishing tab will 
automatically populate the Press or Finishing Site Link. 

This feature is particularly useful for multi-site applications and is be used in conjunction with the profile group 
settings granting access to Site, Sector and Group.  

For example, if you are an estimator but your profile group only allows access to Site, then regardless of whether 
either the Press or Finishing Site Link has access to other sites and their resources, you will only be able to 
estimate including resources which are available at your site. 

Creating the Press and Finishing Site Link 

Note The following steps can be applied to the Finishing Site Link. Simply replace the Press Site Link below 
with Finishing Site Link. 

1. To add a Press Site Link, select the Site Name. 
 

2. Click Press Site Link and the Press Site Link window will open. 
 

3. Click Data > New and a blank row will appear at the top of the window. 
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4. Enter the Press Name (this will be prefixed with the Site Code to which the resource is linked on the 
Press tab). The Press Site will automatically populate with the Site name previously selected. 
 

5. If you need to enter a press site link for a different site, click on the Press Site field and select the 
different Site prior to selecting the Press Name. 

 

 

Pre Press Costs 
The Pre-Press Costs window allows you to enter costs associated to the Pre-Press activities that have been 
entered in Miscellaneous > Pre Press.  

  

New pre-press items can be entered for the site by clicking Add.  Highlighting the row and clicking Remove can 
delete existing pre-press items. 
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Field Name Description 

Effective From Date from which the cost/price is effective from. 

Effective To Date to which the cost/price is effective to. 

Activity Selected pre-press activity as entered in Miscellaneous > Pre Press. 

Size Selected pre-press activity size as entered in Miscellaneous > Pre Press. 

MR Hours Make ready hours for the activity. 

Hours Operation time in hours. For example, time to proof 1 page. 

Labour Costs 
Rate 

Labour cost rate per hour. 

Material Cost Pre Press material cost. 

Apply Markup If selected will apply a markup % to the costs to achieve the sell price. 

Mark Up (%) Enter the percentage markup to apply to the costs to achieve the sell price. 

Labour Sell 
Rate 

Sell rate per hour. 

Material Sell 
Rate 

Pre Press activity material price. 

Total Cost Sum of Labour Cost Rate and Material Cost. 

Total Sell Sum of Labour Sell Rate and Material Sell Rate. 
 

For example: 

A4 Page Proofs take 15 minutes to prepare, labour is charged at £45 per hour, and have a material cost of £5 
per page.  There is a 20% mark-up applied to achieve the price.  

To set this up you would enter the following: 

Field  Value 

MR Hours 0 

Hours 0.25 (15 minutes expressed as decimal time) 

Labour Cost 
Rate 

£45 per hour 

Material Cost £5 per page 

Apply Markup Selected 

Markup % 20 

Total Sell ((Labour Cost Rate x Hours) + Material Cost) x 
markup % 
((£45 x 0.25) + £5) x 20% = £19.50 

 

Alternatively if the Apply Markup check box is clear then the Labour Sell Rate and Material Sell Rate can be 
entered. 

If the operation incurs MR Hours then the time is only included in the calculation once for the component. 

For example: If Sherpa Proofs require 45 minutes to make ready and 6 minutes to process each page then and 8 
page component would require 1.55 Hours labour: 

Field  Value 

MR Hours 0.75 (45 minutes express as decimal time) 
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Field  Value 

Hours 0.10 (15 minutes expressed as decimal time) 

Total MR Hours + number of pages x Hours per page 
0.75 + (8 x 0.10) = 1.55 hours 

Binders Overs 
The Site Binding Overs window allows you to enter the Binders Overs percent and quantity for each finishing 
style, number of sections and quantity range. You can enter both the percentage and a set quantity and the two 
will be added together to calculate the total number of overs required. 

 

When entering a new entry the combination of Finishing Style, No of Sections, Quantity Range Low and 
Quantity Range high must be unique. 

An entry must be added for each finishing style for each number of sections up to the maximum number of 
sections the site can handle.  When calculating the finishing, for the number of sections for the chosen style, the 
number of binders overs will be added to the press gross copy and paper requirements. 

Note The user should ensure when entering a quantity range for a particular number of sections of a chosen 
finishing style, that the range does not overlap that of an existing entry.  To do so could cause 
unpredictable results during the calculation process. 
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Trim Sizes 
Ability to define the default trims against finishing styles. These will be used when calculating web widths and if a 
press is capable of producing the product. 

 

All finishing styles entered in Miscellaneous > Finishing Styles that are as a primary style must have an entry 
created for the site to represent the default trims.  Otherwise the calculation process will fail. 

The spine trim is only added to the sheet size calculation for the Perfect Bound (PB) style. 

Likewise, the Binding Lap dimension will only be incurred against the Wire Stitched finishing style or any other 
custom finishing style that is indicated as requiring a lap. 

The Gripper trim is only added to the sheet size calculation for sheet feed press types. 

The gripper trim is always added to the depth of the sheet.  The additional trim is always added to the width of 
the sheet. 

Trims are applied to the page as follows: 

 

 

 

 

 

 

 

 

 

A4 (297x210) 
Portrait Page 

Foot 

Head 

Foredge 

 

S
pine 
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Sheet size calculation Wire Stitched example: 

16pp A4 (297x210), saddle stitch (WS) section.   

8 Pages to view; page layout is 4 pages across the sheet and 2 pages down the sheet. 

WS Trims are as follows: 

Head = 4mm, Foot = 4mm, Foredge = 7.5 mm, Additional Trim = 0mm and Gripper = 10mm. 

 

Therefore the calculated sheet size for this lay down is as follows: 

Web Route width: = (Page Width + Foredge Trim )  * pages across + Additional 

   = (210 + 7.5) * 4 + 0 

   = 870mm 

Web Route Depth: = (Page Depth + Head Trim + Foot Trim) * pages down 

   = (297 + 4 + 4) * 2 

   = 610mm 

For a sheet fed press type the calculation is the same as the above except the Gripper trim is added to the sheet 
depth making the calculated depth 620mm.  
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Sheet size calculation Perfect Bound example: 

16pp A4 (297x210) perfect bound (PB) section.  8 Pages to view – 4 pages across and 2 down. 

PB Trims are as follows: 

Head = 4mm, Foot = 4mm, Foredge = 4.5 mm, Spine = 3mm, Additional Trim = 0mm and Gripper = 10mm. 

 

Therefore the calculated sheet size for this lay down is as follows: 

Web Route width: = (Page Width + Foredge Trim + Spine) * pages across + Additional 

   = (210 + 4.5 + 3) * 4 + 0 

   = 870mm 

Web Route Depth: = (Page Depth + Head Trim + Foot Trim) * pages down + Additional 

   = (297 + 4 + 4) * 2 

   = 610mm 

For a sheet fed press type the calculation is the same as the above except the Gripper trim is added to the sheet 
depth making the calculated depth 620mm.  

In determining the final sheet size for web offset the width is set to the cut off of the press.  For sheet fed and 
gravure the width is set to the next stock sheet or cylinder size. 

For sheet fed presses that utilize the Reel to sheet option the system will use the calculated sheet size including 
the gripper. 
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Quote Descriptors 
The Quote Descriptors window gives you the ability to change the default terms used on the quotation letter. 
Clicking the various areas on the left of the window will display on the right the standard terms used. You can 
change the terms in this window if required. 

 

Press Tab 
When configuring the estimating system it is not always necessary to configure every piece of equipment the 
organization may have. The application supports the linking of multiple actual resources to one estimating 
resource, for example, if the organization has three presses that have the same capabilities and the same 
cost/price rates then only one estimating press is required.  
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Field Name Description 

Press ID System generated ID for the resource 

Press Type The process type of the resource, for example, web offset, sheetfed, digital or gravure. It is 
important to choose the correct Press Type as this will affect the both configuration and 
calculation process. 
Web Offset:  For Heatset and Coldset presses.  Primarily any press that is web fed and is 
costed/priced on a rate per hour. 
Sheet Fed:  For sheet fed presses including presses that utilise the web to sheet option. 
Digital: For presses that are priced on a click count basis (cost/price per single color page).  
This applies for single sheet or continuous sheet (mini web). 
Gravure:  Gravure Presses. 

Generic Name Typically, the manufacturer and model of the press i.e. Baker Perkins G16 and is used for 
reporting purposes.  
Note   This is not a required field. 

Name Your name for the press resource, for example, Press 3.  This is the name seen by the 
estimator. 

Vendor Allows for the entry of the vendor of the press, for example, Komori, Heidelberg etc.  
Note   This is not a required field. 

Available for 
Quick Pricer 

If you have the Quick Pricer license, selecting this check box allows this resource to generate 
prices based on the configurations set up against the press resource. 

Supports 
Sheets 

Available only when Wide Format is entered as the Press Type for the resource and allows 
you to enter whether the Wide Format press can accept sheets of paper. 

Supports Rolls Available only when Wide Format is entered as the Press Type for the resource and allows 
you to enter whether the Wide Format press can accept rolls of paper. 

Site The site at which the press is located. 

Live Select to confirm whether the press is active and can be included in route calculations. 

No. of Units Enter the number of units on the press.  Must be at least 1.  1 Unit equals 1 color on each 
side of the web/sheet. 
Example 1: A Sheet fed press that can print a 4/4 sheet in 1 pass equals 4 units 
Example 2: A Coldset press that has 4 reel stands and supports 4/4 colors  on tower 1 and 
2/2 colors on towers 2 to 4 equals 10 units 

No. of 
reelstands 

Enter the number of reelstands on the press. Must be at least 1. 

Min Sheet 
Depth 

Enter the absolute minimum sheet depth that can be run through the resource. Only required 
if the press prints on sheets. 

Cut-off Enter the cut-off for a web press and maximum sheet depth for a sheetfed resource.  

Web\Sheet Min 
width 

Enter the minimum web/sheet width. 

Web\Sheet 
Max width 

Enter the maximum web/sheet width. 
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Field Name Description 

Utilisation Enter the utilisation factor of the resource. This is included in the calculation of time when 
press routes are issued from Order Management to Planning. 
All hours defined against an estimating resource represent 100% production time.  The 
utilisation factor is the percentage of time to be allocated as downtime when issuing jobs to 
the plan. 
The utilisation factor is linked to Production Downtime % (PDT%) used in Production 
Scheduling. 
Utilisation = 100 / (PDT + 100), for example, 
1hr estimated running time when issued to the plan will be planned as 1 hour 15 minutes; 
80% utilisation of 1 hour = 48 minutes which is calculated as 12 minutes unproductive time; 
12 minutes as a percentage of 48mins is 25%. 25% of 1hr is 15 minutes, therefore total run 
time is 1 hour 15 minutes. 

Basic running 
waste 

Enter the default running waste for the press, regardless of configuration. 
For example, if running waste values have been entered in the Press Running Waste window 
and assigned to individual press configurations, the maximum quantity range has entries up 
to 1,000,000 and a job requires 1,100,000, the Basic Running Waste value will be used. 

Maximum Plate 
Impression 

Enter the absolute maximum number of impressions that can be run from a single set of 
plates before additional sets need to be made. This value impacts on the make-ready times, 
running speeds and plate values during the press route calculations. 

Running waste 
in impressions 

Select this check box if the running waste is calculated based on impressions or sheets 
rather than copies. 

Plate making 
hours/plate 

Enter the number of hours to process a plate. This will be multiplied by the number of 
required plates for the component to determine the number of Plate Labour hours. For 
example, a 16pp 4/4 component will require 8 plates.  If 0.15 hours is required to process 
each plate then the total time required will calculate 1.2 hours. 
The cost is calculated by multiplying the total plate labour hours by the Plate making Cost 
Rate entered on the Site tab.  
The price is then determined by adding the Pre Press Mark Up % specified against the Site 
Header. 

Cost of 
plate/cylinder 

Enter the cost of a plate. 

Plate mark up 
% 

Enter a percentage markup (if applicable) for the plate cost. 

Plate material Enter the plate material used on the press which have been entered within the Plate material 
group Miscellaneous > Materials. 

Perfecting bar 
after unit 

This is for sheetfed presses only. Enter the position of the perfecting bar, if applicable. If 
there is no perfecting bar entered, if the number of colors within a print section exceeds the 
number of units of the resource, the Estimating application will automatically calculate 
additional passes. 

Web\sheet 1 
MR hours 

Enter the base make ready time for the 1st web or sheet for the press, for example, 
configuring folders. Plate mounting is entered in the Plate Setup window. 

Web\sheet 1 
follow on MR 

hours 

Enter the follow base make-ready time for the 1st web or sheet for subsequent sections.  
For example, an estimate that includes 2 x 32pp sections. The first 32pp section will include 
Web 1 MR hours to calculate its make ready time and the second 32pp will include the 
Follow On make ready time. Plate mounting is entered in the Plate Setup window. 

Addt’l 
web\sheet MR 

hours 

Enter the base make-ready time for additional webs for the press, for example, configuring 
folders. Plate mounting is entered in the Plate Setup window. This is not applicable for sheet 
fed presses. 
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Field Name Description 

Addt’l 
web\sheet 

follow on MR 
hours 

Enter the follow base make-ready time for additional webs for subsequent sections, for 
example,an estimate that includes 2 x 32pp. The first 32pp section will include the Addt’l Web 
MR hours to calculate its make ready time and the second 32pp will include the Addt’l Web 
follow on make ready time. Plate mounting is entered in the Plate Setup window. 

Process unit 
wash up hours 

Enter the wash up times between process color jobs. 
The number of process colors defined against the component and added to the MR Hours 
will multiply this value.  

Special color 
MR hours 

Enter the wash up time for a special color such as Pantone or Spot etc. The number of 
special colors defined against the component up to the maximum number of spare units on 
the press and added to the MR Hours will multiply this value. 
Spare units on the press are calculated by recognizing the Number of Units on the press, for 
example, 4. 
Example 1: If the press has 5 units and 2 special colors are entered in the estimate.  There is 
1 spare unit on the press so 1 x Special Color MR hours will be added. 
Example: If the press has 6 units and 2 special colors are entered in the estimate.  There are 
2 spare units on the press so 2 x Special Color MR hours will be added. 

Process to 
special MR 

hours 

Enter the wash up time for changing a process color to a special color such as Pantone or 
Spot etc. 
The value is only incurred if special colors have been included in the estimate, and the 
number of press units required is less than the total number of colors. This value will be 
multiplied by the number of special colors over the number of press units and added to the 
MR Hours. 
Example: If the press has 4 units and 2 extra special colors are included in the estimate, 
there are no spare units on the press so 2 x Process to Special MR hours will be included in 
the calculation. 

Reel width over Enter a web width at which an additional make-ready time needs to be included in the 
calculation. More suited to large web formats such as gravure processes.  Not applicable for 
sheet fed. 

Extra MR 
hours: 

Enter the additional make-ready time applicable to web widths above that stated in the Reel 
width over field. 

Use Pages Per 
Plate 

Generally used for Coldset type press where plate calculations differ to those used for 
Web/Sheet Fed presses. This will impact on the number of plates calculated for a press run. 
For example, a black plate required for an 8 page to view imposition and only 2 pages per 
plate can be achieved. The resulting number of plates for the black would be 4, for example, 
8 pages to view divided by 2 pages per plate. 

Minimum Run 
Hours  

Enter the absolute minimum number of running hours for the press, for example, if the value 
is enteredas 3 and the calculated number of hours in an estimate is 2, the allowance within 
the estimate will be adjusted to the minimum run hour value of 3 hours. 

Make ready 
sheets 

Enter the basic number of make ready sheets for the press.  Additional sheets for plate 
mounting are entered in the Plate Setup window. 

Follow On 
Make ready 

sheets 

Enter the basic number of follow on make ready sheets for the press. 

Plate Maker 
Make Ready 

Enter a fixed amount of plate making hours when making plates for the specific resource. 
Any plate making time per plate from the Site tab will be added on to this. 

Cartridge This field becomes available when Wide Format is entered for the Press Type and allows you 
to select the Cartridge required for the resource from the list of options that are entered on 
the Miscellaneous tab > Cartridges. 

 

Note For Sheetfed presses; Set reel stands to 1 (as there is always one feeder); Set cut-off to 0, as it is 
variable; ensure the perfecting unit location is set for perfecting presses. 
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Note For Tandem presses; Set reel stands to 1 (as there is always one feeder).  

Click Count 
The Click Count button will become available when Digital has been entered as the Press Type for a printing 
resource. The Click Count window allows you to enter the cost and price for digital presses based on a click 
count by number of colors per side of the sheet along with the Mode and quantity range. The mode can be 
selected from the list of options that are entered on the Miscellaneous tab > Caliper Modes. 

Note Pricing entered here is additional to the normal cost per hour calculation 

 

The click count cost/price is calculated on the gross number of sheets. 

For example, 10,000 4pp 4/4 section 1 up that attracts 2% binders overs and 2% running waste. 

Gross Sheets = ((Net Quantity / Number up) * Binders Overs) * Running Waste 
 = ((10,000 / 1) * 1.02) * 1.02 
 = 10,404 Gross Sheets 
Click Cost = No. of gross sheets * no. of colors * cost * no. of sides 

Web Adjust 
Web Adjust is used for Web Offset and Gravure presses only and allows you to accommodate web shrinkage or 
growth caused by heat during the print process. 

Where values are specified in this window, these will be taken in to account during the web width calculation. 
The standard calculation already includes the trimmed page width, any trim allowances for the required finishing 
style along with the number of pages across the web width to determine the optimum web width. However, if the 
optimum web width falls with the Web Width From and Web Width To data entered, the adjustment value 
would then be included in the calculation. 
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Click Add to create a new entry or Delete to remove an existing entry. 

 
Cell Changes 
Cell changes allow you to enter time, cost and price incurred when including data cell changes on a press 
resource. This is more commonly done when using Scitex heads during a press run. 

 
 
Using the above values as an example, if 10 Data Cells were entered against the print component and a route 
calculated on the Komori 16pp, the following values would be included in the route calculation. 

Additional Make-Ready time = 2.5hrs (10 x 0.25hrs) 

Data Cell Change Price = £1,000 (10 x £100) 

Additional Make-Ready sheets = 1,500 (10 x 150) 

In terms of the press cost, the number of additional make-ready hours would simply be multiplied by the cost rate 
of the press. 

Data Cells are usually priced at a market rate hence why a Cell Change price value is entered so that the pricing 
structure can be set independently to the main resource price per hour. 
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Plate Setup 
The Plate Setup window allows you to enter the make-ready waste and the make-ready hours based on the 
number of plates.  

Note Values entered within this window are additional to the base make-ready sheets and hours entered 
within the main screen of the Press tab. 

 

 

Press Extras 
When entering the press configuration data you can enter a configuration for every possible function that the 
press is capable of achieving. However, it is possible that certain operations, that the press is capable of 
producing, incur additional make ready time and sheets, additional run waste and may even affect the cost or sell 
rate of the press.  This data is entered at press level and can then be assigned to a configuration either for 
automatic inclusion in the calculation or, so that the estimator can manually add to a component within the 
estimate for inclusion in the calculation. 

Before you can assign a press extra to a configuration you need to ensure that the generic entry of Press Extras 
have already been entered in the Press Extra Descriptions window. This is available on the Miscellaneous tab of 
Estimating Maintenance. 
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Click Press Extras to open the Press Extra Descriptions window. For more information please see the 
Miscellaneous tab chapter later in this user guide. 

 

On the Press tab, select the press to which you wish to enter the press extras and click Extras. 

 

If the press extra is incurred during the calculation process then all the values are in addition to the base MR 
Sheet, Hours, cost and price.   

Note The Extra Operators is not currently used in the calculation process. 
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If you wish to enter the cost rate Element breakdown for the press extra selected, click Elements.  

 

For further information on Elements see ‘Rate Elements’ later in this guide. 

For further information on how to apply Press Extras to a press configuration please see chapter ‘Press 
Configurations’. 

Before entering the configurations for the press we recommend that the Press Speed, Waste and Trim data be 
added for the press. 

Press Speed 
Each configuration needs to be linked to a press speed and the Press Speeds window allows you to enter the 
various speeds of the resource so that they can be assigned to the different products (configurations). Speed 
data is entered based on paper weight, number of color and also quantity ranges. 

Form the Press tab, click Press Speed to open the Press Speeds window. 

 

Note When adding quantity ranges, it is recommend that these start at zero. This has implications for 
calculating press speed when using Graduated Running Speed. 

For information on how to link the press speed to a configuration see the Press Configurations chapter. 
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When Wide Format is entered as a press type, the Press Speed Area window opens as follows: 

 

This allows you to enter the square meter area and number of square meters per hour which can be achieved by 
the press based on the caliper modes entered on the Miscellaneous tab > Caliper modes. 

Running Waste 
There are two ways to enter the running waste for a press.  You can choose to use the Basic Running Waste % 
value for the press that does not vary based on quantity or grammage, or you can choose to enter running waste 
profiles that can then be linked to specific configurations on each resource.  

If required, Paper waste levels can also be included in the running waste profiles. This figure relates to unprinted 
paper (slab and core) used when preparing a press. The paper waste is not included in the ink or running time 
calculations. 

The running waste Profile ID can be assigned to a configuration much the same way as the press speed table 
(for further information see the Press Configurations chapter). 

 

When calculating the running waste for a print section within an estimate the application will use the running 
waste profile if it is linked to the configuration. If no valid running waste profile entry is found, then the Basic 
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Running Waste % figure will be included in the calculation. Therefore you only need to enter running waste 
profiles for exceptions to the basic running waste. 

Note Where running waste profiles are entered, these are in substitution (not in addition) to the basic running 
waste. 

Additional Trims 
On the Site tab you enter the trim sizes for each site and each finishing style. However, if you need to increase or 
decrease these values then you can enter Additional Trim profiles per resource that can then be linked to specific 
press configurations, (for further information see the Press Configurations chapter). 

 

 

Note Where additional trim profiles are entered, these are in addition to the basic trims defined against the 
finishing style on the Site tab. 

Rates 
The Rates window allows you to enter the cost and selling rate for the resource that will be included in the route 
calculation.  

Rates can be set up in 2 different ways: 

• Hourly cost rate plus mark up 
 

• Hourly sell rate 

If you wish to calculate the sell price of the estimate based on a sell rate, you need to ensure that the Apply AV 
field is entered as Yes and an hourly rate is entered in the Sell Price and Low Sell Price fields. These values 
can be the same or different to the Cost Rate. The application will calculate the sell value based on the 
calculated Make Ready and Running time for the print route multiplied by the Sell Price value entered. 

If you wish to calculate based on the Cost Rate plus mark up, you need to enter No in the Apply AV field and 
then enter a value in the MU% field.  The application will calculate the sell value based on the calculated Make 
Ready and Running time for the print route multiplied by the Cost Rate + MU% value entered 
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You can enter either value based on date ranges to accommodate any seasonal time frames variations to the 
sell price. 

 

Rate Elements 
You can enter the cost rate breakdown Elements for each resource for analysis purposes. 

There are four elements that can be defined – LABOUR, FIXOH (Fixed Overheads), VAROH (Variable 
Overheads) and DEPREC (Depreciation).   

The element percentage defines how the cost rate is apportioned.   

You will not be able to enter an element that is greater than 100, and during setup you need to ensure the total 
percentage for all elements add up to 100. 

Note This information is not used in the estimating calculation, but is supported to enable the user to analyze 
the information at the lower level if required and is output to the Estimate XML file for reporting 
purposes. 

 

Press Configurations 
This is the hub of the EFI Technique calculation. Estimating, Order Management, Inventory Management and 
Production Scheduling all use these configurations. As a consequence it is imperative to enter this data correctly 
and as accurately as possible. 

To open the Press Configuration window, select the Resource from the Press tab and either; 

a. Click Configurations, or 
 

b. Double click the Resource from the Press Details area. 
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The Press Configuration window will open. The tree view on the left of the window is automatically generated.  
There are 4 levels within the hierarch that are based on the entries made in the Size, Finishing Style, Pagination 
and Orientation fields against the configuration. 

To create a configuration select Edit > Add from the toolbar menu. 

To view an existing configuration you can either select the size, or finishing style, and then expand the list based 
on pagination, orientation and configuration id. 

 

Select the Configuration id and the Attributes will display. 

If a configuration already exists and you wish to create an additional configuration which is similar, find and 
select the existing configuration and click Edit > Copy from the toolbar menu. 

Double click 

Click Configuration 
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If you know the configuration id you can click Edit > Find and enter the configuration id. Click OK and if the 
configuration exists it will open in the window. 

 

 

 

Field Name Description 

Config ID System generated ID for the configuration. 

Press ID System populated ID for the press. 

Live Enter whether the config is active or inactive. 

Size Enter the agreed coding for the size, for example, A4. The size entry is used to 
group the configurations in the hierarchy tree. 

Pagination Enter the number of pages in the component. For example, for a 4pp section 
printed 4up, this is entered as 4. 

Orientation Orientation of the product , for example, P for Portrait, L for Landscape. The 
orientation entry is used to group the configurations in the hierarchy tree. 



48 l EFI Technique 5.4 | System Admin for Sales Enquiries, Estimating and Quick Pricer 5.4 User Guide 

 
 

 

Field Name Description 

Plate Multiplier Enter a value if the standard plate calculation should be multiplied by the value 
within this field. Typically used for Coldset press configurations where multiple 
plates per color are mounted on the press. 

Available for Quick Pricer This needs to be selected if the Press Configuration can be used for pricing when 
using the Quick Pricer licensed module. 

Speed number Enter the speed number the configuration is linked to. 

Run waste no. Enter the running waste profile id the configuration is linked to. 

Add Trim No. Enter the additional trim profile id the configuration is linked to. 

Finishing Style This field is unavailable for editing and will display the finishing style that the 
configuration supports. To amend the finishing styles that support the configuration 
click Styles. 

Styles Click Styles to enter the finishing styles that the configuration supports. For further 
information see the Styles sub-chapter later in this guide. 

Description Enter the name for the configuration. It is important that the description is 
informative, as this text will appear in the route selection window in Estimating and 
will aid the Estimator in route selection. It is also visible in Order Management and 
Production Scheduling. 

Warn This is an optional field and allows you to enter a warning specific to the 
configuration. If entered, this text will appear in Estimating, Order Management 
and Production Scheduling if the configuration is available for selection or 
selected. 

Bleed Select Bleed if the configuration supports a product that bleeds. Within Estimating 
this will filter routes based on whether the Bleed field is selected against the 
component. 

Non Bleed Select Non Bleed if the configuration supports a product that does not bleed. 
Within Estimating this will filter routes based on whether the Bleed box is checked 
against the component. 

Min Depth (Bleed) Enter the minimum product depth supported by the configuration where the 
product is bled. 

Max Depth (Bleed) Enter the maximum product depth supported by the Configuration where the 
product is bled. 

Min Width (Bleed) Enter the minimum product width supported by the configuration where the 
product is bled. 

Max Width (Bleed) Enter the maximum product width supported by the configuration where the 
product is bled. 

Min Depth (Non Bleed) Enter the minimum product depth supported by the configuration where the 
product is not bled. 

Max Depth (Non Bleed) Enter the maximum product depth supported by the Configuration where the 
product is not bled. 

Min Width (Non Bleed) Enter the minimum product width supported by the configuration where the 
product is not bled. 

Max Width (Non Bleed) Enter the maximum product width supported by the configuration where the 
product is not bled. 

Min paper weight Enter the minimum paper weight supported by the configuration. 

Max paper weight Enter the maximum paper weight supported by the configuration. 

Min no. of colors Enter the minimum number of colors supported by the configuration. This is 
independent of the presses capabilities. 
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Field Name Description 

Max no. of colors Enter the maximum number of colors supported by the configuration. This is 
independent of the presses capabilities, for example, a 4-color sheetfed press 
could have a configuration that uses 8 colors. In this example, the Estimate would 
calculate 2 passes. 

Number up Enter the number of identical sections per impression. 

Width or depth on the 
web\sheet 

Enter whether the page width or page depth prints across the web width. This is 
used in the calculation of the web width. 

Minimum run length Enter the minimum run length for this configuration. In Estimating, if the quantity is 
below this value, a print route for the configuration will not be calculated and 
presented for route selection. 

Maximum run length Enter the maximum run length for this configuration. In Estimating, if the quantity is 
above this value, a print route for the configuration will not be calculated and 
presented for route selection. 

Apply to Production If selected, the minimum and maximum run quantities are used to filter the 
configurations offered in Order Management and Production Scheduling. If the 
check box is not selected then configurations will not be filtered by the minimum 
and maximum run quantities for the configuration.  
 
When a new configuration is added the check box is selected by default.  
This is only for Order Management and Production Scheduling purposes as the 
Estimating application will always filter route selects based on the minimum and 
maximum quantities. 

Cut Off Override Enter a cut off override if the press configuration utilizes a different cut off to that 
entered for the press on the Press tab. This is particularly useful if printing 
stationery or business forms where cylinder circumferences are interchangeable, 
for example, 4”, 8”, 12” drops etc. 

No. of delivery streams Enter the number of delivery streams used when producing the product. This 
equates to the number of different bindery sections produced (typically 1 or 2). 

Collated Output This check box is used within Order Management only and is not required for the 
Estimating application. When selected in a configuration, and when entered in the 
Print Routing tab in Order Management, like for like sections using the same 
configuration will be grouped together as a single line entry rather than splitting in 
to multiple line entries. 

Come and Go If selected, this check box affects the binding calculations (not press). ‘Come & 
Go’ sections use 2 hoppers per signature and will only return 2up binding options.  
For example, this way the 3 x 96pp Come & Go section will use 6 hoppers and 
only 2up options for the binding calculation. 

Pages across 1 – 12 Enter the number of pages across the web width. This includes multiple up 
sections. For example a 4up, 4pp section would be specified as 4 across and 2 
down. (For multi-web presses, the number of pages across each web can be 
selected). 

Pages down 1 – 12 Enter the number of pages imposed out of the cut off of the press resource. (For 
multi-web presses, the number of pages down each web can be selected. 

Fold Catalog Enter the JDF fold catalog to be used as part of the JDF Pre Press integration. 
The catalog entries are created in the Miscellaneous tab in Estimating 
Maintenance. 

JDF Stripping Select to confirm that the application will supply the JDF stripping parameters to 
the Pre Press system instead of a pre-defined template. 

Signature Rotation Enter the signature rotation for the Fold Catalog. If no rotation style is selected, the 
application will use the default of Rotation 0. 
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Field Name Description 

Default Layout This field will display the default layout that will be used, in the majority of cases, 
within Order Management. To amend the default, select Layout. 

Layouts Enter the Preps Template to be used in association with the configuration.  This 
controls the imposition layout seen within Order Management and acts as pre 
selected template for JDF integration. The templates are imported or created in 
the Miscellaneous tab in Estimating Maintenance. 

Work Style (Sheet Fed 
only) 

Displays the type of sheet work run thought the press. Similar to the Finishing 
Styles, multiple work styles can be associated with a configuration to prevent 
unnecessary duplication. Click Styles to amend the Work Style entered. 

Styles (Sheet Fed only) Click Styles to open the Work Styles window and select which style is supported 
by this configuration. The options available are: 
Perfecting 
Sheet Work 
Work & Tumble 
Work & Turn 

Note        If you have a perfecting bar positioned on the resource, you need to 
enter a Perfecting work style for the configurations as appropriate. If 
this is not entered, the Estimating application will automatically 
calculate additional passes through the press when calculating print 
sections where the number of inks is greater than the number of 
units of the press. 

Sheet size (Sheet Fed 
only) 

Enter the fixed paper sheet size to use for the configuration. If not specified then 
the application will calculate the required sheet size and choose the closest 
matching stock sheet from the sheets entered on the Miscellaneous tab in 
Estimating Maintenance.  

Extras Selected Extras will always be applied to this configuration and included in the 
calculation. For example, if you choose to enter a configuration that includes a 
specific press extra, for example UV Coating, you should then select the 
associated Press Extra. In this example, the configuration Description should 
include that the Press Extra is included. 

Configuration Capable of 
Supporting 

Select the press extra to confirm if this configuration is capable of supporting it. 
For example, if the press extra is not automatically included with the configuration 
(see Extras above), but is to be included in the calculation of the estimate, and is 
manually added to the component by the estimator, the configuration will be 
calculated and presented for route selection if the appropriate check box is 
selected.  

 

Press Speed 
As part of the Press Configuration attributes, a specific speed number needs to be entered that will be included 
in the calculation each time the configuration is selected. 

 

To enter a speed for a configuration, you need to ensure that the Speed Number has been entered in the Press 
Speed window. 
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By entering a number, the matching speed table for the press will be assigned. To open the Config Press 
Speeds window, click Press Speed within the Press Configuration window. The values can be changed within 
this window for this press speed number. 

 

Run Waste 
A specific running waste profile can be added to a configuration, however this only needs to be entered if the 
configuration requires a different waste calculation to the value entered on the Press tab against the resource. If 
you do not need a different running waste calculation, enter 0 in the Run Waste No. field. 

 

To open the Config Press Running Waste window, click Run Waste within the Press Configuration window. 
The values can be changed within this window for this running waste profile id. 
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Add Trim 
By entering a value in the Add Trim No. field, you are, in effect, changing the trim calculation when the 
configuration is included in the calculation and route selection, from the value which would be calculated using 
the Trims entered on the Site tab.  

Any trim allowances entered within the Additional Trim profile will be added to the standard trim allowances for 
the finishing style being used within the estimate. 

 

To open the Additional Trims window, click Add Trim within the Press Configuration window. The values can be 
changed within this window for this trim profile id. 

 

Styles (Finishing Styles) 
Before a Press Configuration can be used for calculation and route selection, the finishing styles need to be 
entered for it.  

Generally, most press configurations will support multiple finishing styles. By opening the Finishing Styles 
window for a press configuration, the required finishing styles can be selected. Multiple selections can be made 
and will be displayed in the Finishing Style field. 

 

If multiple styles are selected, the Finishing Style will display multiple. 
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To open the Finishing Styles window, click Styles within the Press Configuration window. The styles can be 
selected within this window. 

 

Styles (Work Styles) 
You can only enter a Work Style for configurations for presses that are entered as Sheetfed. Some press 
configurations may be capable of supporting multiple work styles such as Sheet Work, Perfecting, Work & 
Tumble, Work & Turn.  

 

To open the Work Styles window, click Styles within the Press Configuration window. The styles can then be 
selected within this window. 
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Layouts 
You can enter a default Layout to a configuration. Further information on how to enter Fold Catalogs and their 
associated Imposition Layouts is available later in this guide.  

  

To open the Imposition Layouts window, click Layouts within the Press Configuration window. The default layout 
can then be selected within this window. 

 



 Estimating Maintenance | System Admin for Sales Enquiries, Estimating and Quick Pricer 5.4 User Guide l 55  

 
 

 

Example Configurations 

1. 16pp 1up, Saddle Stitched, 297 x 210mm portrait 

5  1 2  9  8  

4  1 3  1 6  1  

 

  

16 pages portrait 

Saddle stitched 

Trim size range 215 x 300mm to 120 x 
237mm 

Paper Weights from 44-130gsm 

Up to 4 colors 

1up, width across web (heads up/down) 

From 1 impressions, 1 stream 

4 pages across web, 2 pages in 
cut-off 
Nothing on webs 2-8 

Attracts JDF Stripping 
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2. 8pp 2up, Saddle Stitched, 297 x 210mm portrait 
 

4  5  

 

4  5  

1  8  1  8  

 

 
 

 

 

 

 

8 pages portrait 

Saddle stitched 

Trim size range 215 x 299mm to 120 
x 237mm 

2up, width across web (heads 
up/down) 

From 2000 impressions, 1 
stream 

4 pages across web, 2 
pages in cut-off 

Nothing on webs 
2-8 

Attracts JDF 
Stripping 

Up to 4 colors 
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3. 4pp, 4up, Saddle Stitched, 297 x 210mm portrait 

4  
 

4  
 

4  
 

4  

1  1  1  1  

 

 
 
 
 
 
 
 

4 pages portrait 

Saddle stitched 

Trim size range 215 x 299mm to 120 
x 237mm 

4up, width across web (heads 
up/down) 

From 0 impressions, 1 
stream 

4 pages across web, 2 
pages in cut-off 

Nothing on webs 
2-8 

Attracts JDF 
Stripping 

Up to 6 colors 
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4. 8pp 2up, Saddle Stitched, 210  x 297mm landscape 

4  5  

1  8  

 

8 pages portrait 

Saddle stitched 

Trim size range 110 x 239mm to 270 
x 306mm 

2up, depth across web (heads 
up/down) 

From 0 impressions, 2 
stream 

4 pages across web, 2 
pages in cut-off 

Nothing on webs 
2-8 

Attracts JDF 
Stripping 

Up to 4 colors 
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Gravure Press Configuration 
Press 
It is possible to enter and configure Gravure press resources. This selection of the press type when creating the 
press determines the options and windows available for the selected press type. 

 

In the above example, a Gravure press resource has been added and now the Gravure button is available. 

For a Gravure press resource, you only need to enter data in the Gravure, Extras and Rates windows. All other 
data entry can be ignored, as they are specific to Web Offset, Sheetfed and Digital type presses. 

The data entered in the press tab are the same as you would enter for any other press type, with the exception of 
the following: 

Field Name Description 

Cut-Off This needs to be entered as 0 (zero) due to the variable cylinder sizes used in the gravure 
process. 

Reel Width 
Over 

This can be used to enter a reel width dimension should you want to incur additional make 
ready time when a reel width exceeds the dimension. 

extra MR Enter the additional make ready value to be included in the calculation with the reel width 
exceeds the Reel Width Over value. 
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Gravure Parameters 
To access the Gravure Parameters window, click Gravure on the Press tab.  

 

Within Gravure Parameters, further press information can be entered that will assist the Estimating application in 
calculating routes and offering them for selection to the user.  

Field Name Description 

Maximum Engraving Enter the maximum number of engravings (pages) around the cylinder that can be 
printed on the press. 

Number of Ribbons Enter the maximum number of ribbons. 

Min Quantity Enter the minimum run length of the press. 

In-Line Finishing 
Capability 

Select the check box  if the press is capable of performing in-line finishing, such as 
in-line saddle-stitching. 

Maximum Sets Finished 
In-Line 

Enter the maximum number of sets that can be included when producing an inline 
finished product.  

Maximum Sets to Quote If a press is capable of producing 1, 2 3 or 4 set jobs, you can enter a restriction to 
prevent routes calculated in Estimating to a maximum value, for example, 3 set. 

Vertical Split Capability Enter the number of vertical splits the press is capable of producing. 

Long Grain Capability Select the check box if the press is capable of producing long grain sections. 

Min Ribbon Width Enter the absolute minimum ribbon width that the press can print on. 

Max Ribbon Width Enter the absolute maximum ribbon width that the press can print on. 

Default Delivery No longer used. 

Max In-Line Trim Enter the maximum head and foot trim that the press can take off the section when 
running an inline finished section. 

Max Off-Line Trim Enter the maximum head and foot trim that is possible to remove by an offline 
finishing resource. 

Include Running Waste in 
Ink Calculation 

Select this check box if the press running waste amount should be taken in to 
consideration when calculating the ink values for cost and usage. 

Min GSM Enter the absolute minimum paper weight in GSM that the press is capable of 
printing on. 

Max GSM Enter the absolute maximum paper weight in GSM that the press is capable of 
printing on. 
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Field Name Description 

Head Trim Enter the standard Head trim allowance in millimeters for inline and offline 
sections. 

Foot Trim Enter the standard Foot trim allowance in millimeters for inline and offline sections. 

Inline Foredge Trim Enter the standard foredge trim allowance in millimeters when printing an inline 
finished product. 

Offline Foredge Trim Enter the standard foredge trim allowance in millimeters when printing an offline 
finished product. 

 

Gravure Folder Configuration 
Gravure Folder Configuration allows you to define the folders that are present on the press. 

If the gravure press has two folders; each can be entered along with a descriptive reference. 

Click Folder Config. from within the Gravure Parameters window to open the Gravure Folder Configuration 
window. 

 

The Press ID and Config No values are automatically populated by the application and cannot be changed. 
However, you can enter your own Description and this can be used to set the reference name of the folder, for 
example, 1040 to indicate that the folder size is 1040mm. 

Gravure Config 
This is essentially the entry of data for the gravure press that defines the product capabilities of the press. Entries 
within this window will determine the routes presented to users when using the Estimating and Order 
Management applications. 

The data is entered on the basis of pagination, weight range, ribbons, engravings and delivery. 
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In this window, multiple entries can be entered, for example, for a 64pp section. Each entry may be based on 
different combinations of ribbons and engravings along with GSM ranges and how they are physically delivered. 

 

 

Field Name Description 

Press ID System generated value. 

Config No. System generated value. 

Pagination Enter the pagination of the details being configured in the line entry. 

Ribbons Enter the number of ribbons required across the web to produce the product. 

Engravings Enter the number of engravings required around the cylinder circumference to produce the 
product. 

Chops Enter the number of horizontal chops the product would require in order to be produced. 

Splits Enter the number of vertical splits the product would require in order to be produced. 

Min GSM Enter the minimum paper GSM weight for this product configuration that the press is capable 
of printing. 

Max GSM Enter the maximum paper GSM weight for this product configuration that the press is capable 
of printing. 

Speed Profile Enter the speed number which supports this product format. 

Default Speed If no speed profile has been entered, the calculation will include the Default Speed when the 
configuration is offered for route selection. 

Min Cut Off Enter the absolute minimum cut off (Double page spread including trims) that can be 
achieved when printing this product format. 

Max Cut Off Enter the absolute maximum cut off (Double page spread including trims) that can be 
achieved when printing this product format. 

Del Ribbons 
(F1) 

Enter how many ribbons will be running in to folder 1. 

Del Ribbons 
(F2) 

Enter how many ribbons will be running in to folder 2. 
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Field Name Description 

No Sections 
(F1) 

Enter how many sections will be produced from folder 1. 

No Sections 
(F2) 

Enter how many sections will be produced from folder 2. 

Del Streams 
(F1) 

Enter how many delivery streams will be used coming out of folder 1 

Del Streams 
(F2 

Enter how many deliver streams will be used coming out of folder 2 

Inline Enter Yes or No to determine if the product is finished inline.   

Notes This is the product description that users will see within Estimating, Order Management and 
Production Scheduling. It is important to choose a correct format that is informative to the end 
users. 

Live Enter Yes if the product is an active format. Enter No if the configuration is no longer valid 
and not to be used. 

Extras Selected Extras will always be applied to this configuration and included in the calculation.  

Configuration 
Capable of 
Supporting 

Select the press extra to confirm if this configuration is capable of supporting it.  

 

Note Within the Gravure Configuration window you can expand the width of the fields so that you easily view 
the data entered. 

Page Filter 

Click Page Filter if you wish to reduce the configurations displayed in the Gravure Configuration by pagination. 

 

Speed 

Click Speed to open the Gravure Speed window. Enter speeds based on quantity, paper weight, number of 
colors and trim size. If no speed number is assigned to the gravure configuration then the default speed within 
the Gravure Configuration window is included in the calculation. 

 

To assign a gravure speed to a configuration enter the speed number enter the Speed Number in the Speed 
Profile field in the Gravure Configuration window. 
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Reducing the maximum product speeds 

The absolute maximum product speeds entered in Gravure Speed can be achieved by entering information in 
the Ribbon Correct, Cut Off Correct, Paper Correct and GSM Correct windows. These are global values and are 
not specific to individual product types. 

 

Ribbon Correct 
The Ribbon correct option allows you to define ribbon width dimensions that may affect the maximum product 
speed. This can be achieved by utilizing the following grid and can be varied based on the folder in to which the 
ribbons will be travelling 

 

Cut Off Correct 
The Cut Off Correct option allows you to define cut off (double page spread) dimensions that can influence the 
maximum possible speed for the products. Again this can be varied based on the folder in to which the product is 
printing. 

 

Paper Correct 
The Paper Correct option allows you to define paper types that can influence the maximum possible speed for 
the products. The Paper Type field should contain the three character value of the Paper Type which is entered 
in Estimating Maintenance > Miscellaneous > Material. 

 

GSM Correct 
The GSM Correct option allows you to define paper weights that may influence the maximum possible speed for 
products. Again, this can be varied based on the folder in to which the product is printing. 
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Paper Weight Limitations 
Further to the Gravure Speed window, it is possible to hold specific paper limitations at the press level for 
different pagination options and also whether the product is produced in-line. To open the Gravure Paper Weight 
Limitation window, click Paper Weight Limit from the Gravure Parameters window. 

 

This allows you to define at a more global press level, the maximum and minimum GSM possible for different 
pagination options. This is irrespective of the number of engravings, ribbons and folders that may be used. 

Delivery 
Again, at press level, it is possible to define the maximum GSM weight that can be delivered off the press based 
on pagination. However, we would recommend that this is entered within the Speed window as this can then be 
product format specific. 

 

Cylinder Limitations 
A Gravure press is limited by the cylinder sizes available and also by the cylinder sizes that can be used based 
on the number of engravings that would be required for a product. 

The Gravure Cylinder Limitation window allows you to enter the minimum and maximum cylinder sizes that can 
be used for the different number of engraving options possible. 

In the example below, if a component was being calculated in Estimating utilizing 6 engravings and the 
calculated cylinder size was above the 1300mm value, the calculated route would be discarded by the Estimating 
and not presented to the user as a pricing option. 
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Cylinder Details 
The final part of gravure configuration is to enter the available cylinder sizes that can be used on the press, the 
actual physical cost of the cylinders and the number of those cylinders which carry in stock. 

It is these values that determine the cylinder sizes that are used with the Estimating calculations and will 
influence the amount of paper calculated. 

 

Using the example above, if during the route calculation in Estimating it is determined that 900mm cylinders 
should be used but due to version changes throughout the run, 13 cylinders would be required. The route 
selection will still be calculated but the user will be presented with a warning to advise them that the number of 
cylinders required exceeds the number in stock (12 in this case). 

The user then has the ability to decide if they should select the route or choose an alternative that has more 
cylinders available. 

Cylinder Making Time 

Within the Cylinder Details area, it is possible to define the amount of time required for stripping, coppering and 
engraving the cylinders. The value would be the total time required for all processes involved from stripping the 
previous engraving right through to having new engraved cylinders available to mount on the press. 

The time is based on the width of the cylinder to be used. The entries can be as simple of complex as required. 
For example, using the data below, if cylinders of 1550mm are required, the time allowance would be 2.5hrs per 
cylinder. 

 

Wide Format 
The application supports Wide Format printing process and, when resources are entered within the Press type 
as Wide Format, there are variations in the data that you need to enter, not only for the resource but also the 
material requirements. For ease of reference, this chapter consolidates the data entry that you will need to add 
when you wish to include Wide Format presses in your calculations. 
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Miscellaneous Tab 
1. Click Caliper Modes to open the Caliper Modes window. 

 

2. Enter Modes based on the caliper of paper, plus the Press Type. These will be available when adding 
the speeds for the Wide Format presses on the Press tab. 
 

3. Click Cartridges to open the Cartridges window in order to enter the Cartridges available for Wide 
Format press types. 

 

4. Click Materials > Ink to enter costs associated for the Cartridges at Item level. 
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Press Tab 
Creating a Wide Format Press Type 

1. Enter Wide Format as the Press Type on the Press tab. 

 

2. The values entered for the press is now restricted to Press Extras, Press Speed, Running Waste and 
Rates. You do not enter press configurations, as the application will calculate how the image is 
positioned on the sheet or roll, and the number up.  
 

3. Two additional fields are also available so that you can select if the press is capable of supporting 
sheets or rolls. You need to ensure that at least one of these options is entered. 
 

4. Click Press Extras to enter any penalties associated with the performance of the press, as per any of 
the other print type resources. 
 

5. Click Running Waste to enter the waste profiles, however the profile number will be ignored. This will 
be used to calculate how much running waste to allow for every wide format job. You can enter both a 
waste % and quantity to allow the support of wastage factors for very low quantity runs. 
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6. Click Press Speed to open the Press Speed Area window. 

 

7. Enter the speed based on Mode and within square meter ranges to indicate how many square meters 
per hour the resource can print. The mode of operation will be entered based on the caliper of the paper 
included for the print section. The Mode options available for selection are entered on Miscellaneous > 
Caliper Modes. 
 

8. Enter the Cartridge that the press is capable of supporting. 
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Finishing Tab 
You can enter details of binding machines, folders, guillotines, laminators, polywrappers, etc., in the Finishing 
tab. Depending on the resource type chosen, the various tables available within this tab will become available. In 
the example below (a stitching line), all tables except those within Folder and Guillotine are available to 
configure. 

 
 

Field Name Description 

Resource ID System generated resource ID. 

Description Enter the Resource name to be visible in Estimating and Order Management. 

Live resource Select if the resource is to be available in Estimating and Order Management. 

Finishing style Enter the primary type of resource. The options available are entered as Primary Finishing 
styles in the Finishing Styles window in Estimating Maintenance > Miscellaneous > 
Finishing Styles.  

Site Enter the location of the resource. 

Inclusive 
operators 

Enter the base number of operators required to operate this resource. 

Time Per Cell 
change (min) 

Enter the amount of time required for a data cell change. Typically incurred during 
personalization or enclosing processes. 

Price per Cell 
Change 

Enter the price of a Data Cell change, i.e. a market rate value. 

Min Run Hours  Enter the minimum run time for the resource. 

Product 
dimensions 

Enter the minimum and maximum product dimensions that the resource is capable of 
producing. 

Paper weights Enter the paper weight range that the resource is capable of producing. 

No. of hoppers Enter the number of hoppers the resource has available.  This must be a least 1. 
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Field Name Description 

Cover feeder Select the check box if the resource has a cover feeder. If selected then it reduces the 
number of hoppers required, for example, 3 x 32pp + 4pp cover with cover feeder selected 
will calculate a speed based on a resource with 3 hoppers. 

… Click … to open the Bindery Cover Feeder window. Enter the product trim size and 
grammage range supported by the cover feeder to include the cover feeder in the bindery 
calculation. If none are entered, then the cover feeder will always be considered when the 
resource is included in the calculation. 

Max spine 
depth 

Enter the maximum spine width for perfect bound products. 

Min Quantity Enter the minimum quantity run for the resource. 

Utilization Enter the utilization figure for use in planning. For further details of how utilization is 
calculated see the Press tab chapter. 

Bindery Extras 
Bindery Extras allows you to apply penalties to binding operations in the same way as Press Extras. You can 
enter additional make ready time, overs, speed variations and cost and price variations. 

Both the Estimating and Order Management applications allow the user to pick the required extras against the 
finishing operation. To include bindery extras you need to enter the full list of extras on the Miscellaneous tab. 

 
Click Bindery Extras to open the Bindery Extra Descriptions window.  
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Enter the required extras and any material codes assigned to them. This will allow the cost of the extra to be 
included in the estimated costs. At this point the bindery extras are not linked to a piece of bindery equipment.  

 
Field Name Description 

Description Enter a meaningful description of the extra. This is a mandatory field and must not be blank. 

RFE Select this check box if you want the extra to be available for selection within the RFE form 
and Quick Pricer. By default, the check box is selected. 

Live Select this check box if you wish for the extra to be available for selection against a finishing 
resource and subsequent estimate.  Default entry is that the Live check box is selected. 

Visible This determines whether the bindery extra is available to the estimator upon enquiry entry.  

Overs % Enter any additional binders overs percentage that are to be added to the calculation process 
if this extra is included.  It can be used independently with the extra or in conjunction with 
Overs Qty. 

Overs Qty Enter any additional binders overs quantity to be added to the calculation process if this extra 
is included.  Can be used independently with the extra or in conjunction with Overs %. 

Materials Click Materials to open the Bindery Extra Descriptions window to allow you to associate extra 
materials that need to be included in the calculation, if the extra is used. 

Add Adds a new entry to the grid. 

Edit Enables the current entry to be edited. 

Delete Removes the highlighted entry. 

OK Saves any changes and closes the window. 
 

Bindery Extras Materials  
For any bindery extra you can enter a material that is associated with it. Select the bindery extra and click 
Materials. The Bindery Extra Descriptions window will open. 
Click Add to enter the material. This will automatically be included in the calculation if the bindery extra is 
included in the estimate or order. For further details see the Materials chapter later in this guide. 

Linking Bindery Extras to Resources  
In the same way press extras are linked to a resource, bindery extras and their associated affect are linked in the 
same way.  

The extras are enabled for all binding resource types including cutting, folding and small machines. 



 Estimating Maintenance | System Admin for Sales Enquiries, Estimating and Quick Pricer 5.4 User Guide l 73  

 
 

 

Adding supported Bindery Extras to a Resource  
On the Finishing tab, select the resource and click Bindery Extra to open the Bindery Extras window for the 
resource. Here you can enter the list of supported extras for the resource and the affect the extra has on the 
running and cost or price of the operation.  

 

Field Name Description 

Bindery Extras List of extras added for the resource. 

Add Opens the Add Binder Extra window so you can enter a new extra. 

Remove Deletes the highlighted extra. 

Extra Hoppers Indicates the extra will use an additional hopper of the resource. Will only be accounted for 
on machines where the number of hoppers for the resource is greater than 1. The entry must 
be greater than or equal to 0 and it must be less than or equal to the number of hoppers for 
the resource. The default is 0. 

Extra MR 
Hours 

Enter the extra number of make ready hours. The default 0. This can be a negative value to 
indicate a shortening of make ready time. If the overall calculated make ready time calculated 
is negative then the make ready time will be calculated as 0. 

Extra MR 
Assistants 

Enter the extra assistants required during the make ready period of the operation. Must be 
greater than or equal to 0. The default is 0. 

Extra Running 
Assistants 

Enter the extra assistants required for the running of the operation. Must be greater than or 
equal to 0. The default is 0. 

Speed 
Reduction % 

Enter the percentage the speed of the resource is slowed down. 
This will be included along with any other speed penalties. Is not accounted for 
accumulatively if the value is greater than 0. If multiple positive speed reductions are 
encountered then only the highest reduction is applied. 
The default 0 and it must be less than 100. 
It can be negative to indicate a performance improvement, for example, -25% indicated the 
overall calculated speed will be increased by 25%. 
Negative speed reductions are applied at the end of the speed calculation. Again if multiple 
negative speed reductions are encountered then only the lowest is applied. 
The speed reduction is considered in conjunction with other extras, pagination, paper weight 
and additional operations. 
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Field Name Description 

Max Run 
Speed 

Maximum speed of the resource if incurred. Must be greater than or equal to 0. The default is 
0. 
This value is checked by the application at the end of the speed calculation. If the calculated 
speed is greater than the Max Run Speed then the speed is calculated at the Max Run 
Speed. 

Extra Cost 
Rate 

Enter the Extra cost per hour added to the base cost rate. The default is 0. 
This can be negative value to indicate a reduction in cost per hour. If the overall cost 
calculated is negative then the cost is set to 0. 

Extra Assistant 
Rate 

Enter the assistant rate to be included in the calculation for extra assistants. Must be greater 
than or equal to 0. The default is 0. This will override the standard assistant rate. 
If a rate is specified then extra assistants incurred with the extra are charged at the specified 
rate. 
If the rate is zero and extra assistants are incurred then the standard site level rate is used. 

Extra Sell Rate Enter the extra sell per hour to be added to the base sell rate. The default is 0. 
This can be a negative value to indicate a reduction in sell per hour. If the overall sell 
calculates as a negative then the sell rate will be 0.  

Extra Mark Up 
% 

Enter the extra mark -up % that will be added to the base sell rate. Must be greater than or 
equal to 0. The default is 100. 

OK Click OK to save the latest changes and close the Bindery Extras window. 

Cancel Ignores the latest changes and closes the Bindery Extras window. 

Apply This becomes available if anything in the window is changed.  Click to save the latest 
changes and leave the Bindery Extras window m open. 

Modes and speeds – binding operations only 
Within the Bindery Operation Modes window, you can enter product types. For instance, in the example below, a 
wire stitched A4 portrait product. Against this there are the minimum and maximum product dimensions relating 
to this product type and also the minimum and maximum weight (in GSM).  
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When entering the mode for the resource the finishing style does not have to match the resource style.  This 
enables you to set up the resource that supports different types of operations.  For example, a stitching machine 
can also collate. 

 
 

Every mode entered must have a set of speeds.  Click Speed to open the Bindery Speed window.  Enter the 
cycle speed and make ready time (along with follow on make ready hours (FO MR Hours), for the resource 
based on the number of hoppers in use. You can also enter the number of total assistants (including the base 
number) to be included in the calculation. 

Note At least one speed must be specified for the mode to calculate.  
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Speed reductions – bind only 
Click Speed Reductions to open the Bindery Speed Reduction window to be able to enter any speed penalties 
for heavy papers.  For example, if producing a cover on a stock greater than 130gsm the speed of the machine 
will be reduced by 10%. 

 

Additional Operations 
Click Additional Operations to open the Bindery Additional Operations window to be able to enter additional 
values for the different types of operations, for example, inserts. Additional Operations are entered in Estimating 
Maintenance > Miscellaneous > Additional Ops.  

 

If Additional Kit is entered as Yes then a hopper is not allocated as the application is assuming that other 
equipment (not a hopper) is used for the operation. For example, an imaging head. Any Extra Assistants required 
will be added to the total number of assistants (see below). 

If Additional Kit is entered as No then a hopper is allocated. Any Extra Assistants required will be included in the 
total number of assistants. For example: 

Resource Config 
 

Job Details Additional Operation 
Config 

Result 

Hoppers Total 
Operators 

Job 
Sections 

Additional 
Operation 

Extra 
assistants 

Additional 
Kit 

Total 
Hoppers 
Required 

Total 
Operators 
Required 

4 to 7 3 6 Loose 
Insert 

1 No 7 4 

6 Shrinkwrap 1 Yes 6 4 

8 to 11 4 6 Ink Jet 0 Yes 6 3 

7 Loose 
Insert 

1 No 8 *5 

7 Shrinkwrap 1 Yes 7 4 

7 Ink Jet 0 Yes 7 3 

8 Loose 
Insert 

1 No 9 5 

8 Shrinkwrap 1 Yes 8 5 

8 Ink Jet 0 Yes 8 4 
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Note Line 4: The resource requires 4 operators when 8 hoppers are used. The job contains 7 sections (7 
hoppers and 3 operators). When the loose insert is added the number of hoppers increases to 8, thus 
increasing the total operators to 4. A further extra assistant is added for the loose insert. In this case, 
the loose insert consumes a hopper, so it would be best to set Extra Assistant to 0. 

When the estimate is calculated, the highest speed reduction will be used.  For example, shrink wrapping incurs 
a 20% speed reduction and ink jetting incurs a 25% speed reduction, a job that is ink jetted and shrink wrapped 
will incur a 25% speed reduction. 

Price per 1000 is the sell price. This enables you to enter the additional operation calculating based on an hourly 
cost rate, but pricing per 1000 selling price, or a combination of the two. For example, an inkjet printer may have 
an hourly cost rate if £100 per hour, but is sold on the basis of £30 per 1000 copies. To enter this scenario, set 
the low sell and budget sell to £0 and define an additional operation called ink jetting, which attracts a cost rate of 
£30 per 1000. 

Assistant Numbers 
The Bindery Assistant Numbers window allows you to enter the total number of assistants required for binding 
lines based on the number of hoppers. The application will then calculate the number of additional assistants 
required. 

 

The number entered in the Total Assistant No. field, should include the inclusive operators for the resource. The 
application includes the base number of operators within the cost rate (at the resource level) when calculating 
the total number of extra operators required. 

So, for a magazine with a cover, two sections, two loose inserts and one bound insert the application would 
calculate six hoppers (unless a cover feeder is being used in which case it would calculate five hoppers). 

Assuming no cover feeder, it would look up the total number of assistants from the Bindery Assistant Numbers 
window. For example, this calculates four assistants based on six hoppers. If the bound insert operation also 
requires one extra assistant then this makes the total assistants equal to five. Subtracting the inclusive operators 
for the resource, for example, two, leaves three additional assistants to be charged. 

Advanced Bindery Assistants 
There are two methods for calculating the number of bindery assistants required.  

The first option is using the data entered as above, where the application will calculate the number of assistants 
required as entered in the bindery speed table and any associated additional operations.  

The second option enables a more detailed calculation method of bindery assistant numbers that will allow for 
log and pile sizes, insert requirements and speed. 
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This calculation method is available in Estimating, Order Management and Production Scheduling. The 
calculation of the necessary crew per order is of major influence on the cost calculation for finishing. A more 
detailed calculation of the required crew can therefore help in achieve a more accurate forecast of the number of 
required people (temporary workers) and thus cost control. 

To configure advanced bindery assistants the following configuration needs to be entered. 

• Information Console > Application Settings 

• Estimating Maintenance > Finishing  

Note Application Settings can also be entered in MIS Console > Maintenance > My Information > 
Application Settings. 

Application Settings 
There are seven application settings that need to be reviewed and values entered as appropriate so that the 
advanced bindery assistant calculation can take place. 

These are entered against the Estimating application but are also used for both Order Management and 
Production Scheduling. 

Setting id Description 

123 Switches on the advanced bindery assistant calculation method (1=on, anything else=off). 

124 Maximum number of hoppers with logs/piles 1 assistant can handle. 

125 Maximum number of bind-ins 1 assistant can handle. 

126 Signature rounding factor used when calculating the average number of log/piles in the job. 

127 Bind-ins rounding factor used when calculating the average number of bind-ins in the job. 

128 Number of logs/piles that can be processed in 1 hour by 1 assistant. 

129 Site logs/piles length in mm or inches. 
 

Estimating Maintenance 
Select the Finishing tab and for any resource that you wish to calculate the bindery assistant using this method, 
ensure that the Advanced Assistants check box is selected. 

 

Quantity Breaks 
The speed entered in Modes & Speeds is the maximum speed that the resource can operate at for a specific 
product. Generally, this speed is achieved over a reasonable run length. However, for short run lengths, the 
maximum speed may need to be reduced. The Bindery Speed Breaks window allows you to enter quantity 
breaks along with the percentage of the maximum product speed that would apply. 

 

Note Setting the Speed(%) value to 0 or 100 will calculate the speed from the Modes and Speed table. 
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Using the example above, if the optimum resource speed for the product is 10,000 cycles per hour and the 
resource quantity is 5,000, the speed used in the finishing calculations will be based on 9,000 cycles per hour 
(90% of the optimum speed of 10,000 per hour) 

Resource Rates 
The Bindery Rates window allows you to enter the cost and selling rate for the resource that will be included in 
the route calculation.  

Rates can be set up in 2 different ways: 

• Hourly cost rate plus mark up 
 

• Hourly sell rate 

If you wish to calculate the sell price of the estimate based on a sell rate, you need to ensure that the AV Hour / 
Apply field is entered as Yes and an hourly rate is entered in the Budget Sell and Budget Low Sell Price 
fields. These values can be the same or different to the Cost Rate. The application will calculate the sell value 
based on the calculated Make Ready and Running time for the bindery operation multiplied by the Sell Price 
value entered. 

If you wish to calculate based on the Cost Rate plus mark up, you need to enter No in the AV Hour / Apply field 
and then enter a value in the Margin / Budget Sell % and Margin / Budget Low Sell % fields.  The application 
will calculate the sell value based on the calculated Make Ready and Running time for the bindery operation 
multiplied by the Cost Rate + Margin / Budget Sell % value entered. 

You can enter either value based on date ranges to accommodate any seasonal time frames variations to the 
sell price. 

 

Piece Rate 
For certain resources the above cost and pricing method may not be suitable. An alternative Piece Rate option is 
available. To enter a resource rate using Piece Rate calculations, enter Yes within the Piece Rate field and the 
Piece Rate button will become available. Click Piece Rate to open the Bindery Piece Rate window. 

Note The piece rate function only controls how the price of the operation is calculated, and the cost 
calculation remains unchanged. 

 

The sheet depth and width ranges allows you to enter pricing for different sheet sizes. 

Per Sheet allows you to enter the rate whether it is applied on a per impressions, or quantity basis. 

Rate Elements 
You can enter the cost rate breakdown Elements for each resource for analysis purposes. 

There are four elements that can be defined: LABOUR, FIXOH (Fixed Overheads), VAROH (Variable 
Overheads) and DEPREC (Depreciation).   
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The element percentage defines how the cost rate is apportioned.   

You will not be able to enter an element that is greater than 100, and during setup you need to ensure the total 
percentage for all elements add up to 100. 

Note This information is not used in the estimating calculation, but is supported to enable the user to analyze 
the information at the lower level if required and is output to the Estimate XML file for reporting 
purposes. 

Guillotine 
Resource parameter information for Guillotine resources is entered differently.  After entering a guillotine 
resource on the Finishing tab, the majority of options available (and included above) become unavailable.  

How the guillotine data is entered can also vary dependent on whether application setting id 35 for Estimating 
(the Advanced Guillotine Setup), is entered as 1 (True).   

Advanced Guillotine  
When application setting id 35 for Estimating is entered as 1 (True), when a guillotine resource is added the 
Guillotine area of the Finishing tab becomes available. 

Note You need to ensure that application setting id 33 is entered as 1 (True) if you wish to use Advanced 
Guillotine. 

 

Enter the maximum single lift (pile) height in millimeters in the Max lift height field.  

Enter the maximum number of lifts/piles that can be put through the resource in the Lifts per hour field. 

Cutting Defaults 
Click Cutting Defaults to open the Guillotine Defaults window. 
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In this window you can enter for each printable section, number up on the sheet (or per cut off), and paper weight 
range, how many cuts are required to trim the sheet. 

 

Speed 
Click Speed to open the Guillotine Advanced Speed window so that you can enter the number of cuts per hour 
based on the caliper of the paper. 

 

Lift Heights 
Based on the area of the paper, the default lift (pile) height can be entered. The number of extra assistants 
required to operate the resource can also be entered (this is in addition to the inclusive operators). 
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Make Ready 
Based on the minimum and maximum number of cuts, the make ready hours, make ready follow on hours, and 
make ready sheets can be entered. 

 

Speed Reduction 
The Speed Reduction window is available for an advanced guillotine set up and allows you to enter speed 
reduction factors based on caliper.  

 

Standard Guillotine 
If application setting id 35 is entered to 0 (False), you can still enter guillotine data but in a more simplified form. 
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Configuration 
Click Confirmation to open the configuration window where you can enter the number of cuts based on an output 
figure per hour, using a weight per hour value. Make-ready and additional operators can also be entered. 

 

Cutting Defaults 
Cutting defaults for this mode are the same as the advanced option. However, if you have chosen not to 
calculate based on caliper (application setting id 33 for Estimating), then the window allows you to enter based 
on grammage rather than caliper. 

 

Folders 
There are two methods to configure the folding machines: 

• Standard 

• Advanced 



84 l EFI Technique 5.4 | System Admin for Sales Enquiries, Estimating and Quick Pricer 5.4 User Guide 

 
 

 

Standard 
When you enter a folding resource a different set of tools are made available to you so that you can enter the 
folding configuration data. 

 

Folder Configuration 
Click Folder Configuration to open the Folder window.  

 

The fold styles are entered in Estimating Maintenance > Miscellaneous > Fold Types. 
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Select the fold type and click Fold Speeds to open the Folder Speeds window. 

 

Field Name Description 

Description Enter text providing a brief description of the folder configuration. 

Min Depth Enter the minimum depth (millimeters) of the product trim size that the folder configuration 
can support. 

Max Depth Enter the maximum depth (millimeters) of the product trim size that the folder configuration 
can support. 

Min Width Enter the minimum width (millimeters) of the product trim size that the folder configuration 
can support. 

Max Width Enter the maximum depth (millimeters) of the product trim size that the folder configuration 
can support. 

Min Weight Enter the minimum paper weight (grammage) that the folder configuration can support. 

Max Weight Enter the maximum paper weight (grammage) that the folder configuration can support. 

Fold No Up Enter the number of copies which can be folded at one time, for example, 2up can fold two 
copies of the product in one cycle. 

No. Folds Enter the number of folds required for this configuration. 

MR Hours Enter the number of make ready hours for the configuration. 

FO MR Hours Enter the number of follow on make ready hours for the configuration. 

Cycle Speed Enter the speed of the resource in cycles to produce the configuration. 
 

Folder Defaults 
After the fold configurations have been entered, you can now set some folder defaults. By entering the folding 
defaults you are minimizing the amount of effort required from your estimating team when constructing and 
calculating an estimate. When the Estimating application identifies a folding operation that is included in the 
estimate, it will automatically enter the default folder values based on the information entered in the Folder 
Defaults window. 

Note Estimators can manually amend the values for each estimate if necessary. However, it will still need a 
valid configuration and speed to be able to successfully calculate a route. 
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Paginations can be specified by the fold number up, number of folds, product size and paper weight. Different 
types of folds such as roll fold, delta folds, can be entered. 

 

Advanced 
Advanced Folding provides you with the ability to calculate folding based on linear measurement, number of 
turns and folds and replaces the standard style fold calculation. To enable this option you need to ensure that 
application setting id 109 for Estimating is entered as 1 (True). This will provide you with the ability to enter 
advanced folding configurations and two additional options become available when a Folder resource is selected 
on the Finishing tab. 

 

Entering Advanced Folding values 

1. Click Advanced Folding to open the Advanced Folding window.  
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Field Name Description 

In-feed speed  Enter the millimeters or inches per minute that the section will feed into the folder. 

MR first plate Enter the make ready time (minutes) for the first plate. 

MR additional 
plates 

Enter the make ready time (minutes) for any additional plates. 

Speed 
reduction per 

plate 

Enter any speed reduction per plate (as a percentage) to be included in the calculation. 

MR first turn Enter the make ready time (minutes) for the first turn. 

MR additional 
turns 

Enter the make ready time (minutes) for any additional turns. 

Speed 
reduction per 

turn 

Enter any speed reduction per turn (as a percentage) to be included in the calculation. 

Standard gap Enter the standard gap (millimeters or inches). 
 

2. Click Speed to open the Folding Advanced Speed window. Within this window you can enter any speed 
reductions that need to be included in the calculation when the caliper of the paper entered for a 
component falls within the caliper range. 

 

Note To use Advanced Folding you need to ensure that calipers are entered within Estimating 
Maintenance > Miscellaneous > Materials > Paper > Type > Item. 

3. Select the Miscellaneous tab and click JDF Fold Catalog. Enter the number of folds (No Folds) and 
turns (No Turns) for each fold catalog. 

 

Small Machines 
Traditionally the finishing calculation within Estimating works on a copy per hour basis, which in turn is multiplied 
by an hourly machine rate.  However, there are various types of finishing machinery for which the method of 
calculating based on modes and speeds may not be suitable. Within Technique, these can be entered as Small 
Machines and allow finishing equipment to be configured and calculated using a batch method. The batch 
method allows the operation to be calculated for costing and pricing based on a piece rate or batches per hour 
based on lift height/weight utilizing caliper and weight.     

Typically the type of machinery covered by this method is: 

• Drills 
 

• Punches 
 

• Hand Work, etc. 
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The configuration areas affected are within Estimating Maintenance are: 

• Finishing Styles 
 

• Finishing Resource Modes and Speeds. 

To make the batch method available, firstly you need to ensure that application setting id 37 for Estimating is 
entered as 1 (True). If this setting is entered as 0 (False) the batch mode settings will not be available. 

Finishing Styles  

With Small Machines available, select the Miscellaneous tab in Estimating Maintenance, click Finishing Styles to 
open the Finishing Styles window. The Batch column appears in this window, allowing you to configure the style 
using batch mode. If the Batch check box is selected, the Parameters button becomes available. This allows the 
batch parameters and defaults for the batch to be entered. 
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Batch Parameters 

Click Parameters to open the Finishing Batch FinStyle window so that you can enter the parameters that 
support the small machine.  Each parameter can be turned on and off, sequenced, made mandatory and limits 
can also be entered.  

 

The parameters set here work in conjunction with, and primarily act as overrides, to the modes and speeds 
defined against the corresponding resource.  This method gives the estimator ultimate control over how the 
operation is calculated. 

The parameter list includes the following set of variables. You need to select which parameters are required for 
the finishing style calculation.  

Field Name Description 

Pieces Per Batch Number of copies or sheets to be processed in each batch. 

Batches Per Hour Number of batches per hour to run. 

Prep Time Per Lift Number of seconds to prepare each lift (batch). 

MR Hours Make ready hours to initially prepare the operation. 

No Of MR’s Incurred Number of make readies included. 

Cost Per Hour Resource cost rate per hour. 

Cost Per Hour MU% Cost rate mark up% to achieve the price per hour. 

Price Per Hour Resource price per hour. 

No Up Number Up. 

Extra Assistants Extra assistants in addition to the inclusive operators. 
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Field Name Description 

Extra Handwork Hours Number of extra offline handwork hours required. 

Speed Reduction % Speed reduction % to be applied. 

Lift Height (mm or 
Inches) 

Batch lift height in millimeters or inches. 

Lift Weight (kg’s or lb’s) Batch lift weight in kilos or pounds. 

Unit Cost Piece (unit) cost if calculating based on a piece rate (for further information see 
Resource Rates). 

Unit Cost MU% Unit cost mark up % to achieve the unit price. 

Unit Price Piece (unit) price if calculating based on a piece rate. 

Piece Rate (True/False) Use piece (unit) cost and price (True) or cost and price per hour (False). 

Length Per Hour Length in millimeters or inches per hour that the machine can operate at. 

Sheet Width/Cut Off The number of sheets per hour that the resource can operate at. 

No. Per Copy Used in conjunction with the Sheet Width/Cut Off variable to define the number up 
per sheet. 

 

You need to enter whether the above parameters are applicable for the finishing style, whether they are visible to 
the user (Estimating and Order Management), their minimum and maximum values, etc. 

Field Name Description 

Description The parameter description. This is field is unavailable for editing. 

Label Enter the label for the parameter that users will see when inputting the data. 

Visible Enter True if you want users to see the parameter in Estimating and Order Management, 
enter False if it is to be hidden. 

Default Value Enter a default value that will be added by default when the finishing style is entered within 
the estimate. 

Value Required Enter True if the field requires input from the user.  

True/False 
Only? 

Enter whether the parameter is to be entered by the user as a True or False field. 

Allow Decimals For a numeric input type this field indicates whether decimals can be entered for the 
parameter. Enter True if decimals are allowed and enter False if the value to be entered must 
be a whole numbers. 

Min Value Enter the minimum value the user is allowed enter. 

Max Value Enter the maximum value the user is allowed enter. 

Screen Position Enter the position of the parameter field within the application. A position cannot be 
duplicated. 

 

Note When entering the default costs, mark up percentage, and price details for either the Per Hour Rate or 
Piece Rate there is no relationship between the values.  It is up when entering the information to ensure 
the default values are correct. 

 However, when entering cost, mark up percentage and price detail within the estimate, the values do 
react where the cost figure acts as the base to calculate the price using the mark up figure.  In other 
words, price or mark up percentage is always recalculated depending on which value is changed. 

 Also, if the cost or price fields are empty then the application will revert back to the rates held against 
the finishing resource for calculation purposes.   
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Layout View 

As the parameters are configured and the screen position and visibility decided the layout view updates to show 
how the parameters will be displayed to the user.   

 

Once entered the parameters will be displayed within the Estimate Finishing window in the estimate to the user. 

Finishing Tab 

When a resource is entered in the Finishing tab that includes a finishing style that has been entered using the 
batch method, several of the options are unavailable on the Finishing tab, plus additional fields are available 
within the Speeds window. 

 

To enter the Speed for each mode, click Mode & Speeds > Speed to open the Bindery Speed window. 

  

Field Name Description 

Batch’s Per Hour Enter the number of batches per hour to run.  This replaces the Cycle Speed 
column. 
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Field Name Description 

Min Lift Height (mm or 
Inches) 

Enter the minimum batch lift height in millimeters or inches. 

Max Lift Height (mm or 
Inches) 

Enter the maximum batch lift height in millimeters or inches. 

Min Lift Weight (kg’s or 
lb’s) 

Enter the minimum batch lift weight in kilos or pounds. 

Max Lift Weight (kg’s or 
lb’s) 

Enter the maximum batch lift weight in kilos or pounds. 

Lift Prep Time (Sec) Enter the number of seconds to prepare each lift (batch). 
 

The speed entries only act as a constraint against the resource if the parameters entered for the operation are 
left empty.  If a lift height or weight parameter is entered by the user then these values will act as an override 
value and used in the calculation process irrespective of whether the entered height and or weight falls within the 
speed range. 

Outwork Tab 
If you have agreed costs with your suppliers for print, binding and other services, for example varnishing, you 
can enter the outworker costs and prices to be included as part of the calculation process in both Estimating and 
Order Management. Both outwork finishing and basic printing data, based on make ready and price per 1,000 
copies, can be entered in the Outwork tab.  
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Before a new outworker can be added to the Outworker tab, you must ensure the supplier name, address, 
contact details, are entered in Company Management in MIS Console. You also need to ensure that you have 
entered whether they can bind or print. This is entered in the company record. 

 

In the above example, Fast Finishing has been entered in Company Management and Can Bind has been 
entered against the record. Therefore in the Outworker tab in Estimating Maintenance, the options to enter 
Binding Prices or Other Finishing are available. If the Outworker was able to provide printing services, you would 
need to enter Can Print for the company record and then the Configs button would be available for selection 
within the Outworker tab. 

To add a new outworker, select the Outworker tab and click Add Item from the tool bar.   

Once the Outworker contact details have been selected, you can then begin to enter the required information.  

Select Default Pricer if you want the outworker to be used when calculating an estimate or order created from a 
contract that has its pricing method entered as Book Schedule. 

If you wish to plan an Outwork route in the planning application, you need to clear the Do Not Plan check box. 
This selection has no effect within the Estimating application. 

Outworker – print  
If you wish to enter print configurations for an outworker, click Configs. You will also need to enter data into the 
Printing Paper Allowance. 

 

Note Outwork print configurations can calculate paper based on caliper in the same way as for in house 
resources. You need to set the application setting to enable caliper entered as 1 (True). 

Enter the paper 
requirements for 
paper 
calculations. 
These numbers 
will be added to 
the calculated 

Click Configs to 
enter print 
capabilities 
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Print Configurations 
You can enter print configurations for an Outworker based on trim size, finishing style, number of colors, print 
process etc. The cost and pricing is based on make ready and price per 1,000 copies only. 

 

In essence, the Outworker Press Configuration and Pricing window is a simplified press configuration. There is 
no requirement to enter speed. 

Field Name Description 

Press ID System generated unique id number for the outworker. 

Size Enter the agreed coding for the size, for example, A4. The size entry is used to 
group the configurations in the hierarchy tree. 

Pagination Enter the pagination of the print section. 

Description Enter the name for the configuration. It is important that the description is 
informative, as this text will appear in the route selection window in Estimating and 
will aid the Estimator in route selection. It is also visible in Order Management and 
Production Scheduling. 

Finishing Style Enter the finishing style that the configuration supports. The options available are 
entered in the Miscellaneous tab in this application.  

Warn This is an optional field and allows you to enter a warning specific to the 
configuration. If entered, this text will appear in Estimating, Order Management and 
Production Scheduling if the configuration is available for selection or selected. 

Min Depth Enter the minimum product depth supported by the configuration. 

Max Depth Enter the maximum product depth supported by the configuration. 

Min Width Enter the minimum product width supported by the configuration. 

Max Width Enter the maximum product width supported by the configuration. 

Min Paper Weight Enter the minimum paper weight supported by the configuration. 

Max Paper Weight Enter the maximum paper weight supported by the configuration. 

Max No. Colours Enter the maximum number of colors supported by the configuration. For example, if 
the outworker can print 4/4, then you need to enter 8. 

Web or Sheetfed Select whether the print process is web or sheetfed. This is required for calculation 
of paper requirements. 
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Field Name Description 

Web/Sheet Width Enter the web or sheet width that would be required if the print section were 
produced by the outworker. 

Cut Off/Sheet Depth Enter the cut off (for web) or sheet depth (if a sheetfed product) that would be 
required if the print section were produced by the outworker. 

Number Up Enter the number of identical sections per impression that this configuration would 
produce. 

Delivery Streams Enter the number of delivery streams used when producing the product. This 
equates to the number of different bindery sections produced (typically 1 or 2). 

Minimum Run Length Enter the minimum run length for this configuration. In Estimating, if the quantity is 
below this value, a print route for the configuration will not be calculated and 
presented for route selection. 

Maximum Run Length Enter the maximum run length for this configuration. In Estimating, if the quantity is 
above this value, a print route for the configuration will not be calculated and 
presented for route selection. 

MR Cost Enter the make ready cost that the outworker would invoice you for producing this 
configuration. 

Cost Per ‘000 Enter the cost per 1,000 copies that the outworker would invoice you for producing 
this configuration. 

MR Mark Up Enter any make ready mark up percentage to be applied to the cost to calculate the 
make ready price. If you enter a value in this field the MR Price will automatically 
calculate. 

Per ‘000 Mark Up Enter any per 1,000 copies mark up percentage to be Price per 1,000 Price will 
automatically calculate. 

MR Price Enter the make ready price that you wish to charge your customer for printing this 
configuration. If you enter a value in this field the MR Mark Up field will automatically 
calculate. 

Price per ‘000 Enter the price per 1,000 copies that you wish to charge your customer for printing 
this configuration. If you enter a value in this field the Per 1,000 mark up value will 
automatically calculate. 

 

Outworker – bind 

Paper Weight 

When configuring an outworker for binding, you need to enter the minimum and maximum paper weights that the 
outworker is capable of binding based on the finishing style and whether the print section is a cover or text. Click 
Paper Weight to be able to add these values.  

 

Note If no minimum or maximum values are entered, no outwork routes will be included in the calculation 
process. 
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Binding Prices 

You need to enter the various costs and prices for the binding operations within the Binding Out Workers: Prices 
window. Values are entered based on finishing style, minimum and maximum depth, minimum and maximum 
width, quantity range and number of sections. 

 

Add Ops 

Click Add Ops if you wish to enter costs and prices when the Outworker supports additional operations, for 
example, the outworker can also include inserts as part of the binding operation. 

Firstly, you need to ensure that the additional operations are entered within the Miscellaneous Tab > Additional 
Ops. Next, click Add Ops to open the Binding Additional Operations window to enter the various options. 

 

Additional make-ready 

The Additional Make Ready window enables you to enter additional make ready time to be included in the 
calculation of the outwork binding routes.  

Note However, it is no longer necessary to enter values in this window as you are now able to enter make 
ready costs and prices within the Binding Prices window. 
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Pagination 

Any additional prices per 1,000, based on the section pagination, can be entered within the Additional Pagination 
Prices window. 

Should the outwork binding route include these sections, the additional prices will be included in the calculation. 

 

Other Finishing 

If the calculation for the outworker is not based on resources that operate using multiple hoppers and are 
calculated using a cost per 1,000 copies, you can enter this information within Other Finishing. Other Finishing 
allows you to enter the cost and price for values that calculate based on coverage rates, for example, laminating, 
UV Varnishing etc. 

Click Other Finishing to open the Binding Out Workers: Other Finishing window.  

 

Within this window you need to enter the paper weight restrictions, minimum running cost and price and make 
ready cost and price.  

Below is an example of how laminating (LA) prices could be entered using cost banding based around paper 
weights. 

 

Field Name Description 

Finishing Style Enter the finishing operation to be performed such as laminating, UV varnish, 
Embossing etc. 

GSM From Enter the minimum paper weight that can be run for this particular line entry. 

GSM To Enter the maximum paper weight that can be run for this particular line entry. 

Default MU % Enter the mark up percentage value to be applied to the cost values within the line 
entry. 

Min Cost Enter the absolute minimum cost for running the operation. 

Min Price Auto populated using the Min Cost value + Default MU %. 

MR Cost Enter the set up cost for the operation if required. 
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Field Name Description 

MR Price Auto populated using the MR Cost + Default MU %. 
 

Enter the default mark up % value so that the minimum and make ready price fields auto-update. 

Note If you enter the minimum price and make ready price the default mark up % value will not recalculate. 

When the costs and prices per grammage range have been entered, click Style Rates. 

 

The Other Finishing Rates window allows you to enter the pricing structure for the running element of the 
operation and is based on a cost and price per area (based on the measurement set up of you system; square 
meters for Metric systems, square feet for Imperial systems). 

The Style Rate allows you to enter the values required to accurately enter running rates for the outwork 
operation. 

The pricing structure is entered using area banding, sheet quantity along with cost, mark up and price values. 

The above example shows how the operation costs could be defined where the greater the area of the sheet, the 
cost per square meter/square feet increases. The first line entry would typically cover a sheet size of 320 x 
450mm (SRA3) up to 450 x 640mm (SRA2) . 

For Area From, the dimensions of the SRA3 sheet have been multiplied and expressed as a square meter. 

For example, 

320 x 450 = 144,000 square millimeters 

144,000 square millimeters / 1,000,000 = 0.144 square meters 

The same process is then applied to Area To. 

Field Name Description 

Area From Enter the lowest Square Metre\Square Foot value for which the price entry is valid. 

Area To Enter the highest Square Metre\Square Foot values for which the price entry is valid. 

Sheet From Enter the minimum number of sheets for which the price is valid. 

Sheet To Enter the maximum number of sheets for which the price is valid. 

Cost Enter the cost per Square Metre\Square Foot to be applied for the running element 
of the operation. 

MU% Enter the percentage mark up value to be applied to the cost value. 

Price Auto populated using the Cost value + MU %. 
 

Note If you have added a line entry within the Other Finishing window, the application will ignore any entries 
for pricing within the Binding Prices window. 
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Location/Currency Tab 

Locations 
The data within this screen enables the calculation of cost of delivery from printer or binders to customer 
locations.  

For the calculation to be correct, the distance from a location to a location must be entered.  

  

Note By default the system contains all major UK cities and towns with the mileage between each location 
entered.  

There are two methods for calculating delivery within an estimate.  

• Delivery Costs 
 

• Transport Rates 
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Delivery Costs 
The application uses the location data to calculate the overall distance that the goods will be shipped.  The 
delivery cost is then calculated using the values added in the Delivery Costs window that is based on a minimum 
and maximum distance and minimum and maximum kilos. 

For example, if 3000 kilos are needed to be delivered a distance of 5 miles, the estimate would include £50 in the 
delivery cost calculation; 1-10 miles, greater than 1500 kilos but less than 4500 kilos. 

 
 

The system includes a single load limit that will use the value added to application setting id 4 for Estimating, for 
example 25,000 kilos. The data entered within the Delivery Costs window must reflect the value entered in 
application settings.  

Delivery Weight Calculation 

The weight to be delivered to a customer is calculated as follows: 

Square meters of product x grammage of paper x (pagination/2) x product uplift (defined on site tab) x nett 
quantity. 

This calculation is performed for each print section and then added together to calculate the total for delivery. 

A further example is provided in the Calculations chapter at the end of this User Guide. 

Freight Rates 
Transport Rates allows the banding of freight calculation by zone and weight, plus the ability to enter a set up, 
drop and fuel levy amounts. 
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Entering Transport Rates: 

1. Ensure that application setting ids 118 and 119 for Estimating are entered as 1 (True). This will create 
additional options on the Miscellaneous tab of Estimating Maintenance: Transport Type, Freight Rates 
and Fuel Levy. 

2. If required, click Transport Type to open the TransType window. Enter the various transport options 
and click Close to save the changes and close the window. 

 
3. Click Freight Rates. For each location (entered in the Location/Currency tab) and for different transport 

types (if required), you can enter the freight charges by date and weight to be applied to each zone 
(location). Along with this you can enter a set up and per drop charge and a fuel levy and mark-up %. 

 

Field Name Description 

Location Enter the destination from address. The list of options are entered within the 
Location/Currency tab. 

Transport Type Enter the transport type from the list of options entered in the Transport Type 
window. 

Date From Enter the date from which the entered rates will be valid.  This represents the start of 
the range and will be valid up to the start of the next range if entered. It is a 
mandatory field and must be a valid date. 
If it is changed, the application updates all the associated weight breaks for the date. 
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Field Name Description 

Weight From Enter the weight from which the entered rates will be valid. This represents the start 
of the range and will be valid up to the start of the next range if specified. It is a 
mandatory field and must be greater than or equal to 0. 
If working in metric mode then the range represents tonnes. If working in imperial 
mode then the range represents CWT. 
The combination of Date and Weight must be unique. 

Add (Date From Range) Click Add to create a new date range. You will be asked if you wish to copy existing 
transport type/weight ranges and location entries. 

Change (Date From 
Range) 

Click Change to amend the date range. 

Remove (Date From 
Range) 

Click Remove to delete the entire Date range. 
Upon confirmation removes the chosen date range and all related transport 
type/weight range details. 

Add (Weight From 
Range) 

Click Add to create a new weight range. If you wish to copy existing transport 
type/weight ranges and location entries, select Base new range on existing range.. 
and then select the existing range from the list of options. 
It will copy all the existing transport types for the current weight range and location 
entries and sets the weight to the highest weight + 1. 

Change (Weight From 
Range) 

Click Change to amend the existing weight range. Enter a new Weight from. 

Remove (Weight From 
Range) 

Click Remove to delete the entire Weight range. 
If Weight range – Upon confirmation removes the current weight range for the 
chosen date and transport type. 

Mark Up % Enter a numeric value. This can be up to two decimal places.  The % mark up will be 
added to the calculated cost to generate the price. It must be greater than or equal 
to -100. The default is 0.  If the Freight Charge option is being used then this % 
mark-up overrides the % entered in the Site tab. 

Location List of locations entered in the Location tab.  Must be a valid location from the list.  
Must be unique within the Date and Weight range. 
If changed it prompts you to confirm whether you wish to apply the new location 
across all ranges.  This includes a newly added location entry. 

Set Up Enter a numeric value. This can be up to two decimal places.  The set up charge will 
be applied to each dispatch specification.  Must be greater than or equal to 0 and 
the default is 0. 

Drop Enter the drop charge to be included for the specified number of drops entered 
against each despatch. Must be greater than or equal to 0 and the default is 0. 

Cost per Tonne (or 
CWT) 

Enter the cost of delivering 1 tonne or 1 CWT to the location for the selected date 
and weight range. Must be greater than or equal to 0 and the default is 0. 

Add Adds a new location entry. 

Remove Removes the selected Location entry from the grid. 
When selected you will receive a prompt asking whether the location entry is to be 
removed from all other ranges. 

OK Saves the latest input and closes the screen. 
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4. Click Fuel Levy to enter the fuel levy charges by site, transport type and date.  

 

Field Name Description 

Site Enter the site to which the fuel levy is to be included.  

Transport Type Enter the transport type to which the fuel levy is to be included.  

Date From Enter the date from which the levy is valid for the chosen site and transport type. 
This represents the start of the range and will be valid up to the start of the next 
range if specified. It is a mandatory field and must be entered. 

Levy % Enter the percent levy to be charged within the date range. The default is 0 and an 
entry must be greater than or equal to 0. 

Add Click Add to include a new entry. 

Remove Click Remove to delete the selected entry. 
 

Freight Rate Calculation 

Freight calculation formula:  
Freight Cost = (((Ship Weight/Drops)*Cost per tonne of 1 drop)*Drops) + Setup + (number of drops * Drop Cost) 
* (1 + Fuel Levy)  
For example: 

A shipment quantity of 100,000, with 20,000 (20%) going to one zone (location 1), and the remaining 80,000 
(80%), going to a second zone (location 2). Delivery Date May 2016.  

Book weight = 325gms. Total weight to be shipped = 325 * 100,000 / 1,000,000 = 32.5 Tonnes  

Shipment 1 (Sheffield) - 20% to be shipped to Sheffield = 1 drop = 6.5 tonnes.  

Shipment 2 (Scarborough) - 80% to be shipped to Scarborough - 4 drops = 26 tonnes.  
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Each shipment is calculated in turn:  

 

 

Shipment 1 

Freight Cost =  

(((Ship Weight/Drops)*Cost per tonne of 1 drop)*Drops) + Setup + (number of drops * Drop Cost) * (1 + Fuel 
Levy)  
(((6.50 / 1) * 20.00) * 1) + 50.00 + (1 * 40.00)) * (1 + 0.025) = £225.50  
Freight Price =  

Freight Cost * (1 + Mark Up %) = 225.50 * (1 + 0.10) = £248.05  

Shipment 2 

Freight Cost = 

(((Ship Weight/Drops)*Cost per tonne of 1 drop)*Drops) + Setup + (number of drops * Drop Cost) * (1 + Fuel 
Levy)  
(((26.00 / 4) * 25.00) * 4) + 50.00 + (1 * 40.00)) * (1 + 0.025) = £758.50  
Freight Price =  

Freight Cost * (1 + Mark Up %) = 758.50 * (1 + 0.10) = £834.35  

Total Freight Cost = £225.50 + £758.50 = £984.00 

Total Freight Price = £248.05 + £834.35 = £1,082.40 
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The calculated freight costs are stored in the same manner as the current delivery costs.  

Note When transferred to Order Management the cost and price will be represented as an ancillary item. A 
separate ancillary item is created for each shipment specified.  

Currency 
The Estimating application allows you to produce a quotation letter based on any currency, and does not need to 
be your currency which is entered in application settings id 3 for Estimating. 

As a consequence you can maintain currencies and their default exchange rate within this tab.  

  

You do not need to maintain the exchange rates; you simply need to ensure that the Currencies are added. 
Within each estimate and contract title you can enter the current exchange rate for inclusion when creating the 
estimate and subsequent quote letter and potentially, the sales invoice. 
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Terms Tab 
Terms and conditions are generally included on the quotation letter. There are three possible ways for these to 
be added: 

• On pre-printed stationery. 
 

• Included in the XSL template upon which the quotation letter is printed. 
 

• Adding the terms on the Terms tab in Estimating Maintenance so that they can be output to the XML file 
based on content of the estimate. In order for this option to work as expected the XSL template needs 
to support this method. 

 

The Terms tab allows you to edit the text within the Description so that it is more suitable for your organization. 
You can also add new items; click Add Item from the toolbar and a new line will be added to the bottom of the 
window. 

You can associate a Type Description with each term and condition. The Types are associated to certain 
characteristics of the estimate, for example, if paper is to be supplied by the customer, and within the estimate 
this has been entered, the terms and conditions will recognize the item which has a Type Description of Paper 
Supplied and will output the associated term and condition (as highlighted above). 

To remove a term and condition, select the item and click the red cross (delete) icon on the toolbar. 

Term types 
Click Terms Types to open the Term Types window. This displays a list of the term types but is not available for 
editing. 
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Miscellaneous Tab 
The Miscellaneous tab is where you can enter non-resource specific data, such as materials, finishing styles etc. 

 

Within this User Guide there has already been some reference to this tab, as it is necessary to enter data within 
the options available before being able to proceed to other areas of the application, for example, pre-press 
activities, press extras, and finishing styles. 

The Miscellaneous tab is split into five distinct areas: 

• Pre-Press 
 

• Press 
 

• Finishing 
 

• Custom Fields 
 

• Other 
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Pre-Press 
Pre Press 
The Pre Press window enables you to enter the master list of pre press items and their associated sizes. This 
allows subsequent cost and price information to be entered at site level on the Site tab. 

If pre-press JDF integration is a requirement then the JDF type must be entered from the pre-defined list. The 
Custom Type and Named Features are also for JDF integration; this allows specific parameters to be supplied 
to a prepress workflow system. (If JDF integration is not required, these fields can be empty.) 

 

To enter the size options so that the relevant costs and prices can be entered on the Site tab, select the pre 
press activity and click Sizes. 

In the Sizes window you can add the appropriate minimum and maximum product sizes for the activity. 

 

JDF Types 
Click JDF Types to open the JDF Prepress Type window. This is the master list of JDF types where you can add 
different JDF types that can subsequently be associated to the pre press activities within the Pre Press window.  

Note This information only needs to be entered if you are implementing JDF integration. 
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JDF Fold Catalog 
Fold Catalogs are a pre-defined list of JDF folding types that describe how a bindery signature is folded. It is 
required for pre-press JDF integration, however JDF Fold Catalogs can also be used within Estimating and Order 
Management to automatically calculate the open size (flat size) of a product based on its finished size, 
pagination and fold type. 

For JDF stripping to work correctly, the fold catalog must be specified at the press configuration. It’s important to 
remember that the fold catalog relates to the bindery signature, not the sheet. So if there are four bindery 
signatures on a sheet, for example, a cover printed 4up, each bindery signature will have the same folding 
catalog. 

There can be multiple fold catalog entries for paginations greater than four pages. For example an 8 page 
product can be folded in multiple ways to produce the 8 pages. 

Note The layout must represent a bindery signature imposition and is only ever 1up. The representation of 
the sheet layout will be calculated by the system if the chosen method of production (configuration) is a 
multiple number up and, for sheetfed only, if work and turn or work and tumble. For come and go style 
configurations these are still treated as a 1up configuration but for the overall pagination. i.e. 48pp 2up 
come and go is treated as a 96pp 1up. However the related fold catalog will have to contain the 
repeating page number definition.  

Click Import Fold Catalogs to browse to a location where the JDF Fold Catalogs have been saved so that they 
can be imported. 

Entering the layout definition 
1 Open the JDF Fold Catalog window. 

 

Field Name Description 

JDF Fold 
Catalog 

Enter the JDF standard folding catalog name or a custom folding catalog name. 

Pages Enter the number of pages for the bindery signature. 

Across Enter the number of pages across the signature (when viewed in the correct 
orientation). 

Down Enter the number of pages down the signature (when viewed in the correct 
orientation). 

Fold Type Link Enter the folding style as entered within the Fold Types window. 
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Field Name Description 

Binding Lap Enter the number of binding laps for the fold style.  
If None is entered, then no lap is added. 
If Single is entered, then the application will calculate a single lap width from the trims 
entered for the associated finishing style and add 1 lap to the open width. 
If Calculated is entered, then the application will calculate the number of laps 
required. 

No Folds Enter the number of folds. 

No Turns Enter the number of turns. 

Feed Edge Enter the edge that will feed the signature into the folder. 
 

2 Double click the JDF Fold Catalog field for the selected JDF Fold Catalog line item.  

Note The Fold Catalogue Layout screen can be maximized for ease of reference. 

3 Enter the appropriate requirements. 
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4 The above example would produce the following bindery signature imposition: 

 

Imposition  
The Impositions window allows you to enter and maintain the list of Preps templates that are available for use 
with JDF in Technique. Once the folder has been created the templates can be imported. New templates found 
are added and changes to existing templates updated each time the import is run. 

Imposition detail can be manually maintained if required.  

 
At the left of the window an Impositions area shows a list of previously imported templates grouped by pagination 
The top right Imposition Details area allows you to enter or view the signature name, template path and the 
number of sheets (webs) and pages.  
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Importing Templates 

Once the Preps templates have been correctly named, they can be imported in to the Estimating Maintenance 
application. 

Click Browse and browse to the relevant folder and double click on any template. Once the template directory 
has been selected, click Import to start the import process. The system will attempt to import all templates in the 
specified folder. If a template has already been imported then it will not be re-imported. If a template contains 
multiple signatures then each signature will be imported as a separate imposition entry in Estimating 
Maintenance. 

The Fold Catalog field allows you to link the imposition it back to the fold catalog and page definition. 

For more information on JDF integration with Technique see the JDF Prepress Integration User Guide. 

Goss Templates 
Note This area is not required for configuration of the Estimating software and its use is outside the scope of 

this User Guide. 

However, for reference ou can enter Goss web press templates in order that they can be linked to a press 
configuration on the Press tab, to provide folding templates to help the folder configuration. The Goss template 
can be selected against the press configuration if Goss has been entered as the Vendor name on the Press tab 
for the associated resource. 

Press 
Press Extras 
As mentioned previously, you can enter custom press extras such as perforating, varnishing etc., and the 
material codes assigned to them. For example, a pattern perforating press extra with a material item such as the 
perforating form. This will ensure that the cost of the form is included in the estimated costs. At this point the 
press extras are not linked to a press or a press configuration. This is done within the Press tab (see the chapter 
Press Configurations). 

There are certain characteristics that you can associate to the press extra, regardless of the press configuration 
to which it will be assigned. You can enter these characteristics by selecting the appropriate check boxes. 
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Field Name Description 

Cover Select if the press extra will only be available for components entered as covers. 

Sheeted Select if the extra applies to a configuration that is supported by a press that can produce 
sheets. This is used as a flag to select other finishing equipment, for example, folders. This is 
mainly used to indicate sheeting off a web-press as the system understands that a sheetfed 
press always produces a sheet that requires further finishing. 

Half Sheet This characteristic is typically used where a finishing style delivers products from a Web Offset 
press. Half of the products are folded in line, half of the product delivered as a flat sheet for off 
line finishing. Enter this option so that the Estimating application understands how to apply 
offline finishing operations. 

Reel to Sheet Enter this option for sheet-fed presses equipped with a sheeter, so that they can be fed with 
web-paper (rolls). When paper is allocated, if the press route is on a press equipped with a 
sheeter, the user will be able to choose roll-stock as well as sheet-stock based upon the 
number of configurations created. 

RFE Enter this option if the press extra can be added when creating a Sales Enquiry. 

Live If selected, this will activate the press extra. 

Visible This option determines whether the press extra is available to the estimator when adding the 
enquiry or estimate. It is particularly useful for extras that are automatically incurred against a 
particular press configuration and is not something the estimator needs to choose. For 
example, 48pp penalty above. 

 

Against a Press Extra, materials can be automatically included, and form part of the cost and sell price 
calculation.  

You can add a material to the extra by selecting the press extra land clicking Material. The materials associated 
with it can then be set up to auto calc (limitations apply) or for the user to specify values such as coverage area 
etc. 

 

For further information see the chapter Material Items.  
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Sheet Sizes 
For sheetfed presses it is possible to enter standard sheet sizes. These sheets sizes can then be allocated to 
specific configurations as the default sheet size.  If not allocated to configurations, the calculation process will 
automatically work out the sheet size and then choose the next matching size from the sizes added. 

 
 

Field Name Description 

Site Name Enter the site name that the sheet size is available, or select All if it’s available at all sites. 

Description Enter the name of the sheet size. This needs to be informative for users when selecting the 
sheet sizes in Estimating and Order Management. 

Depth Enter the depth of the sheet. 

Width Enter the width of the sheet. 

Printable 
Depth 

Enter the depth of the sheet that is available for printing on. 

Printable 
Width 

Enter the width of the sheet that is available for printing on. 

Grip Edge Enter the preferred grip edge. You can enter whether this is at the Top, Bottom, Left, Right of 
the sheet or None.  
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Paper Coatings 
The difference paper finishes can be entered in this window, although the application is supplied with default 
entries. 

 

This window also provides the ability to enter Custom Calipers for each Paper Coating. To ensure that a caliper 
is available to be included in the calculation when custom papers are included in the estimate, you can enter 
generic caliper based on the coating. 
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The calipers are based on the Paper Coating and also the weight of the paper. Click Custom Caliper to open 
the Custom Calipers window. 

 

Caliper Modes 
You can enter the various modes based on caliper of paper and associate the mode with a press type of either 
Digital or Wide Format so that these can be selected when entering speeds for either Digital or Wide Format 
press types on the Press tab. 
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Finishing 
Finishing Styles 
The Technique system contains a number of pre-defined finishing styles. Additional finishing styles, such as in-
line stitching, can be added. Before adding new finishing operations, it is essential to obtain a full understanding 
of the existing finishing styles and the implications of adding new ones. For more information see Built-in 
Finishing Styles. 

 
 

Field Name Description 

Finishing 
Style 

Enter a two-letter code for the custom finishing style, for example, FB for Foil Blocking. 

Description Enter a description for the custom finishing style, for example, Foil Blocking. 

Press 
Finished 

Select this field if the is capable of being produced off the press with no further finishing, for 
example, in-line stitched, spine glued, etc. 

Primary Style Select this field if the finishing style can be used when entering press configurations. Items in 
this list will not appear in the Additional Finishing drop down list within Estimating and the 
Enquiry forms. 

Enq Seq You are allowed to enter five finishing styles to appear as check box selections on the main 
Enquiry Detail window within Estimating. 

Stitched Select this field if the finishing style either requires stitches (and therefore enables the 
corresponding check box in Estimating and Order Management), or that sections will be 
gathered (sections inserted inside each other, as when stitching) rather than collated (sections 
placed side by side, as when perfect binding). This will affect imposition layouts and folio 
numbering. 
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Field Name Description 

Live Ensure that this field is selected if the finishing style can be chosen or used within any new 
Enquiry form or Estimate. 

Batch This indicates that the finishing style is classed as a Small Machine and makes the Parameters 
button available when selected. See Small Machines chapter for further information. 

Sheet Select this field if the finishing style processes sheets rather than individual copies. For 
example, Gloss Laminating is generally performed on flat unfinished sheets, so this check box 
would be selected for this finishing style if applicable. 
If you have entered the finishing style as Sheet, you enter the Overs Qty value within the Site 
Binding Overs window in Estimating Maintenance > Site > Binding Overs as sheets. As a 
consequence, the Waste Qty, calculated within the Estimate Finishing window in the 
Estimating application, is multiplied by the product number up to calculate the correct number, 
of waste quantity, in copies. 

Operation 
Description 

Default 

Enter the name of the part produced from the result of the operation (only used in conjunction 
with BOR functionality). 

Multi Input Select this check box if the finishing style is capable of accepting multiple printed components. 
For example, an Offline Folder or Guillotine would only run one section at a time (Single Input) 
whereas a Stitching operation can bind multiple sections together at the same time (Multi 
Input). This is only used when utilizing the BOR functionality. 

Sewing 
Collate 

For certain finishing operations it is necessary to enter that the same number of sections that 
are allocated to the operation are delivered out of the operation. Typically, when book binding, 
all sections will be gathered through one operation and a subsequent sewing operation needs 
to understand that the sections have been gathered but there are still x number of sections to 
be sewn individually. In this example, the Sewing Collate check box would be selected.   

Lap Select this check box if the finishing style requires a binding lap. By default, the system defined 
Wire Stitched finishing style will have this selected. Any other custom finishing style can also 
attract a binding lap using this indicator. 

Lead This is not relevant to Estimating and the standard desktop applications. This is reserved for a 
future release of Print On Demand. 

Trim Select this check box if the finishing style will trim the input sheet or product and therefore 
result in the trimmed product size. 

 

Built-in Finishing Styles 
When entering finishing styles it is important to understand that within the Technique calculation certain rules are 
pre-defined with regards to certain finishing styles. For example, web printed sections are always assumed to be 
folded on press and either trimmed to size on press, or trimmed during finishing, for example, using a stitching 
line’s three-knife trimmer. 

There are five built-in finishing styles: 

• Perfect Bound 
 

• Spine Glued 
 

• Cut / Folded 
 

• Wire Stitched 
 

• Press Finished 

Perfect Bound (PB) 
For sheeted sections of Perfect Bound products, cutting operations will be added to every printed section greater 
than 1up. Folding will be added to all sections greater that 2 pages except covers, which will never be folded. 
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Finally, a perfect binding operation will be added. For sections that are not sheeted, the system assumes that the 
press will deliver sections that are folded and cut to 1-up. In this instance, the system will only add a perfect 
binding operation. 

Spine Glued (SG) 
Spine Glued behaves the same as Press Finished; however, using the Spine Glued finishing style allows 
configurations to be created with a spine glued press extra and a link to the required material type automatically 
added. This will prevent the estimator forgetting to add the required press extra. The correct finishing style will 
also appear on the documentation. 

Cut / Folded (SH) 
Cut / Folded indicates that the section needs to be cut and/or folded. For web press routes, sheeting must be 
carried out. Cutting will be added for all sections (including 1-up sections). Folding will be added for all sections 
of 4 pages and above (a 2-page section cannot be folded). 

Wire Stitched (WS) 
For sheeted sections of Wire Stitched products, cutting operations will be added to every printed section greater 
than 1up. Folding will be added to all sections greater that 2 pages except covers, which will never be folded. 
Finally, a wire stitched operation will be added. For sections that are not sheeted, the system assumes that the 
press will deliver sections that are folded and cut to 1-up. In this instance, the system will only add a wire 
stitching operation. 

Press Finished (XF) 
Press Finished indicates that sections are delivered cut and folded off press. For sheeted web press and sheet-
fed routes, cutting will be added for all sections, folding will be added for all sections of 4 pages and above (a 2-
page section cannot be folded; however, an outworker that supports the finishing style FL for a 1-section product 
will cause folding to be added). 

Product Template (also known as Bill of Routing) 
There are two methods that can be used when entering an enquiry and or estimate: Standard and Bill of Routing 
(BOR). BOR templates allow you to enter pre-defined production methods and is particularly useful where 
multliple finishing operations need to be included in the calculation. 

Note For the Quick Pricer licensed module and Sales Enquiry custom enquiry forms, you have to create BOR 
templates. 

Templates are created that contain all of the finishing operations linked correctly in sequence so that Estimating 
automatically understands the input in to the operation and its output. 
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BOR is entered in three tiers: 

• Finishing Style 
 

• Product Template 
 

• Product Style 
 

 

The first tier is automatically set using the finishing style against which the templates have been created. 

Product Template 
The second tier is created by adding Product Templates.  

Note Consideration should be made about how you would like the structure of the tiers to be defined from the 
perspective of usability. 

From the Finishing Style window, select the Finishing Style and click Product Template to open the Product 
Template window for that style. Product Template entries can be added to, deleted or copied. 
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For users of the Quick Pricer and Sales Enquiry modules, click Enquiry Details to link the Product Template to 
the Enquiry Template.  

 

The Enquiry Details window will open.  

Select Title Available to make the product template available within Quick Pricer and Sales Enquiries. 

 

Enter the RFE Template. The list of options available are based on the enquiry templates entered within MIS 
Console > Maintenance > RFE Template Maintenance. For further information see the Quick Pricer chapter 
later in this guide. 

Enter the Display Order to position of the template with the available lists of templates within Quick Pricer or 
Sales Enquiries in MIS Console. 

Within Quick Pricer and Sales Enquiries, graphical representations of the products can be viewed. To make the 
graphical representations visible, click Browse to select an image file.  

You can also associated a contract to the template within the Enquiry Details window. The Ancillary Contract 
field will present a list of options of contracts that have been entered as Standard at contract level. This enables 
any ancillary items entered in the contract to be available for selection when creating the enquiry.  

Note Only one contract can be associated to the enquiry template. 
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In the following example, a Contract has been linked to the Enquiry for the purpose of offering the ancillary 
options when the user is creating the enquiry 

 

Click OK to save the change and close the window. The Ancillary Defaults button is now available within the 
Product Template window. 

 

The Ancillary Defaults window allows you to enter any default ancillary items from the contract to be 
automatically included when the enquiry or Quick Pricer is added in MIS Console.  

You can also choose to have the ancillary item included within the sell price, either as part of the Print, Finish 
and Delivery values, or broken out on the quote letter (select the Separate check box), or as an extra in addition 
to the total sell price (select the Optional check box). If you wish the ancillary item to be entered more than once, 
then enter the number of times it is to automatically be included within the No Of (number of) field. 
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Note Any defaults added in the above window can still be removed for each enquiry or Quick Price. 

 

Product Styles 
The third tier determines the specific template to be used within the applications. Within the Product Style 
window, entries should be created for each BOR emplate that is required. The Description and Code fields are 
customizable and should be enter using a method that contains enough information to ensure that the user is 
selecting the correct option. 

From the Product Template window click Product Styles. 

 
For each product style you will create a list of default components and also the BOR. 

Component Details 
Once the template names have been entered, you need to enter the default Components. The information 
created within the Component Details window will create the actual print components within the Sales Enquiry 
and Estimating. It is not necessary to populate all fields, only the Title field is mandatory. All other fields can be 
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confirmed by the user when the print components have been created within the Enquiry or Estimate. At the point 
of building the enquiry or estimate using the template, the pagination will be presented on screen to the user so 
that the number of pages can be overridden if required. 

The level of detail entered against the components depends on your own company and the type of work 
produced. If you produce a lot of standard products for example, where pagination, inks, paper etc., is common, 
this information can be set within component detail resulting in less information for the user to enter in the 
enquiry or estimate.  

If the values change for every estimate produced, leave the details blank so that the user has to correctly set 
these against every estimate. 

From the Product Style window, click Component Defaults. 

 

Field Name Description 

Title Enter the name of the component. 

Pag Enter the pagination for the component. 

Depth Enter the depth (in millimeters) of the component. 

Width Enter the width (in millimeters) of the component. 

Cover Select the check box if the component is a cover. 

Supplied Select the check box if the component is supplied pre-printed to you. 

Fold Enter the fold style to be applied to the component. 

Open Size Select the check box if you wish the component to be calculated based on its open size. 

Calc Group Enter a calculation group as appropriate. For further information see Calculation Groups 
chapter later in this use guide. 

Calc Method Enter a calculation method as appropriate. For further information see Calculation Groups 
chapter later in this use guide. 

Colours Displays the default number of colors for the component. 
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Field Name Description 

… Click … to open the Colour Definition window.  
 

 
 
Enter the default colors required for the component and coverage. If you do not want the user 
to be able to change the ink coverage for the component, select the Locked check box. 

Finishing 
Style 

Enter the Finishing Style for the component if it is different to the main product template 
finishing style.  

Paper Grade Enter the default paper grade for the component to automatically populate the enquiry or 
estimate. 

Paper Brand Enter the default paper brand for the component to automatically populate the enquiry or 
estimate. 

Paper Weight Enter the default paper weight (in grammage) for the component to automatically populate the 
enquiry or estimate. 

Web Width Enter a specific web width if you require a particular web width to be calculated for paper 
requirements rather than the system calculated width. 

 

Bill of Routing 
This area is critical to the successful use of the Product Templates. Bill of Routing (BOR) contains the 
requirements for finishing the product. 
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Field Name Description 

Main Proc The main operation sequence number for the component. The Main Process value for the first 
line entry will default to 1 as will the Minor Process value. In the example above, and generally, 
for every different operation involved in producing the same component, up to the point of 
binding, would have a Main Process value of 1. Only the Minor process value will increase. 
When a different component is to be included in the finishing operation, the Main process 
would then need to be 2, as per the End Paper entry in the example above. 
There are occasions when the Main Process number can be duplicated. For example, 2 x 
components to be wire stitched. If no other operations were required, then you would have 
Main Process 1 and Minor Process 1 for the cover, and Main Process 1 and Minor Process 1 
for the text, as below. 

 
Minor Proc The minor operation sequence number belonging to the main process. 

Mat Only Select the checkbox if the component input is material only.  

Component Select the component entered in the Component Details window that is the input into the main 
operation and minor operation sequence number 1. The component does not need selecting 
for minor sequence numbers greater or equal to 2. 

SubStyle Select the finishing style to which the component is to be included. 

Routing 
Output 

The main operation sequence number that the product of the selected operation feeds into. In 
the following example, once the Label component has been cut it will be input into the Case 
Making operation (Main Process 3), and then it will be input into the Case Binding operation 
(Main Process 6). 

 
Finishing Ensure that this is selected if the operation is a finishing operation. Clear the check box if the 

operation is a printing process. 

SiteBO Select the check box if the calculation of binders overs are to be based on the entries within 
the Site Binding Overs window. 

BO % Enter the binding overs percentage that needs to be included in the calculation. If SiteBO is 
populated then this field can be left blank. 

BO Qty Enter the binding overs quantity that needs to be included in the calculation. If SiteBO is 
populated then this field can be left blank. 

Cells Req’d Selecting Cells Req’d will prompt the user to define how many data cells are to be used against 
the finishing operation when the template is used in Estimating. 
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Using the product template shown above, when the enquiry or estimate is created using this template, the 
finishing operations are presented to the user within Estimating as follows: 

 

Note Application Setting id 70 needs to be reviewed. When the setting is entered as 1 (True) you do not need 
to enter guillotine and folding operations into the BOR as the application will automatically add them to 
each estimate based on the printing process of the component.  

 For example, prior to calculation and route selection you do not know if the cover will be printed 
sheetfed or web offset. If the finishing style for the product is saddle stitched, you therefore do not know 
if you need to include a cutting or folding operation to the cover prior to wire stitching. With the 
application setting entered as 1, you do not need to enter these finishing operations into the BOR, as 
they will automatically be entered only if a sheetfed route is selected to print the cover. 

Additional Operations 
The Additional Operations window allows you to enter the different types of operations which can be included in 
the finishing operation in addition to the components included, for example loose inserts, perforating, bound 
inserts etc. These entries are available for selection when entering additional operations for the finishing 
resources on the Finishing tab, as well as outwork binders. The maximum, default, and fixed number per 
publication can be entered, however, one of the key factors that needs to be entered is whether the insert can be 
positioned within the binding order. For example, a bound in insert can be sequenced within the binding order in 
Order Management. 
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Note The Binding Type field is no longer used and any value can be entered. 

Insert Groups 
Insert groups are where you can enter groups for types of inserts. In the example shown below, the user would 
need to first select an insert group before seeing specific insert types.  

 

Fold Types 
Different fold types can be entered within the Fold Types window for selection against Folding resources in 
finishing and also for inclusion when entering Fold Catalogs (see Pre Press chapter above). 

The Default Fold Style will be automatically included when adding a folding operation into an Estimate (either 
manually or automatically). 

You can also enter the orientation of the fold type and whether trims are added on a per page basis. This 
information allows the correct open component size to be calculated based on how it is folded. 

 

The Orientation field allows you to enter whether to layout the open size with width across the sheet (portrait) or 
the depth across the sheet (landscape). If you enter Yes within the Trims per Page field, you are applying the 
Head, Foot and Foredge trims per page and not per open size. 

Inco-Terms & Transport Types 
There are many ways to send pallets, packages, letters etc. They may include use of transport companies, 
courier services, parcel services, postal services, transport by rail or sea transport. 
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All these transportation options have their own specific rules, terms, conditions and method of control. Often 
there are different departments for different shipping methods. For example, the department Service & Quality 
will use uses courier, parcel and postal services a lot, and the department Expedition will make extensive use of 
freight transport. 
To be able to organize transport, it is therefore important at an early stage of the process to know what kind of 
transportation should be organized. However, it is also important who pays the transportation, and who orders 
transportation in reality. Here are the Incoterms (delivery conditions) of interest. 
If an estimate includes no delivery, it will be assumed to be Ex Works (for Collection) using the existing 
functionality supported by the Estimating application and users will not need to select any Delivery, Transport 
Type or Incoterms. 

Note This data has no impact on Estimating cost or prices but are for information only when generating 
documentation such as quote letters etc. 

To make the Inco-Terms and Transport type buttons available, you need to ensure that application setting ids 
117 and 118 for Estimating are entered as 1 (True).  

Inco-Terms 
The Inco Terms window allows for the entry and maintenance aspects of the IncoTerms that you wish to use. 
You need to enter the IncoTerm short code and Description (both customizable and generally would use the 
international standard Inco Terms types). The standard codes can be found on the IncoTerms website. 

 

Transport Types 
Typically, the Transport Types would be used in conjunction to determine how the product is to be shipped to 
various countries. This is a user definable list and will present options for selection within the Delivery area of an 
Estimate, as well as when entering Freight Rates. 

 

Freight Rates 
The Fright Rates is an alternative way to calculate delivery costs within an estimate. Please see 
Location/Currency chapter above for further details. 

Fuel Levy 
For further information on Fuel Levy see the Location/Currency chapter above.  



130 l EFI Technique 5.4 | System Admin for Sales Enquiries, Estimating and Quick Pricer 5.4 User Guide 

 
 

 

Bindery Extras 
As detailed within the Finishing Tab chapter, you can now enter bindery extras for inclusion in the calculation of 
bindery operations. For more information please see the Bindery Extras chapter earlier in this guide.  

Custom Fields 
In both Estimating and Order Management users often need to enter specific information particular to their 
organization that is not easily entered elsewhere in the applications. As a consequence, both applications have 
additional windows where you can create tabs and field data to be displayed in the custom windows and are 
entirely configurable by the user. 

As a consequence you can create and design the layout of these custom windows within this tab of Estimating 
Maintenance. The process is identical whether you are designing windows to appear in Estimating or Order 
Management, however only custom fields entered within the Estimating Header Custom Fields will appear in 
Estimating, and custom fields entered within the Order Header Customer Fields will display in Order 
Management. 

The following example details the steps for designing custom field windows in the Estimating application. 

1. Click Estimating Fields to open the Estimating Header Custom Fields window. 

2. Click Layout > Manage Tabs > Add Tab. 

 
3. A new tab will appear. 

 
4. Right click the tab name and click Edit tab. This will allow you to change the Tab Caption (name). 

 
5. For the Tab Properties and also for the additional controls you can select the Web Visible check box if 

you wish for this custom window to be available within the enquiry form in Sales Enquiries.  
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6. You now need to enter the controls (or fields) that will be available to the user for input of information. 

7. Click Layout > Manage Controls and choose the control name, or right click within the tab window and 
select the control from the short cut menu. 

 
8. Any control added to the tab will first appear in the top left hand corner of the tab. Clicking on it and 

dragging it to the required position can then position the control. The control will automatically snap to 
the displayed grid making it easy for you to align the control with others. 

Each control type also has its own set of properties.  Right click the control and select Edit from the short cut 
menu to open the Properties window. The following options are available within the controls: 

• Default; this allows you to enter a default value. 
 

• Web Visible: if selected, this allows the custom field to be displayed within the enquiry form in Sales 
Enquiries. 
 

• Show in Quote: if selected, this outputs the custom field to the Quote XML. 

Below is a description for each of the controls available for inclusion in the custom tab. 

Label 

 

Use this control to describe the field names.  When displayed to the user there is no input required for this field 
type. You can control whether you want it to appear in the quote by selecting Show In Quote. This is also 
available for the other controls that can be added. 
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Text 

 

Use this control to enter text information.   

You can enter whether the user has to enter a value within this field by selecting the Mandatory check box, and 
also enter a default value that will pre-populate the field when displayed. 

Numeric 

 

Use this control so that the user can enter numeric information.  

It can be indicated that entry into the field is mandatory, set a default that will pre-populate the field when 
displayed, a range that the entered value has to be within, indicate the number of decimal places and whether 
the 1000 separator is used in formatting the output. 

List 

 

Use this control to present the user with a pre-populated list of choices.  Click .. next to the List values field to 
enter the list of options that you wish to the user to choose from within the application. 

You can set a default from the list of options entered. 
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Yes/No 

 

Use this control to present the user with a Yes/No choice. The default can be set to Yes or No. 

Date 

 

Use this control to prompt the user to enter a date.   

It can be indicated that entry into the field is mandatory and set a default date. 

When presented to the user the date picker will be available. 

Time 

 

Use this control to prompt the user to enter a time.   

It can be indicated that entry into the field is mandatory and set a default time. 

All custom field detail is written to the Quote XML file to facilitate the output of custom data onto the quote letter 
or estimate workings.  When designing a custom form it is prudent to name the controls with recognizable tags.  
This way when creating the XSL quote letter or working templates the fields are easily recognizable. 
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Other 
Materials 
The Material window allows you to enter data for all material types with their associated attributes, unit of 
purchase and unit of consumption and their cost and sell prices that can all be date dependent. 

Materials have a 3-level hierarchy: 

• Group 
 

• Type 
 

• Item 

The application includes a set of pre-defined system materials as outlined below.  These materials cannot be 
removed from the system as the applications will not work with out them. 

• Ink > Process > Black, Cyan, Magenta Yellow 
 

• Paper 
 

• Plates 
 

• Packing 

Material Group 
The top level of materials is the Group.  

 

Field Name Description 

Description Enter the name of the Group, for example, Laminate. 

Short Desc Enter a short name of the Group, for example, LAM. 

System If the group was created by the application this field will display Yes. For custom created 
groups this will be No. 

Ledger Code No longer used. 
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Field Name Description 

Treat as 
Paper 

Select the checkbox if the group contains paper items. 

Caliper 
Enabled 

Select the checkbox if you wish to calculate this paper item based on caliper. 

Consumption 
Label 1 

The consumption label entries control the field labels seen against the material item when 
entering the consumption data so you need to enter an informative label name for this purpose.  
For example, for a paper material item, the UOP and UOC may be different, therefore you 
would enter UOC / UOP Ratio: in this field so that users can enter the appropriate Ratio for 
calculating cost and price. 

Consumption 
Label 2 

If you need to enter a second level of consumption, for example, Coated and Uncoated papers 
often attract a different consumption level of ink, so you may choose to enter Coated within the 
Consumption Label 1 field and Uncoated within the Consumption Label 2 field. 

Show Select this check box if you need the label to appear within the Consumption and Costs 
window. 

Numeric 
Label 1 – 6 

If you wish for additional Material Attributes to be available for data entry within the Item Detail 
window, you need to enter a name for the fields and select Show. These fields are for 
information purposes only. 

Attribute 
Label 1 – 3 

If you wish for additional Material Attributes to be available for data entry within the Item Detail 
window, you need to enter a name for the fields and select Show. These fields are for 
information purposes only. 

Cost Band 
fields 

The cost band labels allow additional information to be gathered against the material item (if 
selected to show), and can be used for advanced reporting. These are not required fields. 

GI only Select this checkbox if the material you are entering is only required for use in General 
inventory and not within Estimating. All materials are entered within Estimating Maintenance 
but not all are for Estimating, for example, cleaning materials, that you may need to purchase 
within the General Inventory application are not included in any Estimating calculation. 

 

Material Type 
The Material Type is the second level of entry required.  

 

Field Name Description 

Description Enter the name of the Type, for example, Carton. 

Short Desc Enter a short name of the Type, for example, CAR. 

System If the group was created by the application this field will display Yes. For custom created 
groups this will be No. 

Ledger Code No longer used. 

Pallet Select the check box if the material type is a Pallet. 

Carton Select the check box if the material type is a Carton. 
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Field Name Description 

CPM Packing Select if the material type is a custom packing material for use with Advanced Packing. 
 

For customers working in imperial mode this is where the Basis Area is entered.  If not chosen the paper 
calculation will not work. 

You can click Add Type to create a new material type and Add Item to create a new material item for a type from 
this window. 

Material Item 
Material Item is the third and final level of entry. This is split into two subsequent levels: 

• Item Detail 
 

• Consumption and Costs 

Item Detail 

The Item Detail allows you to enter the specific details of the material item. In the example below, the Magenta 
process ink is the item detail. The required fields of entry are the Description, Short Desc, and Measure Type. 

 

Field Name Description 

Description Enter the name of the Item, for example, A4 Cartons (within the Carton Type and Packing 
Group). 

Short Desc Enter a short name of the Item, for example, A4C (within the Carton Type and Packing Group). 

System If the group was created by the application this field will display Yes. For custom created 
groups this will be No. 

Ledger Code No longer used. 

GI Only Select the checkbox if the item is for General Inventory purposes only and not to be visible 
within Estimating and Order Management. 

Live Select the checkbox to indicate that the item is active and available for selection within 
Estimating and Order Management. 

Brand Select the Brand for the item. This enables you to enter multiple items for the same 
specification that is brand specific and that incur a different cost and sell value. For example, a 
generic (not brand specific) 200gsm Woodfree Gloss Art may incur a different cost and sell 
price than a branded 200gsm Woodfree Gloss Art. 
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Field Name Description 

Cost Analysis 
Code 

No longer used. 

Paper Weight Enter the appropriate grammage for paper items only. 

Measure 
Type 

Enter how the material quantity is calculated. For example, Paper is calculated by weight, Ink 
by Area, Packing by Unit etc. 

Depth Enter the depth of the item in millimeters. This is specific to packing items. 

Height Enter the height of the item in millimeters. This is specific to packing items. 

Paper Caliper Available when the group is paper and caliper is enabled. Enter the caliper for the paper item in 
millimeters or inches if you’re using Imperial measurements. 

Width Enter the width of the item in millimeters. This is specific to packing items. 

Max Weight Enter the maximum weight that the item can hold, in kilograms. This is specific to packing 
items. 

External 
Depth 

Enter the external depth of the item in millimeters. This is specific to packing items and is 
included in the calculation of Advanced Packing. 

External 
Height 

Enter the external height of the item in millimeters. This is specific to packing items and is 
included in the calculation of Advanced Packing. 

External 
Width 

Enter the external width of the item in millimeters. This is specific to packing items and is 
included in the calculation of Advanced Packing. 

Material 
Weight 

Enter the material weight of the item in kilograms. This is specific to packing items and is 
included in the calculation of Advanced Packing. 

Max Height Enter the maximum height of the item in millimeters. This is specific to pallet items and is 
included in the calculation of Advanced Packing. 

Calc Group Enter the Calc Group for calculation of the material item. For further information see 
Calculation Groups and Methods later in this guide. 

Calc Method Enter the Calc Method for calculation of the material item. For further information see 
Calculation Groups and Methods later in this guide. 

Job Cost 
Type 

Enter the job cost type if you wish to automatically convert estimated materials to actuals when 
updating the status of an order in Order Management. For further information see the Job 
Costing User Guide. 

Job Cost 
Code 

Enter the job cost code if you wish to automatically convert estimated materials to actuals 
when updating the status of an order in Order Management. For further information see the 
Job Costing User Guide. 

 

From the Item Detail pane, click Consumption & Costs to open the Consumption and Costs window where you 
can enter the consumption and cost data and material specification. 

Consumption and Costs 

Consumption and Costs can be entered for each item at site level. 

The consumption ratio fields and whether the second field is displayed are set against the material group.  

For the selected site, the units of purchase and measure (consumption) for the material can be entered.  Based 
on the selection, the ratio of units of consumption to units of purchase can be entered.  Setting the right 
consumption ratio is critical to the correct calculation of the material requirement both in Estimating and Order 
Management. 
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In the following example the paper is consumed in Kilo’s and purchased in Tonnes.  The ratio is set to 1,000 
indicating your get 1,000 kilo to the tonne. 

 

Field Name Description 

Description Enter the name of the Item, for example, A4 Cartons (within the Carton Type and Packing 
Group). 

For Site Select the Site for which the costs and sell values are valid. For multi-site organizations you will 
need to ensure that values are entered for each site. 

Unit of 
Purchase 

Select the unit of purchase for the item. 

Consumption 
UOM 

Select the unit of measure for the consumption of the item. 

Consumption 
Rate  

This field name is whatever was entered in the Consumption Label 1 field within the Group 
Detail window. Enter the ratio between the Unit of Purchase and Consumption UOM as 
appropriate. For example, if they are the same measure type, then you need to enter 1 in this 
field. 

Purchase in 
whole Packs 

Indicates the material can only be purchased in whole units. If selected, then the material 
charged within the quotation will be rounded up to the nearest whole unit. For further 
information see Materials to Purchase in Whole Packs later in this chapter. 

Pack Multiple Indicates the pack multiple associated with the whole pack, for example, for items where the 
whole pack purchase consists of more than one item per pack. 

Minimum 
UOP 

Indicates the minimum amount of the material that can be purchased and therefore charged 
within the quotation.  If the calculated amount of material does not reach the minimum UOP, 
then the material amount is rounded up to the minimum UOP. 
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Field Name Description 

Raise 
Demand 

Select this checkbox if the material item is to create a demand in Order Management and 
subsequently Inventory Management.  

Direct Job 
Cost 

Select this check box so that at the point where the job status is changed to a complete status, 
the planned amount of material is automatically added to job costing. 

 

Note When entering sheetfed paper it is very important that the Sheet Desc is chosen against the cost/price 
record.  If it is not entered then the sheetfed paper cost/price will not be returned. 

The cost and price values are entered within an effective date range and unit of purchase band. For material 
items that have costs and pricing for multiple date ranges, the value selected for inclusion for calculation in 
Estimating or Order Management will be the value that is valid the delivery date of the estimate or order. 

For press related materials these can be varied based on the press type, for example, ink used within a web 
process attracts a different price of that for gravure. 

Purchase in Whole Packs 
The calculation of materials within an estimate and order are determined by the selection of Purchase in Whole 
Packs option for the item. The following examples provide details on how you can configure the material 
calculation based on the options selected. 

• Purchase in Whole Packs not selected 
 

• Purchase in Whole Packs selected including a Pack Multiple of 1 
 

• Purchase in Whole Packs selected including a Pack Multiple of greater than 1 
 

• Purchase in Whole Packs selected including a Pack Multiple and Minimum UOP 
 

• Purchase in Whole Packs for paper 

Purchase in Whole Packs not selected 

Where Material Units of Purchase are not used, the material requirements and costs are calculated without 
reference to the required units of purchase. 

In the following example, the Aqueous Varnish is purchased at £ 10.00 per kg and the Material Units of Purchase 
fields are not used. 
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The Raise Demand checkbox is selected in this example, but this does not affect the calculation of materials. 
This means that that materials associated with an estimate and subsequent order automatically requisitions 
greater control of material demand by ensuring that materials associated with an estimate and subsequent order 
within the Inventory Management module.  

The material is calculated and the cost value based upon the specific requirement for that material. 

Other Material cost is displayed as £177.75, a requirement based upon £ 10.00 per kg calculates a material 
demand of 17.78 kgs. 

 

Where Automated GI Materials Demand is used, the requirements are also displayed within the order. 

Purchase in Whole Packs Selected including a Pack Multiple of 1 

Select the Purchase in Whole Packs check box and enter the Pack Multiple. 

In the following example, the Aqueous Varnish is purchased at £10.00 per kg, the Purchase in Whole Packs flag 
is selected and the pack Multiple is entered as 1, indicating that the varnish is purchased per kilogram. 

 

The required kilogramss calculated are rounded up to the nearest whole kilogram, therefore, the original 
requirement is now based upon the whole packs calculation and so 17.78kgs is rounded up to 18kgs. 
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Other Material cost is now calculated as £180.00. 

 

Material demand shows the required quantity as based on whole packs. 

Purchase in Whole Packs Selected including a Pack Multiple of greater than 1 

Select the Purchase in Whole Packs check box and enter the Pack Multiple as a value greater that 1. 

The required kilograms calculated are rounded up to the nearest whole pack based upon the pack multiple 
specified. 

In the following example, the Aqueous Varnish is purchased at £10.00 per kilogram, the Purchase in Whole 
Packs check box is selected and the Pack Multiple is entered as 20, indicating that the varnish is purchased per 
pack of 20kgs. 

 

Therefore, the original requirement is now based upon the whole packs calculation rounded up to the required 
material to the next whole pack(s), 20. The original material requirement 17.78 kgs is rounded up to 20kgs. 
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Other Material cost is now displayed as £200.00. 

 

Material demand shows the required quantity as whole packs based upon the multiple. 

 

Purchase in Whole Packs Selected including a Pack Multiple and Minimum Unit of Purchase 

Select the Purchase in Whole Packs check box, specify the Pack Multiple and Minimum UOP. 

The required kilograms calculated are rounded up to the nearest whole pack based upon the pack multiple 
specified and If the material also has a minimum unit of purchase defined, then the material calculation will round 
up to the minimum purchase quantity. 

If the calculated amount of material is less than the Minimum UOP, then the material quantity is set to the 
Minimum UOP. If the Minimum UOP is exceeded, the material is calculated based upon the whole pack/pack 
multiple defined. 
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In the following example, the Aqueous Varnish is purchased at £10.00 per kg, the Purchase in Whole Packs 
check box is selected and the Pack Multiple is defined as 1, indicating that the varnish is purchased per kg. 
However, the Minimum unit of purchase is entered as 50kgs. 

 

Therefore, the original requirement is now based upon the calculation rounded up to the Minimum Unit of 
Purchase. The original material requirement 17.78 kgs is rounded up to 50kgs. 

Other Material cost is now calculated as £500.00. 

 

Material demand shows the required quantity based on the Minimum UOP. 

 

Purchase in Whole Packs for paper (sheets) 

You will note that when a Paper group, type and item is selected, the Purchase in Packs, Pack Multiplier and 
Minimum UOP fields are unavailable. 
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These are available for entry at the cost level, rather than being available to all cost ranges as there may be a 
minimum requirement when purchasing sheets. 

The principal is the same as for purchasing in whole packs for other materials detailed above. 

Adding a new Group, Type and Item 
You can add customized Groups and Types from the Group Detail pane.  

1. Click Add Group to create a blank Group Detail record. 

 

2. Enter the Description and Short Desc fields and the Consumption Label 1 field. 

Note If the material group is for paper ensure that the Treat as Paper is selected, and if you are using 
the system with caliper rather than grammage, for example for advanced guillotine, then you must ensure 
that the Caliper Enabled check box is selected.  

3. Click Add Type to create a blank Type Detail record. A new Type record can also be added whilst the 
Type level is selected. 

 

4. If you do not want to keep the newly created record (either Group or Type), click a different Type or 
Group record and you will be asked if you want to save changes, so select No and the new record detail 
will be removed. 
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5. Click Add Item to create a new item record. This will appear as -NEW- within the item list. You need to 
select this item and ensure that you are within the Item Detail window. 

 

6. Enter the Description, Short Desc, Brand and Measure Type fields as a minimum and enter the 
remaining fields as appropriate, for example if paper, enter the Paper Weight, or if packing enter the 
packing dimensions. 
 

7. Click Save on the toolbar and then click Consumption and Costs.  

 

8. Enter the Site (this will default to the site of the user’s login) and click Add. This will display the Unit of 
Purchase and Consumption UOM etc. Enter the values as appropriate. 
 

9. Click Save, then click Add to enter the cost and sell values. 
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Brands 
Allows specific material brand names to be defined that can later be specified against the material item. 

Click Brands to open the Material Brand window. 

 

Example Paper Material 
Below is an example of how paper is entered as a material. It is the intention that paper is entered in generic 
terms and does not need to be stock item specific, as the pricing is intended for commercial purposes. If 
customers require a specific paper type, then the estimate should include a custom paper type for the 
components. 

Group 

 

Type 
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Item Detail 

 

Consumption and Costs 

 

Using paper entered in Inventory Maintenance for Estimating 
To negate the need to have to update both Estimating and Inventory data, you are now able to configure the 
system so that the Inventory data is used to calculate costs and prices of paper in Estimating. 

Important This functionality cannot be reversed therefore if the synchronization has been performed you 
are not able to restore the Estimating Maintenance data for paper.  For estimates previously 
calculated using the paper data from Estimating Maintenance, the paper data (cost and price) are 
retained until the component requires re-calculation. 
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To begin working with the paper defined in Inventory rather than in Estimating, you need to review the application 
settings now in place and these now need to be defined. Application Setting id 1 for Inventory Maintenance 
needs to be set to 1 if you choose the option of paper from Inventory. 

Synchronize Paper Detail 

Open Inventory Maintenance and select the Stock Codes tab. The Sync All button is available when the above 
application setting is set to 1 (True).  This synchronizes the grade area id to the material type area id in 
Estimating. 

 

Note The Sync All function will remove all paper defined in Estimating Maintenance and copy the paper 
defined in Inventory Maintenance across to Estimating Maintenance. 

Paper Suppliers 

Additional information is now stored against the Paper Suppliers within Inventory Maintenance. 

 

This enables you to enter the Stock Code, From Date, Unit of Purchase and From UOP. 

 

Ranges are defined by a start point only, where the quantity range is the highest start point that is lower than the 
quantity to be purchased.  Existing data will be modified to have a quantity range starting from 0 and a date 
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range starting from the earliest date entered into Estimating Maintenance, so all existing cost data will be valid 
for any date or quantity. 

When the application setting for paper synchronisation is set to 1 (True), for a supplier item you can enter the 
Price, Pack Sheets and Min Sheets for a stock item.   

Note The sheets value will only accept input for a sheet type stock.  

With the application setting above set to 1, when you select the Paper group within the Material window. The 
type, item, consumption fields are no longer available for editing. 

Prior to applying the Sync All, the paper data within Estimating Maintenance displays as below: 

 

However, following the synchronization, the Item changes to display the stock code. 
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Process Flow  

Synchronise All 
There is an initial check for links between Inventory and Estimating grades: 

• If no link, the paper within Estimating Maintenance is flagged as dead. 
 

• If there is a one-to-one link, then the paper defined in Estimating Maintenance remains flagged live and 
the link remains. 
 

• If a there is a one-to-many link, then the paper defined in Estimating Maintenance is flagged dead and 
the Inventory links are removed. 

For each Grade (with child Items) in Inventory Maintenance, which does not currently have an entry in Estimating 
Maintenance, then upon the synchronization this item is created as a Material Type within Estimating 
Maintenance. 

• For each child Item an entry is created as a Material Item in Estimating Maintenance. 
 

• For each child Item there is a check performed for a matching Brand in Estimating Maintenance.  If it 
doesn't exist one will be created, otherwise the application will use the existing brand. 

When any paper data is saved in Inventory Maintenance, it will be synchronised with the equivalent tables in 
Estimating for grade, brand and stock code, and costs data for each stock code. 

The Sheet size table in Estimating Maintenance will be automatically populated from discrete sizes defined for 
sheet fed stock, if they do not already exist.   

Note Existing sheet sizes will not be deleted, but new ones will be added if found. 

Ink  
Next is an example of how ink would typically be specified. 

Group 
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Type 

 

Item Detail 
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Consumption and Costs 

 

Here, the consumption has been set to square meter’s and purchased by the kilo.  The consumption ratios have 
been set for 3,250sq meters of coverage per kilo on coated paper and 3,000 sq meters of coverage on un-coated 
paper.  When estimating calculates the total area of ink required for a job it will use this ratio to convert the 
amount to a weight and then in turn use the weight to calculate the cost and price. 

Example 1 

Specification 

Color 4/4 

Coverage 45% 

Sqm 
Coverage per 

kilo 

3,250 

Cost per kilo Black £1.37, Cyan, Magenta and Yellow £1.70 

Gross 
Impressions 

85,769 

Configuration 16pp 1 up (8 pages to view) 

Trim Size 297 x 210mm portrait 

Head trim 3mm 

Foot trim 4.5mm 

Foredge 7.5mm 

Total Size 304.5 x 217.5mm 
 

Calculation 

Area depth x width (inc trims) x sides x coverage x pages to view x gross impressions (exl paper 
waste) 
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Calculation 

Amount (kgs) Area / conversion ration 

Ink Cost Amount x cost rate 
 

Example 

Area 0.3045 x 0.2175 x 2 x 45% x 8 x 85,769 = 40,898.64 sqm 

Amount (kgs) 40,898.64 / 3,250 = 12.58 kilos per color 

Ink Cost 
Black 

12.58 x 1.37 = £17.23 

Ink Cost 
(C/M/Y) 

(12.58 x 1.70) x 3 = £64.16 

Total Ink Cost 17.23 + 64.16 = £81.39 

Cartridge Costs 
To account for digital inks, cartridge sizes and consumption rates can be entered to allow for the variation 
against a resource to be entered. 

Material Repricing 
The Material Re-Price window provides you with the ability to change existing material pricing or add new prices 
based on a new date range in one update rather than per each individual item. 

Click Material Re-Price from the Material window to open the Material Re-Price window. 

 

You can filter the list of items by Site, Material Group, Material Type and Item and Press Type.  
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To see the current values, you need to select one Item and click Show Current Values. 

 

Once you have identified which items you wish to reprice, you can select the Effect From Date and Effective To 
Date and then choose to change the sell price values either by an amount or percentage of the current value. 

If you wish to change existing values, we recommend that you select the Create restore point and enter a name 
for the restore point in the field provided so that if you need to undo any changes made, you can click Restore 
Points to open the Material Cost Restore window and select the restore point you wish to go back to. 

 

The Apply to Cost and Maintain Markup % checkboxes will be selected by default, however you can select the 
Apply to Price if you wish for both values to be updated, for example there is currently no difference between 
cost and price for the material item. 

Material Calculations  
Material calculations are entered in groups and for each group multiple methods can be entered. This allows you 
to configure your own set of rules or parameters to calculate the open size of a component or area, length, cut 
off, No Up of material associated with a press or finishing operation.  
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Material Calculation Group 
To open the Material Calculation Group window, click Material Calc… from the Miscellaneous tab. 

 

Click Add to create a calculation group. 

Field Name Description 

Group Enter a 5 character ID group code. This field must not be blank. 

Description Enter the name of the group. This field must not be blank. 

Calculation Method  Click to open the Material Calculation Method window. 

Add  Adds a new group entry. 

Delete  Upon confirmation removes the highlighted group and its associated methods. 

OK  Closes the window. 
 

Material Calculation Method 
For each group you can enter a multiple methods. 
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Field Name Description 

Method 5 character ID method code. For existing methods this field is unavailable for 
editing. The code is entered via the Material Calculation Parameter window. 

Description Name of the method. For existing methods this field is unavailable for editing. The 
code is entered via the Material Calculation Parameter window. 

Calculation Parameters  Click to open the Material Calculation Method window for existing methods. 

Add  Opens a new Material Calculation Parameters window to add a new record. 

Delete  Upon confirmation removes the highlighted method. 

OK  Closes the window. 
 

Material Calculation Parameters 

 

Field Name Description 

Method Enter a 5 character ID method code. This field must not be blank. 

Description Enter the name of the group. This field must not be blank. 

Head Margin Enter the Head trim to be included in the calculation (if appropriate).  

Foot Margin Enter the Foot trim to included in the calculation (if appropriate). 

Foredge Margin Enter the Foredge trim to be included in the calculation (if appropriate). 

Fixed Depth Enter the fixed depth to be calculated irrespective of the component or material 
area.  If greater than 0 then this will override all other depth parameters. 

Fixed Width Enter the fixed width to be used irrespective of the component or material area.  If 
greater than 0 then this will override all other width parameters. 

Page Width Multiplier Enter to multiply the calculated width by the entered factor.  

Page Depth Multiplier Enter to multiply the calculated depth by the entered factor.  

Spine Select this checkbox if you need to calculate and include the spine width in the 
overall width.  
If the selection is clear then the Binding Build Up %, Rib Width, Label/Cloth Caliper 
and End Board Caliper will be ignored in the overall width calculation. 

Binding Build Up % Enter a percentage value to increase the calculated spine width to account for 
bulking. 

Rib Width Enter an additional trim in millimeters that is to be added to the calculated spine 
width. 
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Field Name Description 

Rib Width Multiplier Enter the number of rib width trims to be added. 

Label/Cloth Caliper 
Allowance 

Enter the average caliper of the label or cloth to be included in the calculation of the 
spine width. 

Label/Cloth Multiplier Enter the number of times the label/cloth width needs to be included in the 
calculation. 

End Board Caliper 
Allowance 

Enter the average caliper of the end board to be included in the calculation of the 
spine width. 

End Board Multiplier Enter the number of times you need to include the end board width. 

Flap Width Enter the width of the an additional flap to be added to the overall width calculated 
for the component. 

No of Flaps Enter the number of times the flap width needs to be included. 

Additional Panels:  

Back Side Enter the extra panel width to be added to the width of the component. 

Back Top Enter the extra panel depth to be added to the depth of the component. 

Back Bottom Enter the extra panel depth to be added to the depth of the component. 

Front Side Enter the extra panel width to be added to the width of the component. 

Front Top Enter the extra panel depth to be added to the depth of the component. 

Front Bottom Enter the extra panel depth to be added to the depth of the component. 

Cancel  Closes the form without saving the latest changes. 

OK  Save the latest changes and closes the form. 
 

The following diagram shows how the trims and panels etc are applied to the component to determine its open 
size. 

 

If the calculation method is entered against component or press extra material then the parameters are added to 
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the flat open size according to the dimension of the component and the chosen fold type or catalog layout. 

If the calculation method is entered against a finishing material then the parameters are applied to the finished 
product size as entered in the enquiry. 

Example Using Calculation Method: 

Specification 

Product Trim 
Size 

297 x 210mm portrait 

Pagination 4pp  

Fold Style Section Fold (pages across 2, pages down 1) 

Component Dust Jacket  

Text section 320pp on 60gsm paper on caliper of 0.15mm 
 

Note In order to calculate the correct spine width the thickness of the remaining components are surmised 
using the paper caliper.    

Calculation parameters are entered as follows:  

 

Open size calculated as follows:          

First calculate the basic open size using the same formula and rules (based on fold type) as above but using the 
trims from the method. 

Calculation 

Open Depth (Depth + Head Trim + Foot Trim) * pages down 
(297 + 5 + 5) * 1 = 307 

Open Width (Width + Foredge Trim) * pages across 
(210 + 5) * 2 = 430 
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If the Spine checkbox is selected, the system will then calculate the spine width and add to the open width. 

Calculation 

Spine Width ((Pages of Text / 2) * Calliper) * (1 + Binding Build Up %) + (Rib Width * Multiplier) + (Cloth 
Calliper * Multiplier) + (End Board Calliper * Multiplier) 
((320 / 2) * 0.15) * (1 + 0.025) + (2 * 2) + (0.2 * 2) + ( 2 * 2) = 33.00 

Open Width (Width + Foredge Trim) * pages across 
(210 + 5) * 2 = 430 

Width so far 430 + 33.00 = 463.00 
 

Add on flaps and additional panels to depth and width.      

Calculation 

Open Depth Open Depth + (Greater of Front Top or Back Top) + (Greater of Front Bottom or Back Bottom) 
307 + 0 + 0 = 307 

Open Width Open Width + Front Side + Back Side + (Flap Width * No of Flaps) 
463.00 + 0 + 0 + (50 * 2) = 563.00 
 

Open Size of 
Dust Jacket 

307 x 563mm 

 

Setting Material Calculation Method Defaults 
Once calculation methods have been entered you can enter defaults against Material Items, Press Extra 
Materials, Finishing Materials and Bill of Routing Components.  Entering the default improves the automation 
process. 

Material Item Default 

You enter the Calc Group and Calc Method at the Item level for a material. When this material is included in the 
estimate or order, the calculation will use the default values entered. 

 

Press Extra Material Default 

A material can be added to a press extra and for the material, you can enter the Calculation Group and Method. 



160 l EFI Technique 5.4 | System Admin for Sales Enquiries, Estimating and Quick Pricer 5.4 User Guide 

 
 

 

Click Press Extras from the Miscellaneous tab, select the Press Extra Description and click Materials. 

 

This will open the Press Extra Materials window. 

 

Entries that have been added against the Press Extra Material item that are associated to a configuration will 
automatically be included in the calculation of the estimate or order, using the default method entered.   

Finishing Material Default 

A material and subsequent calculation group and method can be entered against a finishing style, so that when 
the finishing style is included in the estimate or order, it will automatically be included in the calculation. 
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Open the Finishing Styles window from the Miscellaneous tab, select the Finishing Style and click Materials. 

 

The Finishing Materials window will open. 

Click Add to enter the Material. If a Calculation Group and Method have been entered against the Material this 
will automatically be entered when the material is added to the finishing style. 

Material entries that have been added against the finishing style will automatically be included in the calculation 
of the estimate or order, using the default method entered, when the finishing style is included. 

 

Note Materials and their associated calculation groups and methods can also be manually added to each 
estimate or order if they are not included automatically in the methods detailed above. 
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Within a Product Template you can also include a Calc Group and Calc Method. For further information see the 
Product Template chapter later in this guide. 

Packing Quantities 
Click Packing Quantities to open the Packing Quantities window. The data will be automatically populated upon 
installation. The entries allow the application to calculate the number of copies per carton (if no packing quantity 
is specified in the estimate). Only values entered will be calculated as pack quantities within Estimating, unless 
specified otherwise by the estimator. For example, the system may calculate that 54 copies of a product may fit 
in a box. As there is no entry for 54 as a Suitable Packing Quantity, the application will choose the next lowest 
available option, in this instance, this would be 50.  

For details on how to configure Advanced Packing see the System Admin User Guide for Order Management 
5.4. 

RFQ (Bought In) Config 
Request For Quotation (RFQ) module is a licensed module available within the Estimating application. RFQ 
allows users to send enquiries to Suppliers for outsourced elements such as printing, finishing etc., direct from 
within the Estimating module. The Supplier will receive an email notifying them of the enquiry and can provide 
their prices directly back in to the estimate (see the Estimating User Guide for full details). 

RFQ Config with Estimating Maintenance provides the facility to maintain the various codes, menu selections 
and templates to be used with the RFQ module.  

Suppliers will also need to have access to the Customer Portal module in order to provide their responses and 
pricing back to the Estimating application. 

Click RFQ Config from the Miscellaneous tab to open the RFQ Configuration window. There are a series of 
windows that allow you to enter codes which can be associated to the request for quote submitted to the 
supplier. 

 

Field Name Description 

Status Codes This provides a maintenance area where standard RFQ status codes can be 
adjusted. Each status code has a unique sequence number, and you can change 
the User Description. 

Data Codes You can configure your own set of data codes and allows for a selection of data 
formats to be entered when creating the request for quote, for example ISDN. 

Data Status The Data Status is a configurable list of options which users can select to enter the 
current status of the Data for the enquiry, for example, is it available now, available 
next week, not known etc. Typical entries are Awaiting Data, Data Received. 

Finish Codes Enter standard finishing descriptions that will be included in the RFQ. For example, 
Trim to Size, Trim to Size and Stitch. 
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Field Name Description 

Pack Codes Enter the list of standard packing descriptions that you wish to be available in the 
RFQ, for example, Bulk Pack on Pallet. 

Delivery Codes Enter the list of delivery descriptions that you wish to be available in the RFQ, for 
example Delivery Back to Site. 

Supplier Codes When an RFQ has been sent, it will be assigned a status for example, the RFQ has 
been sent but not responded to by the supplier, this will be assigned the status of 
‘Awaiting Response’. 

These are system defined statuses. The description can be changed if required but 
all other areas should be left untouched. 

It is not possible to add in additional status options to this list. 

Pricing Codes When the RFQ has been sent to the Supplier, the RFQ will also be assigned a 
status. If the supplier is still to provide prices, their response status will be entered 
as ‘Awaiting Pricing’, if they responded with prices, the status will be set to ‘Priced’. 

The Supplier can also Decline the quote so statuses are provided for this scenario. 
Again, these are system defined statuses that cannot be deleted or added to. 
However, the User Description field can be changed if required. 

 

RFQ Template 
Part of the RFQ module is the use of templates to provide a quick and easy way to populate the Supplier 
enquiry. The templates utilize the data set up in the previous pages and allow the user to select the most 
appropriate template for the supplier enquiry type that they wish to create and send.  

Multiple template options can be created. There is no limit to the number allowed. Using the Data menu, new 
options can be created and then opening the Template Details window, enter the default entries to be set when 
using the template selected. 

Creating an RFQ Template specific for Press of Finishing 

1. Click Miscellaneous tab. 
 

2. Click RFQ Config button. 
 

3. Click RFQ Template button. 
 

4. Click Data > New Row. Enter a Short Code and template name. 
 

5. Select the template. 
 

6. Click Template Details. 
 

7. Click either the Print or Bind option (as indicated below). The application will open the relevant templates 
based on the type of request being generated. 
 

8. Enter the default information you wish to appear in the Data Type, Finishing, Packing and Delivery fields. 
The selection is based on the options added for each of the codes (see above). 
 

9. Enter any Additional Info to support the RFQ. This information can be added when the RFQ is opened 
within the estimate. 
 

10. Enter the number of days from the date the RFQ was created to provide the date when the supplier should 
respond with prices in the Response Date field. 
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11. Enter free type Notes that can used with either a default data set within the template or entered by the user 
when creating the RFQ. 
 

12. Click OK to close and Save. 
 

13. Click Cancel if the changes are not to be saved. 

  

Default Suppliers 
Click Default Suppliers to be able to enter a default supplier against an RFQ Template. For the supplier to be 
available for selection it is necessary that the outworker is already entered within the Outwork tab in Estimating 
Maintenance. This prevents you from being able to select an invalid supplier.  

The list of suppliers will need to have the Can Bind and or Can Print selection entered on the Outwork tab, and 
the list of suppliers available within the Default Suppliers window is dependent on the Print, Bind option selected 
within the RFQ Template Details window. For example, if you’ve entered Print in the Template, the suppliers 
available for selection within the Default Suppliers window will be those that have Can Print selected on the 
Outwork tab. 

This is particularly useful if you have specific suppliers that you deal with for different types of work. Typically, a 
template will be created for each type of work required for example, print, laminating, binding etc. Each product 
and or template type can be assigned with a specific set of supplier records. These suppliers will receive a copy 
of the RFQ when it has been created and sent.  

Note The suppliers must be present within the company database before they can be selected here. Also, 
prior to sending the RFQ, the default supplier list can be edited or added to, it is not a fixed list. 
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Field Name Description 

Supplier A filtered list of supplier records based on the Print and Bind options selected in the 
template and the Outworker tab. 

Recipient A filtered list of contacts available for the supplier record selected. 

Method There are two methods for sending the RFQ to the supplier; Email or Post. If Email 
is selected, an email can automatically be sent to the supplier with full details of the 
RFQ. If Post is selected, the email will not be sent and the user will need to ensure 
that the supplier receives a copy of the RFQ by other means. 

Notes Free type field for any type of note that needs to be record against the supplier 
selection. 

Setting up Suppliers in MIS Console to work with Bought In 
In order for your suppliers to view and respond to the request for quotations that have been sent from Estimating, 
they will need to be set up as users so that they can gain access to the Customer Portal aspect of MIS Console. 

Adding suppliers to the Users in MIS Console 

1. Open MIS Console and browse to My Information > Users. 
 

2. Click New from the toolbar. 

 

3. The New User window will open. 

 

4. On the Login tab, enter the Login Name and Password. 
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5. Click the Details tab. Enter their user Name as it will appear when they login to the Customer Portal, 
and select a Profile Group. For more details on Profile Groups see the MIS Console User Guide. Enter 
Company in the Role field and enter the supplier’s company name in the Company field. 

 

6. Click the Address tab and enter a site location. 

 

7. You can choose to enter the remaining address information as required.  
 

8. No other information is required for the RFQ module to be successful, so click Save to confirm the user 
details and close the New User window. 
 

9. The supplier will now be able to login to the Customer Portal to view and respond to any RFQs that may 
have been sent. 

Further details on how the supplier uses Customer Portal is included in the MIS Console User Guide. 

Reprice Profiles 
The Reprice profiles are used with the licensed Quick Pricer module and online Quotation re-pricing only. 

Reprice Profiles are created to establish the authority that a user has within the above applications to re-price 
different quotation elements. 
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Multiple profiles can be created, for example Sales Executive, Sales Directors, with each profile having a 
different level of permission and access to the pricing options. 

Against each profile, the standard Estimating cost groups are provided. If a user within the profile is allowed to 
re-price specific groups, enter Yes. If they are not allowed to re-price certain groups, enter No. 

1. Click Reprice Profiles on the Miscellaneous tab to open the Reprice Profile Category window. 

 

2. Click Data > New Row to create a blank row and enter the Description. 
 

3. Enter the Category that the re-price profile is based on. The options available are Total Sales Value, 
Added Value, Contribution or Profit. 
 

4. For each pricing group enter Yes or No if the group is available for re-pricing by a user who is linked to 
this re-price profile group. 
 

5. For each profile, there is a second level of authority. Click Reprice Profile… to open the Reprice Profile 
window.  
 

6. Click Data > New Row to enter a date and value range. Enter the – Shift % and + Shift %. This controls 
the value that the user can adjust the prices by a plus or minus adjustment. 
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7. After the Reprice Profiles have been entered, these need to be assigned to individual User Profile 
Groups within Users & Profiles. 

 
Note If you need different Reprice Profiles to members of the same Profile Group you will need to create new 

Profile Groups in Users and Profiles to manage this. 

Ancillary Items 
Ancillary items are used within Estimating, Contract and Order Management within the Ancillaries tabs. They are 
used to specify prices to be included in the estimate that cannot be accounted for elsewhere. 

Click Ancillary Items from the Miscellaneous tab to open the Ancillary Types window. 

 

The ancillary types are available and it is also possible to create additional categories within this window entering 
a three digit type reference and description. 

Note The pre-defined system categories should not be deleted. 

For each ancillary type you can enter ancillary codes to further distinguish the additional cost and charge of the 
ancillary item. 
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Select the Ancillary Type and click Codes to open the Invoice Type Revenue Link window.  

 

In addition to specifying the basic code and description there is the ability to identify the revenue analysis link for 
invoice integration. Analysis Link and Account Codes are entered in Order Maintenance and can be entered at 
ancillary code level. For further information see the Order Management 5.4 User Guide. 

The JDF checkboxes are used to link pre-press proof and plate codes for the JDF Pre-Press integration so that 
activities which need to be charged and included in the Sales Invoice can be identified and subsequently create 
an ancillary line item within the order. These should only be selected for the appropriate codes and only one 
ancillary code can be selected from all of the ancillary codes.  

You can enter a Tax Code for an ancillary code for use with the Invoice application. When a Tax Code is entered 
with an ancillary code, when this code is entered within the order, when the invoice is generated, this will 
automatically populate the line item with this tax code. For example, a delivery item may attract a 0 % tax rate. 
Enter the appropriate tax code to the ancillary code.  

 

When the invoice is produced the ancillary line item has the appropriate tax code automatically entered. 

 

If the ancillary code attracts a financial discount you need to select the Fin Disc check box. Financial Discounts 
are included during the invoice generation process. See the Order Management 5.4 User Guide for further 
details. 

If you wish to automatically convert the pre production estimate values to actuals (application setting id 107 for 
Order Management), when changing the status of the order, you need to ensure that the Job Cost Type and 
Job Cost Code fields are entered. See the Job Costing User Guide for further details. 
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Market Rates 
Calculating the sell price within the Estimating application can be achieved by a variety of ways such as Cost 
plus mark up %, using Sell Rates or price from a Contract price list. Another option is to calculating using Market 
Rates. 

Market Rates provides you with the ability to enter market place prices for different print sections or products. 

For example, to be competitive on pricing, you know that for a 32pp A4 section, £20.00 per 1,000 copies, (not 
including materials), is the pricing level at which you need to sell the job. 

These values can be configured and then assigned to the press configurations. If a press configuration is then 
selected within Estimating, instead of applying the hourly sell price for the section or product, the market rate 
value will be calculated instead. Using this method allows you to configure all of the different products that you 
produce along with the pricing structure that you need to apply to be competitive. The idea being that when the 
estimate is fully calculated, your print elements will be available for sale at the correct level and should require 
minimal repricing. 

Market Rate Profile 
Click Market Rates on the Miscellaneous tab to open the Market Rate Profile window. You can add new entries 
can for the various options that you would like to configure.  

In the example below, the entries are very specific to A4 size (297 x 210mm). However, they can be left with very 
generic names with the actual size configurations defined within the Profile Pricing area. 

 

To configure the actual Profile Pricing, select the relevant line entry and click Profile Pricing. 

Market Rate Pricing 
This form and the entries contained within it provide Estimating with the information it requires to be able to apply 
the pricing structures within the Estimates. 

With this form, multiple entries can be created to allow for variances in date range, size, paper weight, colors, 
quantity etc. This gives the freedom to define the pricing for the selected product in as much detail as required. 

Please note – the pricing information entered is for the printing of the product only i.e. the machine time and does 
not include any material prices (inks, paper etc), these will be added on during estimate calculation using the 
seasonal rates defined within Estimating Maintenance. 

 

Field Name Description 

Description Enter the finishing style from the list of options. 

Date From / To Enter the date range for which the Market Rate is valid. The delivery date in the estimate 
will need to be between these two dates to be included in the calculation. 

Depth From  Enter the minimum depth of the finished page size in millimeters for which the Market Rate 
entry is valid. 



 Estimating Maintenance | System Admin for Sales Enquiries, Estimating and Quick Pricer 5.4 User Guide l 171  

 
 

 

Field Name Description 

Depth To Enter the maximum depth of the finished page size in millimeters for which the Market Rate 
entry is valid. 

Width From Enter the minimum width of the finished page size in millimeters for which the Market Rate 
entry is valid. 

Width To Enter the maximum width of the finished page size in millimeters for which the Market Rate 
entry is valid. 

Paper From Enter the minimum paper weight in grams for which the Market Rate entry is valid. 

Paper To Enter the maximum paper weight in grams for which the Market Rate entry is valid. 

Colors Front 
From 

Enter the minimum number of colors on the front of the sheet/web for which the Market 
Rate entry is valid. 

Colors Front To Enter the maximum number of colors on the front of the sheet/web for which the Market 
Rate entry is valid. 

Colors Back 
From 

Enter the minimum number of colors on the back of the sheet/web for which the Market 
Rate entry is valid. 

Colors Back To Enter the maximum number of colors on the back of the sheet/web for which the Market 
Rate entry is valid. 

Quantity From Enter the minimum quantity in copies, for which the Market Rate entry is valid.  

Quantity To Enter the minimum quantity in copies, for which the Market Rate entry is valid. 

MR Price Enter the Set Up/Make-Ready price for the Market Rate entry (expressed as the value in 
your local currency). 

FO MR Price Enter the Follow On Set Up/Make-Ready price for the Market Rate entry (expressed as the 
value in your local currency). If multiple print runs of the same section/print item are being 
produced back to back, the first will attract the MR Price, each subsequent run will attract 
the FO MR Price. 

Price Per 1000 Enter the price per 1,000 copies for the Market Rate entry (expressed as a value in your 
local currency based on 1,000 copies). 

Plate Change 
Price 

Enter the price per plate to be applied if versions/plate changes are being used within the 
estimate where the Market Rate entry is being used (expressed as a price for each plate to 
be changed in your local currency). 

 

When you have entered the Market Rate profiles, these must then be assigned to individual press configurations 
so that they can be included in the estimate calculation.  
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Open the Press Configuration window, select the Market Rate profile and save the configuration. 

  

Click   to open the Market Rate Profile window, thus negating the need to close 
the configuration window and select the Miscellaneous tab > Market Rate, if you need to amend the values. 

Stock Webs 
Estimating calculates the web width for a print section using the finished trim size of the component, plus number 
of pages across the web plus trims.  

If you have entered application setting id 16 for Estimating as 1 (True), this introduces the Stock Webs option, 
that will then override the calculated web width and replace with either an exact match from Stock Webs or will 
select the next available size (by rounding up). As a consequence, you will need to ensure that valid Web Width 
sizes are entered. 

For example, Estimating may calculate an 867mm web width. If Stock Webs is active, an 867mm may not be a 
stock option and therefore no match is found. However, a stock web width of 870mm may be present. Therefore, 
Estimating would use this value instead and calculate the paper price accordingly. 
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The stock webs are site and press type specific, for example one site may have different stock web sizes to 
another site in the group, or the same site may have varying stock web sizes based on press type, for example, 
gravure, web or wide format.  

 

Standard Cut Offs 
Note For use with Reel to Sheet press configurations only. 

If your sheetfed press is able to accept reel fed paper, you can enter standard cut off dimensions.  

In theory, a Reel to Sheet press can produce a cut off of any dimension between the minimum and maximum cut 
off capability of the press. However, in reality the cut off dimension is governed by gearing mechanisms and 
other factors. 

EFI Technique’s standard calculation for reel to sheet would be to calculate the optimum cut off to the exact 
millimeter required. For some resources, this may be ideal. However, the need to round up the optimum cut off to 
match with gear settings requires the need for Standard Cut Offs to be present. 

Click Standard Cut Offs from the Miscellaneous tab to open the Standard Cut Offs window. Click Data > New 
Row to enter the list of standard options you wish to use. 
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There is no limit to the number of entries within the standard cut offs list. Simply enter those that are pertinent to 
your reel to sheet press resources. If your company is part of a group that has reel to sheet capable presses at 
different sites, standard cut off values can be set at site level using the drop down list within the Site column. 

 

For example, if the optimum cut off is calculated as 494mm, this value will be compared to the Standard Cut Offs 
list to see if there is a matching entry. If a match is not found, the cut off will be rounded up to the next nearest 
match. Using the example data in the image above, there is no entry for 494mm so in this case, the cut off will be 
rounded up to 500mm. 

Note When a standard cut off entry is applied, this will increase the total length of paper required as the 
impression depth is being increased. 

Quick Price Filter 
The licensed Quick Pricer module will always calculate the cheapest route and price based on the specification 
of the enquiry and available configurations entered. However, you may wish to manage which routes are 
calculated and therefore included in the estimate and as a consequence there are filters that can control which 
routes are calculated. 

1. Application setting ids 22 and 23 for Estimating control the minimum and maximum quantities for which 
Quick Pricer routes will be calculated. 
 

2. On the Press tab, you can select which presses are to be available for inclusion in the calculation. 
 

3. For each press configuration, you can enter which configuration is available for inclusion. 
 

4. In addition to the above, you can filter based on product, then press, then configuration. This is 
managed by the Quick Price Filter on the Miscellaneous tab. For example, for certain products that you 
quote for there may be presses and press configuration options that you may wish to use in the 
Estimating application only. You will need to ensure that application setting ids 71 and 74 for Estimating 
is entered as 1 (True). 

Quick Price Filter is built on a three tier structure: Products > Press Resources > Press Configurations. 

Products 
Click Quick Price Filter to open the Quick Price Filter window. The purpose of this is to allow you to define the 
section breakdown options that can be used during Quick Price Calculation. 
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Typically, options should be present for 4pp covers, 6pp covers, varying text pagination options. Our data sample 
below shows 4 different section breakdowns that wish to use within Quick Pricer. Therefore, for a text 
component, we are not allowing for any other section size to be defined other than 16pp or 32pp for perfect 
binding with other criteria such as quantity, size, paper weight and paper coat also entered. 

 

There is no limit to the number of entries that can be entered in this window. The only criteria is that values are 
entered in each of the fields so that Quick Pricer can correctly reference them and apply them where necessary.  

Field Name Description 

Cover Enter Yes or No to indicate that the filter applies to components entered as a cover. 

Description Enter the name of the line entry for information purposes. 

Pagination Enter the number of pages that the filter is valid for. 

Quantity From Enter the lowest quantity (in copies) that the filter is valid for.  

Quantity To Enter the highest quantity (in copies) that the filter is valid for. 

Fin Style Enter the primary finishing style that the filter is valid for.  
Note      Multiple finishing styles cannot be selected. 

Depth From Enter the minimum depth of the product trim size (in millimeters) that the filter is valid for.  

Depth To Enter the maximum depth of the product trim size (in millimeters) that the filter is valid for. 

Width From Enter the minimum width of the product rim size (in millimeters) that the filter is valid for. 

Width To Enter the maximum width of the product trim size (in millimeters) that the filter is valid for. 

Weight From Enter the lowest weight (in grammage) that the filter is valid for. 

Weight To Enter the highest weight (in grammage) that the filter is valid for. 

Paper Coat Enter the paper coat that filter is valid for, for example, gloss, matt etc. 
Note    Multiple Paper Coat entries cannot be selected. 

Press  
When you have entered the product type entries you can now enter the press filter for each of them.  

Select the product filter and click Press Filter… to open the Press Filter window.  
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The Press Filter window will display a full list of all the press resources entered as Live on the Press tab. 

 

Enter Yes, within the Included field, to allow a press resource to be considered to produce the product when 
performing a Quick Pricer calculation. 

Note At least one press resource must be included for the product filter to be included in Quick Pricer 
calculation. 

Config  
For each press which has been included, you need to filter the configurations. Select the press and click Config 
Filter…. 

Enter Yes, within the Included field, to allow a press resource to be considered to produce the product when 
performing a Quick Pricer calculation. 

The list of entries provided in this screen are press configurations that are valid for the press selection that are 
capable of producing the product entered in the main Quick Price Filter window.  

 

Cartridges 
The Cartridges window allows you to create a master list of the various ink cartridge options to be available for 
selection and when entering the cartridge ink costs within the Material window and on the Press tab for Wide 
Format type presses. 
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Reasonable Section Breakdown 
The Reasonable Section Breakdown is how the application determines the section breakdown of the component 
pagination in order to offer valid routes for selection.  It is necessary to review the entries, that are available as 
part of the install, when configuring your estimating data.  

To access the entries, click RSB from the toolbar in Estimating Maintenance. 

 

The Reasonable Section Breakdown window details how particular paginations are broken down by printable 
sections, for example, 1 x 96pp can be printed as 1 x 96pp, or 1 x 64pp + 1 x 32pp, or 3 x 32pp, or 6 x 16pp etc. 
Each possible breakdown has a unique entry (see below).  

Note If no reasonable section breakdown exists for particular component pagination, then during the 
calculation process the estimator will receive a message detailing that no routes were calculated. 

 

 

Field Name Description 

Section 
Pagination 

Enter the component pagination that will be entered in the enquiry and estimate. 



178 l EFI Technique 5.4 | System Admin for Sales Enquiries, Estimating and Quick Pricer 5.4 User Guide 

 
 

 

Field Name Description 

Option Enter the sequence number to determine the order that the options are presented to the 
estimator when selecting a route.  For example, a component pagination that has 12 
possible section breakdown options, you enter 1 against the most preferred method of 
production.  

 
In the above example, the estimator will be presented with the 64pp & 32pp option 1, 
following by 2 x 48pp etc. 

Sequence Enter the sequence that the section breakdown will appear to the user within option the 
sequence of the printable sections that make up the section. 

 
In the above example, the estimator will see the results for the 64pp first and the 32pp 
second. 

Number Like this 
(NLT) 

Enter the number of like printable sections. 

 
In the above example, Number Like This is 2 to represent the 2 x 28pp. 

Printable Section Enter the actual printable section pagination. 

Description Enter the RSB description that will be presented to the estimator when selecting routes. 

Type Enter the press type the section breakdown is valid for. The options are as follows: 
A = All; W = Web only; S = Sheetfed only; G = Gravure only; D = Digital only; R = Reel to 
Sheet only; F = Wide Format only. 

 

To aid with filtering the long list of entries, if the pagination is known, click Filter to return only those entries of 
interest. 

 

Enter the pagination and click OK. 
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You will be presented with a list of possible section breakdowns for the component pagination. 

 

Likewise, click Data, and select Incorrect RSB’s. This will return a list of entries highlighted in red where the 
something is incorrect, for example, the total pagination of the section breakdowns does not total the value within 
the Section Pagination field. 

 

An entry must exist for all component paginations that are required in both Estimating and Order Management. 

 



180 l EFI Technique 5.4 | System Admin for Sales Enquiries, Estimating and Quick Pricer 5.4 User Guide 

 
 

 

MIS Console 
MIS Console provides you with the ability to create Sales Enquiry templates that are submitted to Estimating and 
also offer the ability to generate a Quick Price either based on the Estimating standards or from a Contract Price 
List. 

RFE Template Set Up Process Flow 
We recommend the following sequence of configuration when creating enquiry templates for commercial 
quotations. 

 

For information on how to create the BOR see Bill of Routing chapter earlier in this guide. 

Creating a new Enquiry Template 
MIS Console > Maintenance > Estimating > RFE Template Maintenance enables you to design multiple 
layouts of enquiry forms. These forms can be used instead of the standard enquiry form and can be designed to 
be specific to the different products available in your organization. 

You can choose to Create Template (using the standard template to customize you own style) or Copy to create 
a new template using an existing template. 
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Click Create Template and the RFE Template Header Properties window will open. This window allows you to 
enter the main properties for the template. 

 

Field Name Description 

Description Enter the name of the template. 

Finishing Style Enter the finishing style for the template. 

Contract Pricing Select if the template can be used for Contract Quick Pricer. When selecting the enquiry 
template to enter the enquiry, the Price from contract check box will be selected by 
default. However the selection can be cleared before proceeding. 
If this checkbox is selected the Ancillary Contract option below will be unavailable. Also,  

Style Sheet Enter the default template that is to generate the quotation letter if using Quick Pricer. 

Def. Sent How Enter the default method of how you wish to send the quotation letter. 

Default Currency Enter the default currency for the template. 

Ancillary 
Contract 

Enter a contract so that ancillary options can be selected in the enquiry when using Quick 
Pricer. This field is unavailable if the Contract Pricing check box is selected. 

Show Depth, 
Width & Fin Style 

Select the checkbox if you wish for the Depth, Width and Finishing Style to be visible in the 
template. 

Header Rows Enter the number of Header Rows to be available in the template. Header rows include 
information such as Title, Depth and Width, Delivery date, quantities. 

Component 
Rows 

Enter the number of Component Rows to be available in the template. Component rows 
include information particular to the component, such as pagination. Fold style, whether the 
component is supplied. 

Footer Rows Enter the number of Footer Rows to be available in the template. Footer rows allow users 
to enter additional information, such as packing, delivery, ancillaries. 
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Field Name Description 

Component 
Columns 

Enter the number of Component Columns to be available in the template. This determines 
the width that the component information spans across the template. 

No. of Web Rows Enter the number of Web Rows to be available in the template. This includes information 
such as ink and paper. 

Show 
Print/Bound 

Select if you wish to display if the components are printed and bound. 

No. of Finishing 
Options 

Enter the number of additional finishing options that the user can select when entering a 
new enquiry. If this option is selected you will need to ensure that the appropriate control is 
added to the template. 

No. of Insert 
Options 

Enter the number of inserts that the user can select when entering a new enquiry. If this 
option is selected you will need to ensure that the appropriate control is added to the 
template. 

No. of Default 
Webs 

Enter the number of webs that are to be displayed on the enquiry form. 

No. of Press 
Extra Entries 

Enter the number of press extras that the user can select when entering a new enquiry. If 
this option is selected you will need to ensure that the appropriate control is added to the 
template. 

Language Enter the template language. 
 

Click Save to save your changes and close the properties window. If you wish to modify the template after it’s 
creation, select the template from the Enquiry Template Maintenance window click Edit Template and when the 
template displays click Main Properties. 

Either after saving the properties when creating a new template or select to Edit Template from the Template 
Maintenance window the RFE Template Editor window will open. 

 

 

The template will display as per the settings entered within the Main Properties. From this window you can now 
include additional controls based on your preference of the level of information that you wish the users to enter 
when generating a sales enquiry. 
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Click Add Control to open the RFE Template Component Field Properties window. 

 

Select the Field that you wish to include. The options available are not customizable and if already in use will not 
be available for selection again, for example, you cannot have duplicate controls added to the same template. 

Field Name Description 

Field Select the field name. The fields available are system generated and cannot be 
customized. 

Tooltip Enter a tooltip for the field to aid users when entering the enquiry information. 

Area System generated information informing you of where, in the template, the control will 
appear. 

System Field There are various controls that are added by the application and cannot be removed; such 
fields will have this check box selected.  

Caption Override Enter the name of the field as you wish for it to appear, for example, you may wish to name 
the Pagination field as No. Pages (number of pages). 

Label Alignment Select whether the label (name) of the field is to be positioned in the Left, Middle or Right of 
the template. 

Label Position Enter the Row, Column and Span (width) of where the field label is to be positioned. 

Field Position Enter the Row, Column and Span (width) of where the control field is to be positioned. 

Mandatory Select the checkbox if the user must enter this information when creating a sales enquiry. 

Show Label Select the checkbox if you wish for the label for the field to also display.  
 

Click Save to add the control. If you wish to amend any controls already added, double click the field within the 
RFE Template Editor window. This will open the RFE Template Component Field Properties window for the 
control selected. 
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Linking Enquiry Templates to BOR Templates 
After the enquiry template and BOR templates have been created you now need to link the Enquiry Template to 
the BOR.  

Click Estimating Maintenance > Miscellaneous > Finishing Styles. 

Select the finishing style to which the template will be linked and click Product Template. 

 

The Enquiry Details window will open.  

Select Title Available to make the product template available within Quick Pricer and Sales Enquiries. 

 

Enter the RFE Template.  

Enter the Display Order to position of the template with the available lists of templates within Quick Pricer or 
Sales Enquiries in MIS Console. 

Within Quick Pricer and Sales Enquiries, graphical representations of the products can be viewed. To make the 
graphical representations visible, click Browse to select an image file.  

You can also associated a contract to the template within the Enquiry Details window. The Ancillary Contract 
field will present a list of options of contracts that have been entered as Standard at contract level. This enables 
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any ancillary items entered in the contract to be available for selection when creating the enquiry.  

Note Only one contract can be associated to the enquiry template. 

In the following example, a Contract has been linked to the Enquiry for the purpose of offering the ancillary 
options when the user is creating the enquiry 

 

Click OK to save the change and close the window. The Ancillary Defaults button is now available within the 
Product Template window. 

 

The Ancillary Defaults window allows you to enter any default ancillary items from the contract to be 
automatically included when the enquiry or Quick Pricer is added in MIS Console.  
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You can also choose to have the ancillary item included within the sell price, either as part of the Print, Finish 
and Delivery values, or broken out on the quote letter (select the Separate check box), or as an extra in addition 
to the total sell price (select the Optional check box). If you wish the ancillary item to be entered more than once, 
then enter the number of times it is to automatically be included within the No Of (number of) field. 

 

Note Any defaults added in the above window can still be removed for each enquiry or Quick Price. 

With the appropriate finishing style selected choose the Product Template option 

Create a Reprice Profile 
If you have purchased the Quick Pricer module or you wish to allow members of profile groups to be able to 
reprice quotations via MIS Console, you now need to create the reprice profiles. For further information see the 
chapter Reprice Profiles earlier in this user guide. 

Quick Pricer Filters 
When using the Quick Pricer module you have the ability to filter routes calculated and included in the quotation. 
Application setting id 71 and 74 need to be reviewed and entered as 1 (True) if you want to include the filters. For 
further information see the chapter Quick Price Filters earlier in this user guide. 

Users & Profiles 
You now need to log back in to MIS Console > Maintenance > My Information > Profile Groups. 

There are two steps which need to be performed: 

• Make the Enquiry template available 
 

• Assign the Reprice Profile 

Making the Enquiry Template Available 
1. Select the Profile Group and click Edit. 

 
2. Expand Quickpricer Templates. 
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3. The list of templates that have been created will appear. Select the templates that are to be visible to 
the users of this profile group. 

 

The Quickpricer Template name is that given for the BOR template, not the Enquiry Template.   

When the above is saved, the Enquiry Template is available for selection 

 

Assigning the Reprice profile to the user group 
If you wish to include the re-price options for the on-line quotations, you also need to assign the Reprice Profile 
to the user group. 

Select the profile name (that has been created in Estimating Maintenance) to the profile group and click Save. 

 

Application Settings 
Finally, you need to review the application settings for Quick Pricer and ensure that the appropriate settings are 
in place, for example, enabling the Quick Pricer Filters. 
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The above process is the same when configuring your system for Quick Pricer, the difference will be that users 
can calculate a quotation directly from the enquiry form rather than only being able to submit an enquiry to 
Estimating using the RFE Template. 

Quick Pricer from Contract 
As well as being able to use Quick Pricer for commercial quotations, you can also generate Quick Pricer 
quotations based on Contract pricing. 

Process Flow 
The process for configuring the system to enable Contract Quick Pricer is as follows:  

 
The process is very similar to the process for enabling Quick Pricer for commercial quotations, but the ability to 
reprice is removed as the pricing is based on agreed contract pricing and there is also some configuration within 
the Contract itself which needs to be entered. 

RFE Template Maintenance 
You can use the same enquiry templates for commercial or contract Quick Pricer pricing. However, if the 
template is to be available for use with Contract Pricing you need to ensure that the Contract Pricing checkbox is 
selected.  

 

When the enquiry is entered by the user, the Price from contract checkbox will be selected by default. 
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Contract Management configuration 
Contract Detail 
You can filter which contracts are available to the user when choosing to create a Quick Pricer quotation from a 
contract.  

Click Contract Management > Contract Detail. Select the Quick Pricer Contract check box. 

 

Note Contracts that are entered as Standard Price List can also be used for Quick Pricer. 

Contract Title 
Against the Contract Title it is necessary for the Title Defaults to contain the appropriate Finishing Style and 
BOR style and for the Title Available field to be selected against the Quick Pricer Details. 

  

The remainder of the configuration is the same as creating the RFE Template and commercial Quick Pricer. 
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Sales Commission Profiles 
Sales Commission is a licensed module and is used in conjunction with Application Setting 110 for Estimating 
and provides the ability to define commission values for sales persons, agencies etc. 

The module allows for multiple commission profiles to be entered that determine how a sales person or agency’s 
commission is calculated. 

Configuring Sales Commission Profiles 

1. To set up Sales Commission profiles, click Maintenance > Sales Commission Profiles. 

To be able to access this, you must have the following permissions allows for your user profile group: 

• Members can view Sales Commission 
 

• To be able to edit/change an existing profile, Members can amend Sales Commission. 
 

2. The Sales Commission Profile Maintenance window will open. 

 

3. To create a new Commission Profile, click New Profile > Edit.   
 

4. Enter the Profile Code/Description. 
 

5. Click Save. 
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6. Click Edit to amend the values. The Plus symbol will become available. Click Plus and new columns will 
become available for you to enter additional value ranges.  
 

 

7. The profile indicates the aspects of the quote and/or order the commission is applied and whether the 
commission is calculated on the total sales value, added value, contribution or profit. Therefore you need to 
select Sales Value, Added Value, Contribution or Profit for the commission profile. 
 

8. Enter the Commission Rates.  These can be entered as a percentage of the chosen options (Rate %) and / 
or a fixed amount (Amount).  
 

9. If both the percentage and fixed amount are entered then the commission is calculated based on the 
commission policy. 

Commission 
Policy Option Description 

Variable % This option will calculate the commission based on the values entered within Rate % only. 

Fixed Rate This option will calculate the commission based on the values entered within Amount. 

Variable % + 
Fixed Rate 

This option will calculate the commission based on both values entered. 

Maximum of 
Variable % or 

Fixed Rate 

This option will calculate the commission based on whichever value is greater. 

Minimum of 
Variable % + 

Fixed Rate 

This option will calculate the commission based on whichever value is greater. 

 

10. Enter a value within the Price field that the salesperson will receive in commission, if they are able to sell the 
quotation at a higher price that the value that was originally estimated. 
 

11. Once you have entered the commission profiles, these now need to be added to the salesperson. Click 
Maintenance > Structures > Sales Staff. Select the salesperson name and click Edit. Enter the 
Commission Profile, and click Save.  
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12. In addition to the default commission entered against the salesperson, individual profiles can be created 
against each contact the sales person is associated with. This allows for different commission rates to be 
entered against each customer required. Click Company Management > Contacts. Open the Contact 
record and scroll down to the Salespersons list. Select the salesperson and click Edit. The Contact 
Salespersons window will open where you can enter the Commission Profile (as below). 

 

13. In addition to the discount value held against the company record the ability to enter an agency commission 
profile is also available. To enter this value, click Company Management > Companies and edit a 
company record (as below).   

 

Note If an Agency Commission profile is entered then this supersedes any Discount (%) value 
entered.  Basically, the two values cannot be used together.  Only when no Agency 
Commission profile has been entered will the Discount value be used. 

Example 1 – Very basic detail. Commission is calculated at 5% across the board on all Added Value related 
areas. 
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Example 2 – More complex. Commission calculation varies based on the value of the job. The higher the Sales 
Values, the higher percentage commission value that the Senior Sales Person will achieve. On the lower 
quantity, the salesperson will receive 5% on all labor elements except Pre Press and Plates where they will earn 
a fixed value. On the higher value jobs, the labor commission percentage increases and the Pre-Press and 
Plates elements earn 5%. 

 

Checklist for Missing Routes 
After configuring Estimating Maintenance, you will be able to start creating estimates. We recommend that you 
start validating the data for press and bindery operations first.  

We also recommend that when implementing Quick Pricer you check the route calculation in Estimating before 
generating the quotations in Quick Pricer and only when you’ve validated the data in Estimating, start generating 
the pricing using Quick Pricer and then validate the two sets of data to ensure that the options calculated in 
Quick Pricer are the routes and subsequent prices you expect. 

Press Routes 
The following checklist provides you with a list of steps to review if the expected press route is not returned in 
Estimating: 

Site 
• Make sure the estimating site is allowed to estimate that resource (add a row to the press site link table 

for the relevant site). 
 

• Make sure trims are defined for the selected finishing style. 
 

• Make sure an RSB exists for the number of pages in the component. 

Press  
• Check that the press is Live. 
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• Check the number of colors of the estimate and that the presses’ units and reelstands will meet the 
requirements of the estimate. 
 

• Check the Cut-off of the press and this falls within the requirements of the estimate. 
 

• Check the minimum and maximum web width that the press is capable of producing and that this falls 
within the requirements of the estimate. 
 

• Check that resource rates are entered and that they are valid beyond the Delivery Date of the estimate 
entered. 

Speed  
• Make sure that there is a valid press speed and that it starts from 0 and the highest quantity is greater 

than the press run.  
 

• Check that the paper weight range grammage entered against the component in the estimate.  
 

• Ensure at least 1 range has color ranges that start at 0. 

Configurations 
• Make sure the configuration is Live. 

 
• Make sure the pagination matches the section pagination in the estimate. For example, if the 

component pagination is 96pp, ensure that you have live configurations that can produce a 96pp 
component. 
 

• Make sure the minimum and maximum depth and width include the estimate’s component depth and 
width. 
 

• Make sure the finishing style matches the component’s finishing style. 
 

• Make sure either or both of bleed and non-bleed are selected. 
 

• Make sure the maximum number of colors is greater than the number of colors for the component. 
 

• Make sure the configurationis capable of supporting any press extras specified in the component. 

Finishing Routes 
If the expected finishing route is not returned, the following should be checked: 

Site 
• Make sure the estimating site is allowed to estimate that resource (add a row to the finishing site link 

table for the relevant site). 
 

• Make sure trims are entered for the selected finishing style. 

Finishing Resource  
• Check that the finishing resource is Live. 

 
• Check the minimum and maximum product depth and width will support the entries in the estimate. 

 
• Check the minimum and maximum paper weights will support the entries in the estimate. 
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• Check the number of hoppers is sufficient. (Remember to add one hopper for each additional operation 
where Additional Kit = No.) 
 

• If minimum quantity is used, make sure it is lower than the quantity entered in the estimate. 
 

• Check that resource rates are defined and that they are valid beyond the Delivery Date entered in the 
estimate. 

Speed calculation 
Modes and Speeds 

• Make sure that an entry exists for the relevant finishing style, and that the product falls within the range 
of sizes, orientations, no up, minimum and maximum width and depth and weight. 
 

• For each row in modes and speeds, make sure a speed exists and that the number of hoppers and 
cycle speed are entered. 

Cutting and Folding Operations 
Assuming cutting and folding operations are returned for some products on the selected finishing resource, there 
are other factors to check if cutting and folding are missing for specific sections: 

Cover Sections 

• Folding will never be added for perfect bound cover sections. 

Web Press Routes 

• Unless sheeted is checked for the component or a sheeted configuration is selected, cutting and folding 
will never be added to web-printed sections. 

Pagination 

• Folding will never be added for 2-page sections (a 2-page section is a flat sheet). 

Outworkers 
Bindery Outwork 

• Make sure Can Bind is selected for the outworker. 
 

• Make sure paper weights are entered for the relevant component type (text or cover) and finishing style. 
 

• Add entries to binding prices for the relevant finishing style, component size, quantity, number of 
sections. 
 

• Make sure the application setting 1 for Estimate Finishing is entered as 1 (True). 

Print Outwork 

• Make sure Can Print is selected for the outworker. 
 

• Manually select Outwork in Estimating > Component > Manual. 
 

• Check the configuration has been entered. 
o Make sure the pagination matches pagination of the component in the estimate. 

 
o Make sure the finishing style matches finishing style of the component in the estimate. 

 
o Make sure the depth and width of the component falls within range. 
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o Make sure the paper weight of the component falls within range. 
 

o Make sure the total number of colors of the component is less than or equal to Max No. Colors. 
 

o If a printing method (web or sheetfed) has been selected in the estimate, make sure either web or 
sheet is selected against the configuration. 
 

o Make sure the estimate’s quantity falls within the minimum and maximum run lengths. 
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Calculations 
The following provides explanation of how the EFI Technique application calculates certain elements of the 
quotation. 

Calculation Process Flow 
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Press Calculation Process 
The following process and examples are design to help understand how the estimating press calculation engine 
works based on the product specification and configuration data entered. 

Route Generation 
This routine takes the print component specification and using the Site and Press configuration data determines 
which presses are capable of producing the product.  For each valid configuration found the application writes 
out a route. 

For every valid route written the number of routes generated will be incremented. 

In this determination the following calculations/filters are undertaken: 

Step Process 

Step 1  
RSB 

Check pagination against Reasonable Section Breakdown (RSB).  
If an RSB option is found then each RSB element will be processed.  All valid RSB options 
are processed. 
Example a : 16pp may have RSB options of 1 x 16pp, 2 x 8pp and 4 x 4pp. 
Example b: 56pp may have options of 1 x 56pp, 1 x32pp + 1 x 24pp and 2 x 28pp. 
If no RSB options found then the component cannot be calculated and the process ends. 
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Step Process 

Step 2 Press and 
Configuration 

For each RSB element the Press Configurations are filtered and extracted.  The filters 
applied are: 

For Press  
• Press is Live. 

 
• Press has required number of press units to support the number of colors. 

 

 
 

For Press Configuration 
• Configuration is Live. 

 
• Pagination match . 

 
• Finishing Style match. 

 
• Product Depth and Width (Open sheet size if specified for sheet work) are 

within range. 
 

• Product weight or calliper (based on application setting) are within range. 
 

• Total of colors are within range. 
 

• Bleed/Non Bleed.  
 

• Support of In-line press extras. 
 

• Quantity is greater than minimum quantity. 
 

 
• Only if all the checks are valid is a route written for calculation. 

 
• If no routes are written the process will end. 
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Route Calculation  
For every route generated, the Estimating application will attempt to calculate material, cost and price data. 
During the process further checks are made to ensure the validity of the route.  If it fails the route will be 
removed. 

For every valid route calculated the number of Routes Calculated will be incremented. 

For demonstration purposes every calculation aspect of the following sample has been worked: 

Scenario: 775,000 Saddle Stitch 16pp A4 (297 x 210) 6/6 (4 process/2 special) color book.  1 set of 16 
Page Proofs and UV to Page 1. 

Element Process Calculation Formula 

Pre Press Step 1  
 

Net Impressions and Extra Plate Sets 

  Net Impressions Net Quantity / Number Up 

   775,000 / 1 

   775,000 
  Extra Plate Sets Net Impressions / Maximum Plate Impressions 

   775,000 / 250,000 = 3 (rounded down to a whole number) 

  Entries from 
Press tab 

 
  Entries from 

Press 
Configuration  

 Step 2 Pre Press Labour, Cost and Price 

  Pre Press Labor 
Hours 

Pagination * Imposition Time 1 Page 

   16 * 0.08 = 1.28 Hours 

  Pre Press Labor 
Cost 

Pre Press Labor Hours * Pre Press Cost Rate 

   1.28 * 85 = £108.80 

  Pre Press Labor 
Price 

Pre Press Labor Cost * (100 + Pre Press Mark Up %) / 100 

   108.80 * (100 + 5) / 100 = £114.24 

  Entries from Site 
tab 

 
 Step 3 Plate Labor, Cost and Price 

  Number of 
Plates 

(Colors Front + Colors Back) * (1 + Extra Plate Sets) 

   (6 + 6) * (1 + 3) = 48 Plates 

  Plate Labor 
Hours 

Number of Plates * Plate Labour Hours 
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Element Process Calculation Formula 

   48 * 0.25 = 12 Hours 

  Plate Labor Cost Plate Labor Hours * Plate Labor Cost 

   12 * 50 = £600 

  Plate Labor 
Price 

Plate Labour Cost * (100 + Pre Press Mark Up %) / 100 

   600 * (100 + 5) / 100 = £630 

  Entries from Site 
tab 

 
  Entries from 

Press tab  
 Step 4 Plate Cost and Price 

  Plate Cost Number of Plates * Cost of Plate 

   48 * 25 = £1,200 

  Plate Price Plate Cost * (100 + Plate Mark Up %) / 100 

   600 * (100 + 10) / 100 = £1,320 

  Entries from 
Press tab 

 
 Step 5 Pre Press Proofs (if entered against the component). Repeated for each proof 

entered. 
  Proof Labor 

Cost 
(Proof Make Ready Hours + (Proof Per Page Hours * Proof 
Quantity * Proof No Pages)) * Proof Labour Cost Rate 

   (0 + (0.25 * 1 * 16)) * 45 = £180 

  Proof Labor 
Price 

Proof Labour Cost * (100 + Proof Mark Up %) / 100 

   180 * (100 + 20) / 100 = £216 

  Proof Material 
Cost 

Proof Quantity * Proof No Pages * Proof Material Cost 

   1 * 16 * 5 = £80 

  Proof Material 
Price 

Proof Material Cost * (100 + Proof Mark Up %) / 100 

   80 * (100 + 20) / 100 = £96 

  Entries from Pre 
Press costs (for 
the site) 

 
Press Step 1 Number of Printed Sheets and Make Ready Sheets 

  Net Sheets Net Quantity / No Up 

   775,000 / 1 = 775,000 
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Element Process Calculation Formula 

  Binders Overs Net Sheets / 100 * Binders Overs % 

   (775,000 / 1)  / 100 * 2 = 15,500 Binders Overs Sheets 

  Running Waste (Net Sheets + Binders Overs) /100 * (Running Waste % + Press 
Extra Running Waste %) 

   (775,000 + 15,500) / 100 * (5 + 1) = 47,430 Running Waste 
Sheets 

  MR Sheets (MR Sheets + No Plates MR Sheets + (Follow On MR Sheets + 
No Plates MR Sheets) * Extra Plate Sets) + Press Extra MR 
Sheets 

   (500 + 500 + (250 + 500) * 3) + 1,000 = 4,250 MR Sheets 

  Paper Waste (Net Sheets + Binders Overs + Running Waste + MR Sheets) / 
100 * Paper Waste % 

   (775,000 + 15,500 + 47,430 + 4,250) / 100 * 0 = 0 Paper Waste 
Sheets 

  Number of 
Printed Sheets 

Net Sheets + Binders Overs + Running Waste 

   775,000 + 15,500 + 47,430 = 837,930 Number of Printed Sheets 

  Entries from Site 
Binders Overs 

 
  Entries from 

Press tab 

 
  Entries from 

Plate Set Up 
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Element Process Calculation Formula 

  Entries from 
Press 
Configuration 

 
  Entries from 

Config Press 
Running Waste 

 
(Only used if selected against the Press Configuration.  If not then 
the basic running waste against the Press Header is used.) 

  Entries From 
Press Extras 

Repeated for each press extra specified against the component or 
automatically incurred against the configuration. 

 
 Step 2 Make Ready 

Hours 
 

  Basic Make 
Ready Hours 

Web 1 MR Hours + No Plates MR Hours + (Web 1 Follow On MR 
Hours + No Plates MR Hours) * Extra Plate Sets 

   1 + 1.75 + (0.5 + 1.75) * 3 = 9.5 Hours 

  Process Wash 
Up 

No Process Colors * Process Unit Wash Up Hours 

   4 * 0.15 = 0.60 hours 

  Special Color 
Wash Up (only if 
special colors 
entered) 

(Number of Special Colors + (No of Units – 4 – Number of Special 
Colors)) * Special Color MR Hours 

   (2 + (5 – 4 – 2)) * 0.5 = 0.5 hours 
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Element Process Calculation Formula 

  Process to 
Special Color 
Wash Up (Only 
if special colors 
specified) 

(Number of Special Colors - (No of Units – 4)) * Process to Special 
Unit Wash Up Hours 

   (2 – (5 – 4)) * 0.5 = 0.5 hours 

  Press Extra 
Make Ready 
Hours 

Extra MR Hours + (Extra Follow On MR Hours * Extra Plate Sets) 

   1 + (0.50 * 3) = 2.5 hours 

  Total Make 
Ready Hours 

13.6 hours 

  Entries from 
Press tab 

 
  Entries from 

Plate Set Up 
 

  Entries from 
Press Extras 

Repeated for each press extra specified against the component or 
automatically incurred against the configuration. 

 
   Note                The Additional Web MR Hours and Additional Web 

Follow On MR Hours will be incurred for each 
additional web identified against the configuration. 

   Note             The Reel width over Extra MR will only be incurred if 
a value is specified and the calculated web/sheet 
width is over the defined value. 

 Step 3 Run Hours  

  Number of 
Press Passes / 
Sheet Fed Only 
(Not Perfecting) 

ROUNDUP(No Colors Front / No Units) + ROUNDUP(No Colors 
Back / No Units) 

   ROUNDUP(6 / 5) + ROUNDUP(6 / 5) = 2 + 2 = 4 Passes 
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Element Process Calculation Formula 

  Number of 
Press Passes 
(Perfecting 
Press) 

ROUNDUP(No Colors Front + No Colors Back/ No Units) 

  Press Speed 
(graduated) 

Number of Printed Sheets / Total of Graduated Hours 

   Speed Breaks Speeds 

   < 5,000 5,000 

   <10,000 6,500 

   <50,000 8,500 

   >50,000 10,000 

   Impressions Speed Hours 

   5,000 5,000 1.00 

   5,000 6,500 0.77 

   40,000 8,500 4.71 

   787,930 10,000 78.79 

   Total Graduated 
Hours 

 85.27 

   Sheets per Hour 837,930 / 85.27 = 9,827 sheets per hour 

  Run Hours Graduate Hours * Number of press passes 

   85.27 * 4 = 341.08 hours 

   Note                For non graduated speed calculation the matching 
line from the Press speed table is used. 

  Entries from 
Press tab 

 

 

  Entries from 
Press Speed 

 

 Step 4 Make Ready and Run Cost and Price 

  Make Ready 
Cost 

Total Make Ready Hours * Press Cost Rate 

   13.6 * 230 = £3,128 

  Make Ready 
Price (Cost 
Plus) 

Make Ready Cost * (1 + Cost Make Up %) 

   3,128 * (1 + .10) = £3,440.80 
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Element Process Calculation Formula 

  Run Cost Run Hours * Press Cost Rate 

   341.08 * 230 = £78,446.68 

  Run Price Run Price * (1 + Cost Make Up %) 

   78,446.68 * (1 + .10) = £86,291.35 

   Note                   For non cost plus the hours are multiplied by the 
Press Sell Rate. 

   Note                   If no rate entry is found for the press, the route will 
fail and be deleted. 

  Entries from 
Press Rate  

   Note                   Selection of the rate entry is based on the delivery 
date of the enquiry. 

 Step 5 Ink Quantity, Cost and Price 

  Ink coverage 
square meter 
(sq m) per book 

((Page Depth + Head Trim + Foot Trim) * (Page Width + Foredge 
Trim + Spine Trim (PB Only)) * (Pages Across Web * Pages Down 
Web) * (Color on Front + Color on Back) * Ink Coverage) / 
1,000,000 

   ((297 + 4 + 4) * (210 + 7.5 + 0) * (4 * 2) *(1 + 1) * 45%) / 1,000,000 
= 0.47763 sq m per book 

  Total Coverage 
sq m 

Ink Coverage sq m per Book * (Number of Printed Sheets + MR 
Sheets) 

   0.47763 * (837,930 + 4,250) = 402,250.4334 sq m 

  Number of 
kilograms 

Total Coverage sq M / Consumption Rate 

   402,250.4334 / 3,250 = 123.77 Kilo’s 

  Ink Cost Number of Kilo’s * Cost Per UOP 

   123.77 * 9 = £1,113.93 

  Ink Price Ink Cost + MU% 

   £1,113.93 + 5% = £1,169.63 

   Note                  The consumption rate used is dependant on the 
paper type – Coated or Un-coated. 

   Note                  The ink calculation process is repeated for every 
ink specified – in this example the 4 process and 2 
special colors. 

  Entries from the 
Site Trim Table  
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Element Process Calculation Formula 

  Entries from 
Press 
Configuration 

 

  Entries from 
Material 

 

 Step 6 Press Extra Materials (Only if entered, in this example UV varnish 

  UV Coverage 
square meters 
(sq m) 

(Extra Depth * Extra Width) / 1,000,000 

   (297 * 210) / 1,000,000 = 0.06237 sq m per book 

  Total Coverage 
sq m 

UV Coverage sq m per Book * (Number of Printed Sheets + MR 
Sheets) 

   0.06237 * (837,930 + 4,250) = 52,526.7666 sq m 

  Number of 
kilograms 

Total Coverage sq M / Consumption Rate 

   52,526.7666 / 2,500 = 21.01 kilos 

  UV Cost Number of Kilo’s * Cost Per UOP 
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Element Process Calculation Formula 

   21.01 * 20 = £420.20 

  UV Price UV Cost + MU% 

   £420.20 + 5% = £441.21 

  Entries from 
Material 

 

 Step 7 Determine the sheet size. 

  Sheet Depth ((Page Depth + Head Trim + Foot Trim) * Pages Down Web) + 
Gripper Trim 

   ((297 + 4 + 4) * 2) + 10 = 620mm 

  Sheet Width ((Page Width + Foredge) * Pages Across Web) + Additional Trim 

   ((210 + 7.5) * 4) + 0 = 870mm 

   Note                   For web presses the sheet depth is check against 
the Cut Off of the press.  If the Cut-off is exceeded 
then the route will fail. 

   Note                   For all presses the sheet width is checked against 
the press minimum and maximum web/sheet width.  
If outside the parameters then the route will fail. 

  Sheet Size Web 
Presses 

Sheet depth is set to the Cut-off. 

   Sheet Depth = 630mm 

   Sheet Size = 630mm * 870mm 

  Sheet Size 
Sheet Fed 
presses 

Lookup the sheet size. 

   Next matching entry is 640 x 900 sheet. 

   Sheet Size = 640 x 900mm. 

   Note                   If the sheet size is specified against the 
component or configuration then this will be used 
irrespective of whether the product fits or not. 

   Note                   If the sheet size is not specified then the 
application will lookup the sheet size within the Sheet 
Stock Sizes table.  If no entry is found then the route 
will fail. 

 Step 8 Paper Weight, Sheets, Cost and Price (Non US) 
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Element Process Calculation Formula 

  Total Sheets Number of Printed Sheets + Paper Waste + MR Sheets 

   837,930 + 0 + 4,250 = 842,180 Total Sheets 

  Total Weight 
(kilograms) 

((Sheet Depth * Sheets Width) / 1,000,000) * (Paper Weight  / 
1,000) * Total Sheets 

   ((640 * 900) / 1,000,000) * (90 / 1,000) * 842,180 = 43,659 Kilo’s 

  Paper Cost (Total Weight / 1,000) * Paper Cost Per Tonne 

   (43,659 / 1,000) * 600 = £26,195.40  

  Paper Price (Total Weight / 1,000) * Paper Price Per Tonne 

   (43,659 / 1,000) * 630 = £27,505.17 

  Paper Weight, Cost and Price (US) 

  (Sheet Size 25” x 34” – on 60lb Book Stock (25” x 38”) – Cost $55 per cwt – Mark Up 
5% - Price = Cost + Mark Up) 

  Total Weight 
(lb’s) 

(Sheet Width * Sheets Depth * Paper Weight * Total Sheets) / (500 
* Basic Area) 

   (25 * 34 * 60 * 842,180) / (500 * 25 * 38) = 90,424 lb’s 

  Paper Cost (Total Weight / 100) * Paper Cost Per CWT 

   (90,424 / 100) * 55 = $49,733.20 

  Paper Price (Paper Cost + Mark Up%) 

   (43,733.20 + 5%) = $52,219.86 

  Entries from 
Material Type 
(US only) 

 

  Entries from 
Material Item 

 

 Step 9 Total Cost, Sell, Margin and Added Value (AV) 
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Element Process Calculation Formula 

  Total Cost Pre Press Labour Cost + Plate Labour Cost + Plate Cost + Proof 
Labour Cost + Proof Material Cost + Make Ready Cost + Run Cost 
+ Press Extra Material Cost + Ink Cost + Paper Cost 

   108.80 + 600.00 + 1,200.00 + 180.00 + 80.00 + 3,128 + 78,446.68 
+ 417.63 + 5,501.65 + 26,195.17 = £115,857.93 

  Total Sell Pre Press Labour Price + Plate Labour Price + Plate Price + Proof 
Labour Price + Proof Material Price + Make Ready Price + Run 
Price + Press Extra Material Price + Ink Price + Paper Price 

   114.24 + 630.00 + 1,320.00 + 216.00 + 96.00 + 3,440.80 + 
86,291.35 + 438.51 + 6,033.89+ 27,504.92 = £126,085.72 

  Total Margin Total Sell – Total Cost 

   126,085.72 – 115,857.93 = £10,227.79 

  Total Added 
Value (AV) 

Total Sell – Plate Cost – Proof Material Cost – Press Extra Material 
Cost - Ink Cost – Paper Cost 

   126,085.72 – 1,200 – 80.00 – 417.63 - 5501.65 – 26,195.17 = 
£92,691.27 

Wide Format Calculation 
The calculation process for Wide Format press types is divided into three separate steps; Press Time and Cost 
Calculation, Paper Calculation and Ink Calculation. 

Press Time and Cost Calculation 
First the total area of print, in square meters, is calculated using the following formula: 

(Open Depth x Open Width) /1,000,000) x (Quantity + Running Waste % + Running Waste Quantity) 

Note The printable area will include the product trims as entered for each finishing style. 

Note Quality speed factors will be applied by using Press Extra’s using standard Press Extras functionality.  

Example: 

Product Size: 594mm x 420mm 

Trims: 3mm Head and Foot, 6mm Foredge and 6mm Spine edge 

Open Size: 600mm x 426mm 

Quantity 500 

Running Waste % = 5% 

Running Waste Quantity = 0  

Mode = Standard 

(600 x 426) /1,000,000) * (500 + 5% + 0) = 134.19 square meters of print. 
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The speed for the Wide Format press is referenced based on the mode of printing and square meters, 
therefore, in this example the print rate will be 21 square meters per hour based on the mode of operation 
(standard) and the total square area to print (134.19). 

 

Using these values the application will also ensure that any speed reductions or extra make ready time etc., 
that have been included as press extras are also included, plus any make ready time entered against the 
press on the Press tab. 

The speed calculation is as follows: 

(Total Square Meters of Print / Square Meters Per Hour) + MR Time 

(134.19 / 21) + 0 = 6.39 Hours 

The press cost is then calculated by multiplying the time by the cost rate, (in this example £75 per hour): 

Print Cost = Total Hours * Cost Rate 

Print Cost = 6.39 * 75 = £479.25 

Paper Calculation 
If supported the both sheet fed and roll fed paper option will be calculated. 

For roll fed the system will start by identifying wide format roll widths that have been entered in Estimating 
Maintenance > Miscellaneous > Stock Webs. For sheet fed the system will work in the same manner as for a 
Sheet Fed press.  

In this example the roll stock is configured as follows: 

Roll 
Sizes 

Roll Length Sqr M Per Roll Cost per Sqr M (£) Cost per Roll (£) 
 

500 100,000 50 0.160 8.00 

1,000 100000 100 0.155 15.50 

1,600 100000 160 0.150 24.00 

2,500 100000 250 0.145 36.25 
 

The application will orientate the product across each roll width to calculate, based on the product open size, the 
number up. Then based on the number of products to be printed, the application will calculate the length of roll 
required, how much paper waste will be incurred and the cost of the paper.  
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Portrait: 

Roll  
 

No Up Meters Required Total Paper Sq M Total Waste (%) Paper Cost 
(£) 

500 1 315.0 157.5 14.80 25.200 

1,000 2 157.8 157.8 14.96 24.459 

1,600 3 105.0 168.0 20.13 25.200 

2,500 5 63.0 157.5 14.80 22.838 
 

Landscape: 

Roll 
  

No Up Meters Required Total Paper Sq M Total Waste (%) Paper Cost 
(£) 

500 0 - - - - 

1,000 1 223.650 223.650 40.00 34.666 

1,600 2 112.038 179.261 25.14 26.889 

2,500 4 56.232 140.580 4.55 20.384 
 

The calculation is as follows: 

Example 2500mm roll based on the portrait orientation (open width across the roll): 

No Up = (Roll Width / Open Width or Open Depth) rounded down to the nearest whole number. 

No Up = (2500 / 426) = 5.869, when rounded down = 5. 

Meters Required = (Gross Qty / No Up * Open Depth or Open Width) 

Meters Required = (525 / 5 * 600) / 1000 = 63.000 Meters. 

Total Paper Sqr Mtr = (Roll Width * Meters Required) 

Total Paper Sqr Mtr = (2.500 * 63.000) = 157.500 Sqr Mtrs 

Total Waste % = 1 – (Total Square Meters of Print / Total Paper Square Meters) * 100 

 Total Waste % = 1 – (134.190 / 157.500) * 100 = 14.8% 

Paper Cost = (Total Paper Square Meters * Cost Per Square Meter)  

 Paper Cost = (157.500 * 0.145) = £22.8375 

Ink Calculation 
Ink will be calculated in the standard manner based on total print area and % coverage. 

In this example the ink cost has been entered as follows: 

Color 
 

Cost Per Litre (£) Coverage Per Litre (Sq 
M) 

Cost per Sq M 
(£) 

C 25.00 500 0.0500 

M 25.00 500 0.0500 

Y 25.00 500 0.0500 

K 17.50 625 0.0280 
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The calculation is: Ink Cost Per Color = Total Square Meters of Print  * % Coverage * Cost Per Square Meter 

Therefore total ink cost is calculated as follows: 

Color Total Square Meters Coverage (%) Cost (£) 

C 134.19 50 3.35 

M 134.19 50 3.35 

Y 134.19 50 3.35 

K 134.19 50 1.88 
 

Therefore the Total Cost = £11.94. 

Post Press (Finishing) Calculation Process 
The following process and examples are designed to help understand how the estimating post press calculation 
process works based on the product specification and configuration data entered. 

The post press calculation process goes through 5 stages: 

• Press component re-calculation to enable the correct number of binders overs to be accounted for. 
 

• Finishing operations. 
 

• Packing. 
 

• Delivery. 
 

• Ancillary items. 

Press Component Re-Calculation 
Now that the final product has been defined the system is now able to determine the number of press 
components included.  This number is used to refer back to the Site Binders Overs to obtain the % to apply when 
re-calculating the routes. 

When re-calculating the routes the same rules are applied as described in the Press Calculation Process. 

Finishing Route Generation 
This routine works through each specified finishing operation and using the Site and Finishing configuration data 
determines which finishing resources are capable of producing the product.  For each valid configuration 
calculated the application writes out a route. 
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Step Process 

Step 1  
Binding 

Resource 
 

Resource is Live. 
Has the resource the required number hoppers (feeds) to support the number of assigned 
components and additional operations. 
Can support the product dimension. 
Can support the product weight. 
Operation quantity is greater than or equal to the minimum quantity. 

 
 

Modes and 
Speeds 

The finishing style matches 
Can support the product dimension. 
Can support the product weight. 
Speed entry exists for the required number of hoppers. 
Modes: 

 
Speeds: 
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Step Process 

Folding The finishing style is folding.  
Supports the fold type. 
Can support the product dimension. 
Can support the product weight. 
Can support the fold number up. 
Can support the number of folds. 
Folder: 

 
Configurations: 

 
 

Cutting The finishing style is folding.  
Supports the required number of cuts. 

 

 

Route Calculation  
For every route selected estimating will attempt to calculate cost and price data. 

During the process further checks are made to ensure the validity of the route.  If it fails the route will be 
removed. 

For demonstration purposes every calculation aspect of the following sample has been worked: 
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Scenario: 775,000 Saddle Stitch 16pp A4 (297 x 210) 6/6 (4 process/2 special) color books.  1 set of 16 
Page Proofs and UV to Page 1.  Here folding and saddle stitching have been applied to the 16pp section 

Element Process Calculation Formula 

Folding Step 1  
 

MR Hours and Run Hours 

  Gross 
Impressions 

Net Quantity + (Net Quantity * Site Binders Overs %) 

   775,000 + (775,000 * 2%) = 790,500 

  MR Hours 2 Hours 
  Run Hours Gross Impressions / Cycle Speed 
   790,500 / 4,500 = 175.67 Hours 
  Entries from 

Site Binders 
Overs 

 
  Entries from 

Folder Speed 

 
 Step 2 MR Cost and Price 

  MR Cost MR Hours * Cost Rate 

   2 * £70.00 = £140.00 

  MR Price MR Hours * Price 

   2 * £90.00 = £180.00 

 Step 3 Run Cost & Price 

  Run Cost Run Hours * Cost Rate 

   175.67 * £70.00 = £12,296.90 

  Run Price Run Hours * Price 

   175.67 * £90.00 = £15,810.30 

  Entries from 
Folder 
Resource Rates 

 

If no rate entry is found for the press, the route will fail and be 
deleted. 

Saddle 
Stitching 

Step 1 MR Hours and Run Hours 

  Gross 
Impressions 

Net Quantity + (Net Quantity * Site Binders Overs %) 

   775,000 + (775,000 * 2%) = 790,500 
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Element Process Calculation Formula 

  MR Hours 2 Hours 

  Run Hours Gross Impressions / Cycle Speed 

   790,500 / 10,000 = 79.05 Hours 

  Entries from 
Site Binding 
Overs 

 

  Entries from 
Bindery Modes 

 

  Entries from 
Bindery Speeds 

 

 Step 2 MR Cost and Price 

  MR Cost MR Hours * Cost Rate 

   2 * £120.00 = £240.00 

  MR Price MR Hours * Price 

   2 * £180.00 = £360.00 

 Step 3 Run Cost and Price 

  Run Cost Run Hours * Cost Rate 

   79.05 * £120.00 = £9,486.00 

  Run Price Run Hours * Price 

   79.05 * £180.00 = £14,229.00 

  Entries from 
Resource Rates  

If no rate entry is found for the press, the route will fail and be 
deleted. 

Advanced Guillotine Calculation 
Example – 8pp printing 4up on SRA1 paper (640 x 900mm), 40,000 copies 

Process  Calculation Source 

Sheet Size = 640 x 900 = 576,000 sq mm  
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Process  Calculation Source 

Caliper = 0.0038 (from 
Materials) 

Paper weight = 90gsm (from 
Materials) 

Sheets = (40,000 / 4up) + 150 MR sheets = 10,150  

Max lift height = 4 (from Lift 
Height) 

Sheets per lift = 4 / 0.0038 = 1,053  

Total number of lifts = 10,150 / 1,053 = 10  

Lifts per hour = 30 (from 
Resource tab) 

Time = 10 / 30 = 0.33 hours  

Number of cuts per 
sheet 

= 2 (from Cutting 
Defaults) 

Total cuts = 10 piles x 2 = 20 cuts  

Cuts per hour = 40 (from 
Advanced 
Speed) 

Time = 20 / 40 = 0.5 hours  

Total Time = lift time + cut time + Make ready time (MR from 
Make Ready) 

 = 0.33 + 0.5 + 0.5 = 1.33 hours  

Advanced Folding Calculation 
In the following example, a 4pp, 297mm x 210mm portrait, with a section fold, on 130gsm paper, 0.13 caliper, 
printed sheetfed 2up on a 640mm x 900mm sheet size, the Fold Catalog has been entered as 1 fold and 0 turns. 

When the estimate version is created 

Process Calculation 

Advanced 
Folding 

Parameters 

 

Folding speed 
reduction 

(Number of folds * Speed Per Plate / 100) + If No of Turns > 0,then number of turns * 
Speed Per Turn / 100,0) = 5% 
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Process Calculation 

Millimeters per 
minute 

In-Feed speed x speed reduction (larger of caliper speed reduction or folding speed 
reduction) 

203200 x 5% = 193040 

Pieces per hour Millimeters per hour / (Feed Length + Gap)/ Fold No Up) * 60 

193040 / 475 * 60 = 24384 

Make Ready 
Time 

(MR First plate + MR additional plates + MR first turn + MR additional turns) 

(1 / 60) * 3 = 0.05 hours 

Run Time Quantity / Pieces per Hour = 100,000 /  = 4.10 Hours 

 

Advanced Bindery Assistants Calculation 
The following scenario is provided to explain the calculation method when the advanced assistants check box is 
selected for a resource. 

A4 Perfect Bound book consisting of a 4pp Cover + 480pp Text (on 2 different stocks) + 3 Loose inserts.  
250,000 copies. 

4pp Cover is printed sheetfed and is delivered to the binder as a flat section, on 130gsm (0.13 caliper). 

320pp Text (1) is printed web.  Produced as 5 x 64pp, 1 x 32pp and 1 x 8pp, on 60gsm (0.081 caliper). 

120pp Text (2) is printed web.  Produced as 3 x 32pp and 1 x 24pp, on 70gsm (0.095 caliper). 

The Inserts are entered as follows: 

First 100,000 copies contain 3 Inserts. 

Second 100,000 copies contain 2 Inserts. 

Third 50,000 copies contain 1 Insert. 

Each profile is calculated in-turn, as the diminishing number of inserts running will affect the number of assistants 
required. 

The binding requirement is as follows: 

1 x Cover Feeder, 11x  Log/Pile fed hoppers, 3 x insert hoppers for 100,000 copies, 2 x insert hoppers for 
100,000 copies, 1 x insert hopper for 50,000 copies. 

Base Number of assistants entered for the resource is 2. 

The resource speed is entered as follows: 

 13 Hoppers - 6,000 per hour 

 14 Hoppers - 5,750 per hour 

 15 Hoppers - 5,500 per hour 

The calculation process is split down in to the following steps: 

Step 1  

Calculate the average log/pile size and number of log hoppers and bind-in hoppers. 
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The calculation is based on a log length of 1200mm (application setting id 129) and web delivered section spine 
width. 

Sheeted sections for calculation purposes are treated as a bind-ins as the hopper loading process is the same as 
an insert. 

Section Bind-Ins Process GSM Caliper Spine Copy per Log 

4pp  Sheet 130 0.15 -  

64pp  Web 60 0.081 2.592 462 

64pp  Web 60 0.081 2.592 462 

64pp  Web 60 0.081 2.592 462 

64pp  Web 60 0.081 2.592 462 

64pp  Web 60 0.081 2.592 462 

32pp  Web 60 0.081 1.296 925 

8pp  Web 60 0.081 0.324 3703 

32pp  Web 70 0.95 1.520 789 

32pp  Web 70 0.95 1.520 789 

32pp  Web 70 0.95 1.520 789 

24pp  Web 70 0.95 1.140 1052 

 A    -  

 B    -  

 C    -  

No 
Hoppers 

4 11   Average 941 

 

Note The number of bind-in hoppers includes the sheeted sections. 

 

Note The Copy Per Log for each web section is calculated using the following formula: 

 Spine = (Section Pagination / 2) * Caliper 

 Copy Per Log = Log length / Spine. 

 Average = Sum of Copy Per log / No of Process Web Sections. 

Step 2 

Calculate the number of signatures per hour that an assistant can manage. 

The calculation uses the value entered in application setting id 128, in this scenario 35, and average copy per 
log. 

Signatures Per Hour = Logs per hour * Average Copy Per Log  

Signatures Per Hour = 35 * 941 

Signatures Per Hour = 32,935 

Step 3  

Calculate the number of hoppers to be managed. 
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The calculation is based on the Signature Per Hour divided by the speed of the resource. The resource speed 
included in the calculation is based on the total number of hoppers required.  Therefore, in this example when 3 
inserts are included in the binding operation this equate to 15 hoppers and a speed of 5,500 copies per hour. 

Hoppers to Handle = Signature Per Hour / Resource Speed  

Hoppers to Handle = 32,936 / 5,500 

Hoppers to Handle = 5.988 

The Hoppers to Handle is re-calculated for each profile split caused by the diminishing number of inserts.  For 
example, when the number of inserts included in the binding operation changes from 3 to 2, the speed increases 
to 5,750 and likewise when the number of inserts reduces to 1 the speed increases to 6,000. 

Note Any speed reduction factors based on quantity, pagination, paper grammage and additional operations 
are applied in the normal manner before the speed is used in the calculation. 

Step 4  

Calculate the number of assistants required to handle the log/pile signatures.   

In this scenario application setting id 124 has been entered as 6. 

The calculation is based on the following comparison: 

IF   Hoppers to handle is greater than the value entered in application setting id 124, 

THEN No of Logs Signatures / maximum logs per assistant (application setting id 124) 

ELSE No of Logs Signatures / Hoppers to Handle 

In this case Hoppers to Handle is calculated as 5.988 and is therefore less than the value entered for maximum 
number of logs per assistant 

Therefore,  

Log Assistants = No of Logs Signatures / Hoppers to Handle  

Log Assistants = 11 / 5.988 

Log Assistants = 1.83 

The calculated Log Assistants is then rounded according to the value entered for application setting id 126, in 
this example this has been entered as 0.2. 

If the decimal of the calculated Log Assistants is less than or equal to the value entered in application setting id 
126, rounding factor, then the number of Log Assistants is rounded down to the nearest whole number. 

If the decimal of the calculated Log Assistants is greater than the rounding factor then the number of Log 
Assistants is rounded up to the nearest whole number. 

Therefore, in this example 1.83 is rounded up to 2, therefore the number of Log Assistants is 2. 

Step 5 

Calculate the number of assistants required to handle the bind-ins and sheeted sections.   

In this scenario the value entered in application setting id 125 is 3. 

The calculation is based on the number of bind-in and sheeted sections divided by the maximum bind-ins per 
assistant value. 

As each insert profile split is calculated the number of Bind-In Assistants may vary. The insert profile is as 
follows: 

First 100,000 copies contain 3 Inserts. 
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Second 100,000 copies contain 2 Inserts. 

Third 50,000 copies contain 1 Insert. 

Therefore for 3 Inserts: 

Bind-in Assistants = (No of Bind-Ins + No of Sheeted Sections) / maximum bind-ins per assistant 

Bind-in Assistants = 4 / 3 

Bind-in Assistants = 1.333 

The calculated Bind-In Assistants is then rounded according to the value entered in application setting id 127, in 
this scenario = 0.33. 

If the decimal of the calculated Bind-In Assistants is less than or equal to the rounding factor then Bind-In 
Assistants is rounded down to the nearest whole number. 

If the decimal of the calculated Bind-In Assistants is greater than the rounding factor, then Bind-In Assistants is 
rounded up to the nearest whole number. 

Therefore, in this example 1.333 is rounded up to 2, therefore the number of Bind-In assistants is 2. 

Therefore for 2 Inserts: 

Bind-in Assistants = 3 / 3 

Bind-in Assistants = 1 (rounded) 

Therefore for 1 Insert: 

Bind-in Assistants = 2 / 3 

Bind-in Assistants = 1 (0.667 rounded) 

Step 6 

The final step is to calculate the total number of assistants required.   

When 3 Inserts are included in the binding operation: 

Total Assistants = Log Assistants + Bind-In Assistants + Base Assistants 

Total Assistants = 2 + 2 + 2 

Total Assistants = 6 

When 2 and 2 Inserts are included in the binding operation: 

Total Assistants = 2 + 1 + 2 

Total Assistants = 5 

Calculating Packing 
There are two methods for entering and subsequently calculating packing within an estimate. 

• Standard 
• Advanced 

Standard 
Example scenario: 250,000 copies, 4pp cover on 130gsm + 96pp text on 70gsm, 297 x 210mm portrait. Packing 
in A4 Cartons and Standard Pallets, Delivery to 1 address Leicester (from Leeds). 
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Process  Calculation Source 

Weight of product   

Weight of each 
component 

= (Trim size / 1000) * grammage * 
(pagination / 2) 

 

Cover  (297 x 210 / 1000) * 130 * (4 / 2) = 
16.2162 grams 

 

Text  (297 x 210 / 1000) * 70 * (96 / 2) = 
209.5632 grams 

 

Weight of book 
plus product 

 Weight of book + product weight uplift 
% 

(from Site tab) 

  16.2162 + 209.5632 * 5% = 237.07 
grams 

 

Pallets  

Number of 
copies per 

pallet 

= Maximum weight of pallet / Product 
Weight 

(from Materials) 

  1000 / 0.237070 = 4,218   

Packing 
Quantities 

= 4,000 

 
Total number of 

Pallets 
= Quantity / Copies per pack  

 = 250,000 / 4,000 = 62.5, rounded up to 
full pallets = 63 

 

Cost per UOP = £7.00 (from Materials) 

Cost of pallets = Number of pallets x Cost per pallets  

  63 x £7.00 = £441.00  

Price of pallets = Cost of packing * Mark Up % (from Materials) 

  £441 * 5% = £463.05  

Carton Packing  

Number of 
copies per pack 

= Maximum weight of pack / Product 
Weight 

(from Materials) 

  12.5 / 0.237070  = 52.7 copies  

Packing 
Quantities 

= 50 

 
Total number of 

Packs 
= Quantity / Copies per pack  

  250,000 / 50 = 5,000  

Cost per UOP = £0.25 (from Materials) 

Cost of packing = Number of packs * Cost per pack  

  5,000 * £0.25 = £1,250.00  

Price of 
packing 

= Cost of packing * Mark Up % (from Materials) 
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Process  Calculation Source 

  £1,250 * 5% = £1,312.50  

Advanced 
For details of calculations for Advanced Packing, see the Order Management 5.4 User Guide, Advanced Packing 
chapter. 

Calculating Delivery 
There are two methods for entering and subsequently calculating delivery within an estimate. 

• Standard 
• Freight Rates 

Standard 
Example scenario: 250,000 copies, 4pp cover on 130gsm + 96pp text on 70gsm, 297 x 210mm portrait. Packing 
in A4 Cartons and Standard Pallets, Delivery to 1 address Leicester (from Leeds). 

Process  Calculation Source 

Weight of product   

Weight of each 
component 

= (Trim size / 1000) * grammage * (pagination / 
2) 

 

Cover  (297 x 210 / 1000) * 130 * (4 / 2) = 16.2162 
grams 

 

Text  (297 x 210 / 1000) * 70 * (96 / 2) = 209.5632 
grams 

 

Weight of book 
plus product 

 Weight of book + Product Freight Uplift (%) 

 
  16.2162 + 209.5632 * 5% = 237.07 grams  

Overall weight 
of product 

= (Product weight / 1,000) * Net Quantity  

  0.23707 * 250,000 copies  = 59,267 kilograms  

Distance 
between 
locations 

= 99 miles 

 
Maximum 

weight per load 
= 25,000 kilograms (from Application Settings) 

Number of 
Loads 

= Overall weight of product / Maximum weight 
per load 

 

  59,267 / 25,000 = 2.37, rounded up to full 
wagon = 3 

 

Cost for 
distance range 

and weight 

= £180 
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Process  Calculation Source 

  Cost for distance range x Number of Loads  

  £180 * 3 = £540  

Delivery price = Cost * Mark Up % 
 

  £540 * 25% = £675  

Freight Rates 
Example scenario: 250,000 copies, 4pp cover on 130gsm + 96pp text on 70gsm, 297 x 210mm portrait. Packing 
in A4 Cartons and Standard Pallets, Delivery to 1 address Leicester (from Leeds). 

Process  Calculation Source 

Weight of product   

Weight of each 
component 

= (Trim size / 1000) * grammage * (pagination / 
2) 

 

Cover  (297 x 210 / 1000) * 130 * (4 / 2) = 16.2162 
grams 

 

Text  (297 x 210 / 1000) * 70 * (96 / 2) = 209.5632 
grams 

 

Weight of book 
plus product 

 Weight of book + Product Freight Uplift (%) 

 
  16.2162 + 209.5632 * 5% = 237.07 grams  

Overall weight 
of product 

= (Product weight / 1,000) * Net Quantity  

  0.23707 * 250,000 copies  = 59,2675 
kilograms = 59.2675 Tonnes 

 

Freight Cost  (((Ship Weight/Drops)*Cost per tonne of 1 
drop)*Drops) + Setup + (number of drops * 
Drop Cost) * (1 + Fuel Levy) 

 

  (((59.2675/1) * 30) * + 50 + (1 * 40) * (1 + 
0.02) 
1,778.025 + 50 + 40 * 1.02 = £1,905.37 

 

Freight Price  Freight Cost * Mark Up %  

  1905.37 * 10% = £2,095.91  
  


